Abstract: The TeleEngineering Toolkit software was developed to provide a mechanism by which deployed engineers could view and analyze geospatial data, collect and display data required for engineering analyses conducted by subject matter experts via reachback, track previously conducted analyses, organize requests for information, maintain interoperability with other software used by deployed personnel, and provide requestors a more efficient means to display analyses provided by subject matter experts. The capabilities of the TeleEngineering Toolkit include tools to display and analyze many types of geospatial data (maps, imagery, and various other raster and vector data), manage documents in a geospatial environment, create and share annotations, plot data points, import and export vector data in several common formats, and process and view reconnaissance data. This document provides a detailed reference to the TeleEngineering Toolkit software including installation of the software, working with geospatial data and the Data Depot format, creating and working with Projects and viewing maps and imagery, using all of the menus and toolbars, using the various Project components, importing and exporting data, and working with data collected from the Automated Route Reconnaissance Kit. Complete descriptions of all of the software functions, example applications, and images of the interface to support understanding of the software are included.
Contents

Figures and Tables...........................................................................................................................................vii

Preface .........................................................................................................................................................xvii

1 Introduction ...............................................................................................................................................1
   Background.............................................................................................................................................1
   TeleEngineering Toolkit development.................................................................................................2
   Objective and purpose ..............................................................................................................................3

2 Basic Overview of the Toolkit Concept.................................................................................................5
   Purpose ..................................................................................................................................................5
   Data supported.......................................................................................................................................5
   Data Depots ...........................................................................................................................................6
   Projects ................................................................................................................................................6
   Toolkit operation..................................................................................................................................7

3 Getting Started.........................................................................................................................................9
   Recommended hardware configuration....................................................................................................9
   Software installation .................................................................................................................................9
   Starting the software...............................................................................................................................16

4 Data Depot Creation and Management.................................................................................................17
   Introduction............................................................................................................................................17
   The Data Depot..................................................................................................................................17
   Creating Data Depots............................................................................................................................19
     New Data Depot for loading data ............................................................................................................21
     Registering an existing Data Depot .......................................................................................................25
   Downloading NGA data from the SIPRNET .........................................................................................29

5 Basic Project Functions ..........................................................................................................................31
   Introduction............................................................................................................................................31
   Creating a new project .............................................................................................................................31
   General tab............................................................................................................................................33
   Data Source tab .....................................................................................................................................34
   Map tab ................................................................................................................................................36
   Saving a project....................................................................................................................................39
   Modifying a project .................................................................................................................................39
     Modifying the security classification ......................................................................................................41
     Modifying the general information ........................................................................................................41
     Modifying the data source ....................................................................................................................42
Opening a project ................................................................. 43
Closing a project ........................................................................ 49

6 Basic Display Operations and Utilities .................................................. 51
   Introduction ................................................................................ 51
   Menus ...................................................................................... 52
       File menu ................................................................................ 52
       Edit menu .............................................................................. 53
       View menu ................................................................................ 54
   Utilities .................................................................................... 65
   Window .................................................................................... 72
   View Control window ................................................................ 77
       Project tab ............................................................................ 78
       Background tab ..................................................................... 78
       Legend tab ........................................................................... 85
       Stacker tab ........................................................................... 86
       Coordinates tab .................................................................... 88
       Extents tab .......................................................................... 91

7 Project Components ....................................................................... 95
   Introduction .............................................................................. 95
   Documents .............................................................................. 96
       Creating new documents folders and categories ......................... 96
       Adding documents to a project .................................................. 99
       Viewing and managing documents ............................................ 103
   Airfields .................................................................................. 107
   Annotation ............................................................................... 107
       Creating a new annotation ...................................................... 108
       Annotation symbology .......................................................... 112
       Line annotation .................................................................... 114
       Polygon annotation .............................................................. 116
       Filled circle/ radius annotation ................................................. 117
       Icon annotation ..................................................................... 117
       Text annotation ..................................................................... 120
       Arrow annotation ................................................................... 122
       Geometric shape annotations .................................................. 124
       Editing annotations ............................................................... 126
       Deleting annotations ............................................................. 131
       Measurements with annotations .............................................. 131
       Elevation profile with line annotations .................................... 133
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPS track</td>
<td>134</td>
</tr>
<tr>
<td>Layers</td>
<td>136</td>
</tr>
<tr>
<td>Creating a new layers overlay</td>
<td>136</td>
</tr>
<tr>
<td>Layers toolbars</td>
<td>139</td>
</tr>
<tr>
<td>Creating layers legends</td>
<td>147</td>
</tr>
<tr>
<td>Creating objects in layers</td>
<td>155</td>
</tr>
<tr>
<td>Viewing object name using Map Tip</td>
<td>158</td>
</tr>
<tr>
<td>Linking legends with object symbology</td>
<td>158</td>
</tr>
<tr>
<td>Exporting and importing shapefiles from layers</td>
<td>160</td>
</tr>
<tr>
<td>Importing annotations into layers</td>
<td>161</td>
</tr>
<tr>
<td>Exporting and importing C2PC MGC files from layers</td>
<td>162</td>
</tr>
<tr>
<td>Overlays</td>
<td>163</td>
</tr>
<tr>
<td>Viewing overlay data features</td>
<td>164</td>
</tr>
<tr>
<td>Viewing overlay legends</td>
<td>165</td>
</tr>
<tr>
<td>Querying OVERLAY FEATURES</td>
<td>166</td>
</tr>
<tr>
<td>Using the Stacker</td>
<td>168</td>
</tr>
<tr>
<td>Plot data</td>
<td>169</td>
</tr>
<tr>
<td>Recon</td>
<td>175</td>
</tr>
<tr>
<td>Route Database</td>
<td>175</td>
</tr>
<tr>
<td>Shapefiles</td>
<td>175</td>
</tr>
<tr>
<td>Introduction</td>
<td>175</td>
</tr>
<tr>
<td>Importing a shapefile</td>
<td>176</td>
</tr>
<tr>
<td>Point shapefiles</td>
<td>180</td>
</tr>
<tr>
<td>Displaying point shapefiles using text</td>
<td>200</td>
</tr>
<tr>
<td>Line shapefiles</td>
<td>203</td>
</tr>
<tr>
<td>Polygon shapefiles</td>
<td>205</td>
</tr>
<tr>
<td>8 Processing Route Reconnaissance Data</td>
<td>207</td>
</tr>
<tr>
<td>Recon</td>
<td>207</td>
</tr>
<tr>
<td>New Recon Folder</td>
<td>208</td>
</tr>
<tr>
<td>Add Existing Recon Folder</td>
<td>208</td>
</tr>
<tr>
<td>Viewing the recon</td>
<td>211</td>
</tr>
<tr>
<td>Recon:Control window</td>
<td>211</td>
</tr>
<tr>
<td>Recon:Picture window</td>
<td>215</td>
</tr>
<tr>
<td>Saving individual images from the Recon:Picture window</td>
<td>215</td>
</tr>
<tr>
<td>Viewing legend for recon objects</td>
<td>216</td>
</tr>
<tr>
<td>Controlling display of recon objects with the Stacker</td>
<td>216</td>
</tr>
<tr>
<td>Recon toolbars</td>
<td>218</td>
</tr>
<tr>
<td>Save objects to Route Database (Engr DB)</td>
<td>243</td>
</tr>
<tr>
<td>Save recon to Route Database (Engr DB)</td>
<td>244</td>
</tr>
<tr>
<td>Downloading a recon from Route Database (Engr DB)</td>
<td>245</td>
</tr>
<tr>
<td>Viewing recon data in Output Control window</td>
<td>247</td>
</tr>
<tr>
<td>Route Database</td>
<td>251</td>
</tr>
<tr>
<td>Working with Route Database objects</td>
<td>252</td>
</tr>
</tbody>
</table>
Bridges in the Route Database .................................................................254
Curves in the Route Database .................................................................258
Ferries in the Route Database .................................................................262
Fords in the Route Database .................................................................263
Intersections in the Route Database .....................................................265
IRI in the Route Database .....................................................................267
Obstructions in the Route Database .......................................................269
Other objects in the Route Database .....................................................270
Roads in the Route Database ...............................................................271
Steep grades in the Route Database .......................................................275
Tunnels in the Route Database ............................................................276
Exporting shapefiles and saving data from the Route Database ..........278
Creating a route in the Route Database ................................................282
Notes on processing route recon data ..................................................288

9 Custom Installation and Custom Project Components .......................289
   Custom software installation options .................................................289
   Custom project components .........................................................295
      HPAC shapefiles .................................................................295
      Humanitarian assistance .....................................................296

10 Overlay Creation ............................................................................303

11 Sending RFI ..................................................................................313

12 Technical Support ..........................................................................315

Appendix A - Data Types Supported ....................................................317

Report Documentation Page
Figures and Tables

Figures

Figure 3.1. Initial install screen. ................................................................. 10
Figure 3.2. Welcome to the TeleEngineering Toolkit Installation Wizard. ........................................................................... 11
Figure 3.3. User information. ......................................................................... 11
Figure 3.4. Installation folder selection. ............................................................ 12
Figure 3.5. Configuration data folder selection. ..................................................... 12
Figure 3.6. Installation type. ................................................................................ 13
Figure 3.7. Disable/enable recon recording option. ............................................... 14
Figure 3.8. Begin final installation. ....................................................................... 14
Figure 3.9. Installation progress displayed. .......................................................... 15
Figure 3.10. Successful installation. ................................................................. 15
Figure 3.11. Exiting the install screen. ............................................................... 16
Figure 3.12. TeleEngineering Toolkit interface. ................................................... 16
Figure 4.1. Example of a Data Depot folder structure. ........................................... 18
Figure 4.2. Opening the Data Depots window. ..................................................... 19
Figure 4.3. The Data Depots window is displayed. ................................................. 20
Figure 4.4. Right-click and select “New/Insert.” .................................................... 20
Figure 4.5. New/Insert Data Depot window. ......................................................... 21
Figure 4.6. New Iraq Data Depot named. .............................................................. 22
Figure 4.7. From Map box checked to define extents. ............................................ 23
Figure 4.8. World map with Magnifying Glass tool zooming on Iraq. ....................... 23
Figure 4.9. Close-up map of Iraq with extent defined using rectangle. ..................... 24
Figure 4.10. Loading raw data. ............................................................................. 25
Figure 4.11. Registering or inserting an existing Data Depot. .................................. 26
Figure 4.12. Newly registered Data Depot added to Data Depot list. ....................... 27
Figure 4.13. Listing of data types in a Data Depot. ............................................... 28
Figure 4.14. View of geographic coverage for 1:100K TLM data. ............................. 28
Figure 5.1. Accessing the New Project window. ................................................... 32
Figure 5.2. New Project window. ............................................................... 32
Figure 5.3. Data Source tab of New Project window. ......................................... 35
Figure 5.4. Data Depot set to Baghdad. ............................................................ 35
Figure 5.5. World map with magnifying glass and extent selection tools. ................. 37
Figure 5.6. Selection of geographic extents using box selection tool ........................................37
Figure 5.7. Initial project view .........................................................................................................38
Figure 5.8. Selecting Save Project from the File menu to save a project ..................................39
Figure 5.9. Selecting Modify Project from the File menu ............................................................40
Figure 5.10. The Modify Project window ..........................................................................................40
Figure 5.11. Modifying the security classification .......................................................................41
Figure 5.12. Modifying the Data Source ..........................................................................................42
Figure 5.13. Data Depot changed to Iraq for ADRG Data Sources ..............................................43
Figure 5.14. Toolkit project file in project folder .........................................................................44
Figure 5.15. Options to open a Project from the File menu ..........................................................44
Figure 5.16. Open Project window ..................................................................................................45
Figure 5.17. Select Project window ...............................................................................................46
Figure 5.18. Selecting desired project from list .............................................................................46
Figure 5.19. Path to selected project in file path .........................................................................47
Figure 5.20. Opening a project from the drop-down project list ..................................................48
Figure 5.21. Browsing to project file in Open Project window .....................................................48
Figure 5.22. Closing a project .........................................................................................................49
Figure 6.1. Basic layout of Toolkit interface ..................................................................................51
Figure 6.2. File menu ....................................................................................................................52
Figure 6.3. Edit menu ....................................................................................................................53
Figure 6.4. View menu ..................................................................................................................54
Figure 6.5. Toolkit toolbars ..........................................................................................................55
Figure 6.6. Toolbars identified ......................................................................................................55
Figure 6.7. Output Control window Open ....................................................................................60
Figure 6.8. Status bar location ......................................................................................................61
Figure 6.9. Configuration tab in the System Settings window .......................................................62
Figure 6.10. User Interface tab in the System Settings window ....................................................63
Figure 6.11. User Profile tab in the System Settings window .......................................................63
Figure 6.12. Elevation Profile tab in the System Settings window ................................................64
Figure 6.13. Database Manager tab in the System Settings window ...........................................65
Figure 6.14. Utilities menu ...........................................................................................................66
Figure 6.15. GPS Control and GPS Control Options windows ....................................................67
Figure 6.16. Coordinate Calculator utility ....................................................................................68
Figure 6.17. Coordinate Calculator example input .......................................................................69
Figure 6.18. Coordinate Calculator example output .....................................................................69
Figure 6.19. Spreadsheet Coordinate Converter .........................................................................70
Figure 6.20. Points to be converted from MGRS to latitude/longitude .........................................71
Figure 6.21. Spreadsheet Converter window for MGRS to lat/lon conversion .............. 71
Figure 6.22. MGRS coordinates converted to latitude/longitude. ................................. 71
Figure 6.23. Window menu .............................................................................................. 72
Figure 6.24. Multiple windows ........................................................................................ 73
Figure 6.25. Cascade arrangement of windows ............................................................. 74
Figure 6.26. Tile arrangement of windows ....................................................................... 74
Figure 6.27. Active Window tool in Window menu ...................................................... 75
Figure 6.28. More windows management options ......................................................... 76
Figure 6.29. Different map backgrounds in main viewing windows .............................. 77
Figure 6.30. View Control window ................................................................................ 78
Figure 6.31. Background tab display in View Control window ...................................... 79
Figure 6.32. Export Image window .................................................................................. 80
Figure 6.33. Types drop-down menu .............................................................................. 81
Figure 6.34. Data Source drop-down menu ................................................................. 82
Figure 6.35. Main viewing window redrawn with 1:250K JOG source ......................... 82
Figure 6.36. Source options for Elevation Tint data type ............................................. 83
Figure 6.37. Source options for Relief data type .......................................................... 84
Figure 6.38. Source options for multi-spectral imagery ................................................ 84
Figure 6.39. Legend tab with surface material overlay active ....................................... 86
Figure 6.40. Stacker tab example .................................................................................... 87
Figure 6.41. CL surface material category display turned off ...................................... 87
Figure 6.42. Stacker items reordered ............................................................................. 88
Figure 6.43. Coordinate tab ......................................................................................... 89
Figure 6.44. Available coordinate systems ................................................................... 89
Figure 6.45. Geodetic coordinates in status bar ............................................................ 90
Figure 6.46. Available units for distance measurement ............................................... 90
Figure 6.47. The Extents tab ......................................................................................... 91
Figure 6.48. Drop-down menu of data sources in Extents tab ...................................... 92
Figure 6.49. Red cross-hatched area representing extents of selected data ................... 92
Figure 6.50. Example with view extents partially outside of data extents ..................... 93
Figure 7.1. Project components listed in Project tab of View Control window ............. 95
Figure 7.2. Categories of Toolkit documents ................................................................. 96
Figure 7.3. Adding a new document folder and category ............................................ 97
Figure 7.4. New Category window for documents ....................................................... 97
Figure 7.5. Creating a new documents folder and category ......................................... 98
Figure 7.6. New documents folder and category added .............................................. 99
Figure 7.7. Sample document highlighted ................................................................. 100
Figure 7.45  Changed line symbology...................................................................................128
Figure 7.46.  Edited line. ........................................................................................................128
Figure 7.47.  Line annotation selected for editing..............................................................129
Figure 7.48.  Point on line relocated..................................................................................130
Figure 7.49.  Line edits complete.......................................................................................130
Figure 7.50.  Click red X to delete selected annotation graphic.......................................131
Figure 7.51.  Size (SZ) icon on Annotation toolbar..........................................................132
Figure 7.52.  Example measurement for polygon annotation graphic..............................132
Figure 7.53.  Elevation Profile tool. .....................................................................................133
Figure 7.54.  Sample elevation profile................................................................................134
Figure 7.55.  GPS Control to activate GPS. .......................................................................135
Figure 7.56.  GPS Control Options menu. ........................................................................135
Figure 7.57.  Creating a new Layers overlay.....................................................................137
Figure 7.58.  New Layers window......................................................................................138
Figure 7.59.  New overlay opened with toolbars...............................................................138
Figure 7.60.  Naming a new layer.......................................................................................139
Figure 7.61.  Selecting a layer to be the active layer..........................................................140
Figure 7.62.  Renaming a layer..........................................................................................141
Figure 7.63.  Move LAYER OBJects. ..................................................................................142
Figure 7.64.  Layers Object Size window. .......................................................................143
Figure 7.65.  Layers legend window..................................................................................148
Figure 7.66.  Symbol Type drop-down menu....................................................................150
Figure 7.67.  Creating an Information legend type............................................................151
Figure 7.68.  Adding a Subtitle legend type ......................................................................151
Figure 7.69.  Adding a Clause legend...............................................................................153
Figure 7.70.  Line Symbol Editor. .....................................................................................153
Figure 7.71.  Line legend added.........................................................................................154
Figure 7.72.  Line legend inserted.....................................................................................154
Figure 7.73.  Legend in View Control window. .................................................................155
Figure 7.74.  Opening the Output Control window for layers..........................................156
Figure 7.75.  Line object being created.............................................................................157
Figure 7.76.  Line object completed..................................................................................157
Figure 7.77.  Object Map Tip............................................................................................158
Figure 7.78.  Drag and drop legend symbology to new Layers object..............................159
Figure 7.79.  Legend symbology linked with new object..................................................159
Figure 7.80.  Layers export and import options.................................................................161
Figure 7.81.  Importing annotation file into layers..............................................................162
Figure 7.82. Viewing overlay data types.................................................................164
Figure 7.83. ITD vegetation data displayed...............................................................165
Figure 7.84. Overlay legend.....................................................................................166
Figure 7.85. Overlay highlighted and Query icon displayed......................................167
Figure 7.86. Overlay feature query results...............................................................167
Figure 7.87. Stacker.................................................................................................168
Figure 7.88. Sample information for Plot Data feature.............................................169
Figure 7.89. Creating a new Plot Data feature..........................................................170
Figure 7.90. Plot Data Properties window...............................................................170
Figure 7.91. Selecting fields for longitude and latitude.............................................171
Figure 7.92. Selecting field for coordinate string....................................................171
Figure 7.93. Plot Data Properties window completed..............................................172
Figure 7.94. Data points plotted.............................................................................172
Figure 7.95. Query results for Plot Data.................................................................173
Figure 7.96. Symbol Editor for Plot Data...............................................................174
Figure 7.97. Plot Data information.........................................................................174
Figure 7.98. Importing a new shapefile.................................................................176
Figure 7.99. Opening the New Shapefile window....................................................177
Figure 7.100. Browsing with the Select Shapefile window.......................................177
Figure 7.101. File path, overlay name and overlay folder for selected shapefile. ......179
Figure 7.102. Selecting the appropriate projection and datum...................................180
Figure 7.103. Selection of method to draw point shapefile......................................181
Figure 7.104. Menu to define display options..........................................................182
Figure 7.105. Symbol Editor....................................................................................183
Figure 7.106. Defining tip and descriptions for Map Tips........................................184
Figure 7.107. Turning on display of shapefile overlays............................................185
Figure 7.108. Map Tip and description.................................................................185
Figure 7.109. Shapefile Legend Editor.................................................................187
Figure 7.110. Revised descriptions and text display................................................187
Figure 7.111. Using simple ranges to draw shapefile..............................................188
Figure 7.112. Column information.......................................................................189
Figure 7.113. Number of ranges and range display colors.....................................190
Figure 7.114. Symbology and text display options................................................190
Figure 7.115. Points displayed based on simple ranges.........................................191
Figure 7.116. Selecting the advanced method to draw shapefile.........................192
Figure 7.117. Shapefile Legend Editor.................................................................192
Figure 7.118. Point display with text at 45-degree azimuth....................................193
Figure 7.119. Add or insert new clause for overlay via Shapefile Legend Editor...........194
Figure 7.120. Shapefiles Add/Insert Clause menu..............................................................194
Figure 7.121. New clause added to overlay in the Shapefile Legend Editor......................196
Figure 7.122. Unique values selected for shapefile display.............................................197
Figure 7.123. Display of points overlay with two clauses..............................................197
Figure 7.124. Adding a new clause with column option but not unique.........................199
Figure 7.125. New clause with range of depth values defined......................................199
Figure 7.126. Display with three clauses for the points overlay......................................200
Figure 7.127. Draw as Text for new shapefile. .................................................................201
Figure 7.128. Choosing the column and text positioning and size.................................201
Figure 7.129. Symbol Editor for text display.................................................................202
Figure 7.130. Text displayed with ID numbers for points...............................................202
Figure 7.131. Importing a line shapefile to create a new overlay....................................204
Figure 7.132. Three methods for drawing line shapefiles..............................................204
Figure 7.133. Creating a new polygon shapefile overlay................................................206
Figure 7.134. Selecting the method to draw the polygon shapefile...............................206
Figure 8.1. Recon component options.................................................................207
Figure 8.2. Add Existing Recon Folder window.........................................................209
Figure 8.3. Opening existing recon folder.......................................................................209
Figure 8.4. Expanding the new recon folder...............................................................210
Figure 8.5. Opening the new recon................................................................................210
Figure 8.6. Opening the Recon:Control and Recon:Picture windows.............................212
Figure 8.7. Playing the recon.......................................................................................212
Figure 8.8. Selecting the RECON PLAYBACK Speed.....................................................213
Figure 8.9. Using the seek function to view a recon......................................................214
Figure 8.10. Distance measuring along a recon............................................................215
Figure 8.11. Saving individual image files from Recon:Picture window.............................216
Figure 8.12. Display of the legend for recon objects.....................................................217
Figure 8.13. Stacker for recon objects.............................................................................217
Figure 8.14. Stacker with intersection and obstruction display toggled off.....................218
Figure 8.15. Navigating a recon with the Select Location tool......................................219
Figure 8.16. Compute curves, compute slopes and compute track..................................220
Figure 8.17. Obtain Zero Data window...........................................................................221
Figure 8.18. Choosing object type to be selected for editing........................................222
Figure 8.19. Object along recon track selected..............................................................223
Figure 8.20. Edit window for bridge information............................................................223
Figure 8.21. Road Change Tool and Road Properties window.......................................224
Figure 8.22. Example completed Road Properties window. .............................................225
Figure 8.23. Obstruction window to add new obstruction to recon track....................226
Figure 8.24. New obstruction added to recon track. .....................................................226
Figure 8.25. Designating start location in steep grade tool.......................................227
Figure 8.26. Designating end location in steep grade tool.......................................228
Figure 8.27. New grade added to recon track. .........................................................228
Figure 8.28. Start location of curve ..........................................................................229
Figure 8.29. End location and radius of curvature for curve....................................230
Figure 8.30. New curve added to recon track ...........................................................230
Figure 8.31. Bridge dialog .......................................................................................231
Figure 8.32. New bridge added to recon track ...........................................................232
Figure 8.33. Adding a new intersection .....................................................................233
Figure 8.34. New intersection added to recon track. ...............................................233
Figure 8.35. Other Point of Interest dialog .................................................................234
Figure 8.36. New Other Point of Interest added to recon track...............................235
Figure 8.37. Export Elevation Track dialog. ...............................................................236
Figure 8.38. Sample data file from Export Elevation Track .......................................237
Figure 8.39. Export Picture Records dialog. ...............................................................238
Figure 8.40. Example folder with exported images. ...................................................239
Figure 8.41. Creating an Other Point of Interest with pothole key PH .......................240
Figure 8.42. Creating an Other Point of Interest with pothole key PHR.....................241
Figure 8.43. Selecting type and folder for extracting other objects of interest. ..........241
Figure 8.44. Verifying successful extraction of other objects. .................................242
Figure 8.45. Contents of sample data file for extracted objects. ................................242
Figure 8.46. Saving recon objects to Route Database. .............................................244
Figure 8.47. Saving recon to Route Database. ............................................................245
Figure 8.48. Download recon from database .............................................................246
Figure 8.49. Selecting recon for download from database ........................................246
Figure 8.50. Selected recon downloaded into project and displayed. .......................247
Figure 8.51. Viewing recon data in the Output Control window. .............................248
Figure 8.52. Graph control for recon data. .................................................................249
Figure 8.53. Selecting data channel for recon data in Output Control window ..........249
Figure 8.54. Color selection for data display. ............................................................250
Figure 8.55. Scale options for graph control. ............................................................250
Figure 8.56. Components of the Route Database in the View Control window .........251
Figure 8.57. Selected Route Database objects displayed .........................................252
Figure 8.58. Route Database toolbar. .....................................................................253
Figure 8.59. Selecting an object in the Route Database.................................254
Figure 8.60. Bridge Reconnaissance Report (DA Form 1249) - page 1.........255
Figure 8.61. Bridge Reconnaissance Report (DA Form 1249) - page 2........255
Figure 8.62. Drawing and image palette for bridge report.............................256
Figure 8.63. Inserting a photograph or image file into Bridge Report............256
Figure 8.64. Adding more pages to Bridge Report form.................................257
Figure 8.65. Editing curve data in the Route Database.................................258
Figure 8.66. Drawing a new curve.................................................................259
Figure 8.67. Entering radius of curvature for new curve...............................260
Figure 8.68. New curve completed and added to Route Database...............260
Figure 8.69. Relocating a curve......................................................................261
Figure 8.70. Ferry Reconnaissance Report (DA Form 1252) - page 1..........262
Figure 8.71. Ford Reconnaissance Report (DA Form 1251) - page 1.............264
Figure 8.72. Editing intersection remarks in the Route Database................266
Figure 8.73. Editing IRI data in the Route Database....................................267
Figure 8.74. Editing obstruction data in the Route Database.........................269
Figure 8.75. Editing other object remarks in the Route Database..................271
Figure 8.76. Editing road attribute data.........................................................272
Figure 8.77. Adding a new road segment.......................................................273
Figure 8.78. Completed new digitized road segment....................................274
Figure 8.79. Editing steep grade slope data.................................................275
Figure 8.80. Tunnel Reconnaissance Report (DA Form 1250) - page 1........277
Figure 8.81. Exporting shapefiles for all Route Database objects.................279
Figure 8.82. Selecting shapefiles folder..........................................................279
Figure 8.83. Listing of saved shapefiles from Route Database.......................280
Figure 8.84. Select “Export Shapefile” for bridges........................................281
Figure 8.85. Select “Save As” to export shapefile for all other object types.....281
Figure 8.86. Creating a new route.................................................................282
Figure 8.87. New route dialog.................................................................283
Figure 8.88. New route added to Route Database........................................283
Figure 8.89. Initial road segment added to route..........................................284
Figure 8.90. Additional road segment added to route...................................285
Figure 8.91. Warning if non-adjacent segments are selected......................285
Figure 8.92. Road Reconnaissance Report (DA Form 1248) for route............286
Figure 8.93. Warning to update report due to changes in extent of route........287
Figure 9.1. Initial Install screen.................................................................289
Figure 9.2. Application Maintenance screen.............................................290
Figure 9.3. Welcome screen for Installation Wizard. ..............................................................291
Figure 9.4. User Information screen for Installation Wizard.................................................291
Figure 9.5. Configuration Data Destination Folder screen for Installation Wizard. ..............292
Figure 9.6. Select Installation Type screen for Installation Wizard........................................292
Figure 9.7. Select Features screen for custom installation.....................................................293
Figure 9.8. Install options for HPAC shapefile viewer..........................................................294
Figure 9.9. All applications selected for installation..............................................................294
Figure 9.10. Importing a new HPAC shapefile......................................................................295
Figure 9.11. Selecting the HPAC shapefile CXL file for import............................................296
Figure 9.12. Creating a new Humanitarian Assistance Database.........................................297
Figure 9.13. Create/select Humanitarian Database...............................................................297
Figure 9.14. Prompt to save, exit and reopen project for new database...............................298
Figure 9.15. Humanitarian Assistance Database categories..................................................299
Figure 9.16. Humanitarian Assistance menu.........................................................................299
Figure 9.17. Completing the Humanitarian Assistance menu..............................................300
Figure 9.18. Humanitarian Assistance icon added.................................................................301
Figure 9.19. Icon color indicates status of all categories.......................................................302
Figure 10.1. Creating a new overlay......................................................................................303
Figure 10.2. Data Feature menu and subfeatures.................................................................304
Figure 10.3. AP030-Road attribute list displayed.................................................................305
Figure 10.4. Selected subfeature added to Query Builder......................................................306
Figure 10.5. Symbol Editor...................................................................................................306
Figure 10.6. Deselecting AP030-Road subfeature...............................................................307
Figure 10.7. Adding subfeatures to the overlay.....................................................................308
Figure 10.8. Save Query window..........................................................................................308
Figure 10.9. Creating a new Overlay folder.........................................................................309
Figure 10.10. New Overlay displayed....................................................................................310
Figure 10.11. Overlay legend...............................................................................................310
Figure 10.12. Overlay file.....................................................................................................311
Figure 11.1. Location of example annotation file.................................................................313

Tables

Table 3.1  Minimum hardware/software requirements .........................................................9
Preface

The work reported herein was conducted under the direction of the TeleEngineering Operations Center at the U.S. Army Engineer Research and Development Center (ERDC), Vicksburg, MS. Dr. Jeffrey D. Jorgeson and Woodman W. Berry of the ERDC Coastal and Hydraulics Laboratory (CHL), along with Rhonda D. Taylor, Benjamin T. Webb, Sandra K. Fairley, Jill M. Jackson, and Jeffrey L. Williamson of the ERDC Geotechnical and Structures Laboratory (GSL), prepared this report.

The work was conducted under the general supervision of Earl V. Edris, Chief, Hydrologic Systems Branch, CHL; Thomas W. Richardson, Director, CHL; Dr. Larry N. Lynch, Acting Chief, Geosciences and Structures Division, GSL; Dr. William P. Grogan, Deputy Director, GSL; and Dr. David W. Pittman, Director, GSL.

COL Richard Jenkins was Commander and Executive Director of ERDC. Dr. James R. Houston was Director.
1 Introduction

Background

The U.S. Army engineer community identified a requirement for split-based support, or a reach-back capability, within its Future Operational Capabilities in fiscal year 1997 (FY97). The U.S. Army Engineer Research and Development Center (ERDC) initiated the TeleEngineering Operations Technology Demonstration in FY97 to investigate the feasibility of providing that reach-back capability.

TeleEngineering Operations within the constraints of the technology demonstration were defined as providing a civil and environmental engineering tele-presence to provide engineer mission support. The basis for the reach-back capability was that, during the execution of missions worldwide, frequent situations occurred that required specialized engineering expertise and technical advice to resolve problems. Additionally, as the Army continues to decrease in size and the reliance on forces based in the continental United States increases, and as the Future Force concept continues to mature, a complete engineer team of experts will not be available at each location where engineering operations are occurring. TeleEngineering Operations provides the link between field personnel and a team of subject matter experts (SMEs) with the required unique expertise and computational assets to provide necessary technical support and analyses.

Engineer units are involved in a wide variety of missions and challenges ranging from assessing, constructing, and maintaining transportation and utility networks, executing expedient river crossing operations, and conducting logistics-over-the-shore operations. These operations must be successfully executed in order to deploy, receive, employ, and sustain deploying forces. Force protection technologies are also required in the theater to assess existing and planned security measures, protect deploying forces, and reduce vulnerabilities to terrorist threats by implementation of adequate countermeasures. Each mission differs from the previous mission, and the engineer team does not always have all of the technical data required prior to arrival at the mission site. Additionally,
the impact of force structure changes on the engineer force has significantly reduced the engineers’ ability to respond to these missions. The scope of engineering challenges encountered by deployed engineers can easily overwhelm the limited computational capabilities and data sources available in the field. Without immediate feedback from engineering SMEs, critical operations that hinge on the success of an engineer team would be in jeopardy. In FY97, the U.S. Army ERDC initiated a technology demonstration program to determine the feasibility of providing deployed troops direct access to SMEs. Direct access to SMEs would allow responses to engineering challenges beyond the in-theater capability to be provided without the time delays and costs associated with deploying the SME into the theater.

TeleEngineering Toolkit development

As the TeleEngineering Operations Technology Demonstration continued to mature, it became evident that a mechanism was needed to assist personnel in the field collect the requisite data to improve SME analyses, track previously conducted analyses, organize requests for information (RFIs), maintain interoperability with selected software currently being used by deployed personnel, and provide the requester a more efficient means to display SME analyses.

A review of the TeleEngineering Operations Center (TEOC) activities from FY97 to the present indicated that RFIs were usually submitted via secure or non-secure electronic mail (e-mail) and contained a written description of the problem that generally included Microsoft Word®, PowerPoint®, Access®, and/or Excel® files, digital photographs, etc. Responses provided by SMEs through the TEOC were designed to meet the requester’s needs and therefore also included a wide variety of formats. Additionally, there was a requirement to geographically reference the responses being provided to the requester.

The TeleEngineering Toolkit (referred to herein as “Toolkit” or “TETK”) was developed to address these needs and requirements by providing, both for the engineers requesting technical assistance and the SME providing that assistance, a common software system that easily enables sharing of data and transmission of georeferenced engineering analyses. This is accomplished through the use of “projects” and various
subcomponents of projects in the Toolkit. A project can be a single request concerning a bridge, road, airfield, building, etc., or a project can contain multiple analyses for a specific area, country, or region. The Toolkit allows the requester and/or the SME to create a project, to populate that project with data, information, and analyses, and then to easily share that project information with others who are using the Toolkit software.

The Toolkit is continuously being upgraded to include new capabilities as requirements are identified. As an evolving software package, users may encounter problems or “bugs” during operation of the software. Additionally, users may have suggestions on new capabilities or enhancements that would improve the functionality of the Toolkit. Users are encouraged to report all bugs and provide enhancement suggestions via e-mail to teoc@usace.army.mil. The subject line of the e-mail should include “Toolkit Bug” or “Toolkit Suggestions.”

Objective and purpose

The objective of this documentation is to provide personnel with information on the capabilities of the Toolkit and to provide detailed instructions for operation of the Toolkit. The primary purpose of this document is to provide users with the necessary information and instruction such that they can productively and efficiently utilize the Toolkit to accomplish their engineering and engineer-related missions, including but not limited to submitting RFIs and managing and displaying responses from SMEs.

This manual assumes that the user possesses a basic knowledge of the Microsoft Windows® operating system and its operations. The user will need to have knowledge of using Windows Explorer®, using the CD-ROM, sending/receiving e-mail messages, and transferring files from one computer to another.

This document is intended to provide an overview and reference manual for the software and its capabilities, with some limited examples.
2 Basic Overview of the Toolkit Concept

Purpose

The Toolkit was developed to assist personnel in collecting requisite field data and background information for improving SME analyses, organizing RFIs, tracking previously conducted analyses, maintaining interoperability with selected software currently being used by deployed personnel, and providing the requester a more efficient means to display resulting SME analyses.

RFIs were usually submitted via secure or non-secure e-mail and contained a written description of the problem that often included Microsoft Word®, PowerPoint®, Access®, and/or Excel® files, digital photographs, maps, imagery, etc. Responses provided by SMEs through the TEOC were designed to meet the requester’s specific needs; formats for the responses varied. Additionally, there was a requirement to geographically reference (georeference) the responses provided by the SMEs. The Toolkit provides a standardized georeferenced product for each response that is easily viewable by the requester using the Toolkit software.

Originally, the Toolkit was conceived as a tool for creating annotation files to enhance RFIs and the responses associated with them. These annotation files are essentially georeferenced overlays that can be displayed over maps and imagery to detail the situation and the problem being addressed, as well as to provide information associated with the completed analysis from the SME. The Toolkit annotation files are relatively small (6 kb, for typical RFIs) and do not require large amounts of bandwidth for transmission via e-mail. By sending annotation or layer files, SMEs and requesters take advantage of a georeferenced standardized tool, enabling accurate, precise, and efficient communications.

Data supported

The Toolkit primarily supports maps, imagery, digital terrain, and other geospatial data produced by the National Geospatial-Intelligence Agency (NGA), U.S. Geologic Survey (USGS), and several commercial sources.
These data include ARC Digitized Raster Graphics (ADRG), Compressed ADRG/Controlled Image Base (CADRG/CIB), Digital Nautical Chart, Digital Terrain Elevation Data (DTED), Digital Topographic Data (DTOP), Feature Foundation Data (FFD), Interim Terrain Data (ITD), Planning Interim Terrain Data (PITD), Urban Vector Map (UVMAP), Vector Interim Terrain Data (VITD), Vector Map (VMAP) Level 0, VMAP Level 1, and Commercial Satellite Imagery (CSIL). The Toolkit also supports USGS Digital Orthophoto Quadrangle, scanned georectified maps, and various formats of commercial imagery products such as QuickBird and IKONOS.

Refer to Appendix A for details on the types of data that may be used.

Data Depots

Data Depots are folder (directory) structures designed to store maps, imagery, digital terrain data, and other geospatial data supported by the Toolkit. Data Depots are subdivided by subfolders (subdirectories), each representing a type of terrain data and the various data formats, scales, and resolutions supported by the Toolkit. Users are given some flexibility in the construction of these depots, which provides a means to organize and group data. Users are allowed to select the computer disk drive for storing the Data Depot and to specify a folder for the Toolkit to construct the necessary subfolder structures for organizing terrain data. Beyond that, the folder and file structure of the depot are essentially transparent to the user and are automatically generated when the user creates the Data Depot.

The Toolkit provides the software utilities necessary to transfer the data from NGA-produced compact disks (CDs) to the hard drive during the creation of a Data Depot. These easy-to-use Windows®-based tools are menu driven and minimize user input.

More detailed information on the Data Depots and managing the Data Depots is provided in Chapter 5.

Projects

To provide a mechanism for organizing requests and responses, the Toolkit operational concept is based upon “projects.” A project is
implemented as a folder structure containing all project information, data, and components. The user defines a project by specifying the project folder (directory) containing the project’s security classification (unclassified, for official use only, confidential, secret, or top secret), the geographic boundaries of the project (defined by a rectangle or by country), and the Data Depot containing terrain data required by the project. The project does not include copies of the maps, imagery, or other geospatial data that is contained in the associated Data Depot, which is a separate series of folders as detailed in the previous section. Multiple projects can be created, all of which utilize the same Data Depot for background maps, imagery, and terrain data. Thus, multiple copies of the Data Depot files are not required.

A project can be created for a single request involving a bridge, road, airfield, building, or other specific feature; a project can be created for multiple analyses for a particular area, country, or geographic region; or a project can be created for any combination thereof. The geographic size of the project should be defined to encompass the entire area of interest, and care should be exercised not to limit the geographic extent too much. Although the time required for the computer to plot maps and images may be reduced by limiting the size of a project, limiting the geographic extents of the project to a very small area may inadvertently result in areas being excluded from the project that are ultimately important to the user as analyses for a project are conducted.

Chapter 6 provides details and further guidance on creating, opening, and modifying projects, Chapters 7 and 8 include the typical project components that are available in the Toolkit, and Chapter 9 includes custom project components that may optionally be installed.

Toolkit operation

Users setting up the Toolkit for the first time need to install the Toolkit software from the distribution CD. Most of the installation is performed automatically by the Toolkit installation utility. Refer to Chapter 3 for details on the installation.

Once the Toolkit has been installed, a Data Depot must be created to organize and store terrain data. The location of the depot is specified by
the user. Consideration should be given to the amount of data to be imported and stored in the depot. Also, the user may wish to isolate specific data sets by creating unique meaningful names for the depot (for example, “Bosnia” or “Korea,” or even more specific, “10th MTN DIV AOR”). Once the depot is created, data may be imported from the NGA-produced or USGS-produced CDs. Depot creation and management is discussed in Chapter 5 in detail.

The next step is to create a project. Depending on the purpose of the project and the intended use of the Toolkit, the project will vary in geographic size. Once the project has been defined and saved, annotations or layers can be constructed to facilitate requests, analyses, and responses, or geographic and attribute information contained in files created outside of the Toolkit, such as Shapefiles, may be imported for use. Project management is discussed in detail in Chapter 7.
3 Getting Started

Recommended hardware configuration

The Toolkit can be executed on almost any personal computer (laptop or desktop) with the minimum configuration presented in Table 3.1.

<table>
<thead>
<tr>
<th>Item</th>
<th>Minimum recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>Windows 2000</td>
</tr>
<tr>
<td>Memory</td>
<td>256 MB RAM</td>
</tr>
<tr>
<td>Processor</td>
<td>Pentium II or better, or Celeron</td>
</tr>
<tr>
<td>Processor Speed</td>
<td>400 MHz Processor speed or faster</td>
</tr>
<tr>
<td>Graphics</td>
<td>800×600 resolution and 16-bit color</td>
</tr>
<tr>
<td>CD Drive</td>
<td></td>
</tr>
<tr>
<td>Hard Disk Space</td>
<td>The Toolkit software itself requires little disk space (~16 MB). Data stored in the depots, depending on the type and amount of coverage needed, can range from 20 MB to 2 GB, or more. For example, a typical 100 km square area of ADRG 1:50K occupies 288 kb of space; and a 3600 km square area of CADRG 1:250K occupies 288 kb of space.</td>
</tr>
</tbody>
</table>

Software installation

To install the Toolkit for the first time on a computer, insert the CD into the CD-ROM drive. The install menu should begin automatically. If it does not, press the Start button from the Windows Taskbar and select Run. In the Run box, browse to locate the CD drive, select the Setup.exe file on the CD, and run that executable. When the installation begins, the window illustrated in Figure 3.1 will appear. Note: The installation process on certain systems may vary slightly from what is presented here depending on the system configuration. Following the on-screen instructions and accepting the default options will generally lead to successful installation.
Select the Install/Reinstall option, and the screen in Figure 3.2 will appear.

Only the system administrator will be allowed to install the software for use by all users, as Figure 3.3 indicates. If logged on as the administrator, installation of the software for all users may be selected, as Figure 3.3 demonstrates. Press Next to continue.
The installation wizard will select a folder on the hard drive for installation as shown in Figure 3.4. This default drive may be accepted as the installation folder or it may be changed as needed. Press Next. Figure 3.5 demonstrates the same folder destination selection process for the configuration data.
Figure 3.4. Installation folder selection.

Figure 3.5. Configuration data folder selection.
The Typical installation shown in Figure 3.6 is recommended for most users, and installation continues upon pressing Next as shown in Figure 3.6. Details on Custom Installation and Complete Installation are provided in Chapter 9 of this document.

The following installation screen, shown in Figure 3.7, allows the user to either Disable or Enable Recon Recording within the TETK software being installed. If the software is being installed on a computer that will actually be used with the Automated Route Reconnaissance Kit (ARRK) hardware for recording route recons, then Enable Recon Recording should be selected. If the computer will never physically be connected to the ARRK hardware for recon recording, it is suggested that Disable Recon Recording be selected.

After Next is selected in Figure 3.7, final installation of the software continues when the Next button is selected again via the window shown in Figure 3.8.

Installation progress is shown in Figures 3.9, and the installation process is finalized by selecting Finish (as shown in Figure 3.10). The user is then returned to the screen shown in Figure 3.11, and selecting Exit on this screen completes the entire installation procedure.
Chapter 3   Getting Started

Figure 3.7. Disable/enable recon recording option.

Figure 3.8. Begin final installation.
Figure 3.9. Installation progress displayed.

Figure 3.10. Successful installation.
Starting the software

To start the TETK, double-click the icon on the desktop. The screen shown in Figure 3.12 will appear, and the Toolkit is ready for use.
4 Data Depot Creation and Management

Introduction

Although a project can be created in the Toolkit once the software has been installed on a computer, a Data Depot must exist before any map, imagery, or other geospatial data can be displayed in the main viewing window of the Toolkit. Thus, a basic overview of creating and managing Data Depots is presented in this section, and details of creating and managing projects will be presented in following chapters.

The Data Depot

The Toolkit manages maps, imagery, and other geospatial data into folder structures called Data Depots for storing and organizing data. Data supported by the Toolkit include the NGA-produced and USGS-produced data listed in Appendix A, as well as various other data formats such as certain commercial satellite images. The primary folder containing the Data Depot files and subfolders can be located on any disk drive or network drive accessible to the user’s computer. However, it is suggested that some standard convention be followed whereby Data Depots are always stored in the same location such that other users of the Toolkit can easily determine what data sources are available on a particular computer. This is particularly useful when the Toolkit may be used on laptop computers or other computers that are shared by multiple users and can help avoid duplication of storing large data sets on a computer.

When the Toolkit is installed on a computer, a folded named TETK is automatically created on the root drive or disk, typically the C: \ drive. This folder location is dictated by the option selected during the installation process as shown in Figure 3.5. The default is C: \ TETK, but some other location may have been selected during the installation process. The remainder of this section assumes the default location. During the Toolkit installation, a folder named Data Depots is automatically created under the TETK folder (C: \ TETK\Data Depots). All Data Depots on that computer should then be stored within that C: \ TETK\Data Depot folder. Although it is not required for Data Depots to be stored in this location, it is strongly recommended to do so as a matter of standard convention so
that other Toolkit users can easily determine what data are available on a computer. In Figure 4.1, a Data Depot named Baghdad has been created following this convention. Note that under the C:\TETK\Data Depot\Baghdad folder there are several subfolders containing various formats of geospatial data (CadrgCib, DTED, etc.) for the Baghdad Data Depot.

Typically, the original data that are used to populate the Data Depot are distributed by either NGA or USGS on CD-ROMs or are downloaded via the Internet or the Secure Internet Protocol Router Network (SIPRNET). The Toolkit is not designed to directly read these native data files until they are loaded into a Data Depot and the standard file structure recognized by the Toolkit is created. The Toolkit provides automated utilities to load these data and create the folder structure that forms the Data Depot. Once a Data Depot has been created, the process of loading the data into a Data Depot does not have to be repeated and that Data Depot can simply be copied to any other computer for use with the Toolkit. In doing so, the user must ensure that the folder structure originally created is maintained when the Data Depot files are copied.

A general overview of the process required for loading data and creating a new Data Depot, copying an existing Data Depot, registering Data Depots
with the Toolkit, and viewing the basic data content and geographic coverage of a Data Depot in the Toolkit is presented in the following sections.

Creating Data Depots

Working with Data Depots in the Toolkit is accomplished using the Data Depot window that can be accessed from the View menu as shown in Figure 4.2. To create a new Data Depot for the storage of geospatial data or to register an existing Data Depot with the Toolkit, open the Toolkit and select Data Depots under the View menu as in Figure 4.2. This will bring up the Data Depots window shown in Figure 4.3. In the left-hand pane of that window, right-click with the mouse and select New/Insert with the cursor, as shown in Figure 4.4. This will bring up the New/Insert Data Depot window shown in Figure 4.5.
Figure 4.3. The Data Depots window is displayed.

Figure 4.4. Right-click and select “New/Insert.”
If a new Data Depot is being created to load data, the desired name for that new Data Depot and the directory to store that Data Depot on the computer are entered in the window shown in Figure 4.5. However, if an existing Data Depot is being registered with the Toolkit, the name is left blank and the user browses to the directory where that Data Depot is stored. Once that directory containing the existing Data Depot folder is selected, the Toolkit automatically adopts that folder name as the name of the Data Depot.

New Data Depot for loading data

For example, to create a new Data Depot named Iraq to load data, Iraq is entered as the Name, and the desired directory for storing the Data Depot is specified as shown in Figure 4.6. Click OK in the New/Insert Data Depot window. The geographic extents of the data being loaded may be limited during the loading process. This is accomplished either by typing in the coordinates of the corners of the desired geographic extent or by checking the From Map box as indicated in Figure 4.7. If From Map is checked, then the View tab must be selected to display a world map as shown in
Figure 4.8. On this map, the user may zoom in on the desired area for the Data Depot by selecting the Magnifying Glass tool and holding down the left mouse button to drag a window around the area of interest. The geographic extent of the Data Depot may be defined either by a rectangle on the map or by the borders of a country or of more than one country. To use a rectangle to define the extents, the Rectangle Extents tool is selected and left mouse button is used to drag a rectangle on the map as shown in Figure 4.9. To define the extents by country, the Country Extents tool is selected and one or more countries is selected on the map using the left mouse button (multiple countries may be selected by holding down the Ctrl key on the keyboard and clicking on the countries with the left mouse button). Figure 4.9 indicates the Rectangle and Country Extents tools. Checking the Ignore Extents box in the Load tab will allow all data on the CD to be loaded, regardless of the geographic extent. Figures 4.7 through 4.9 show an example of the extent being defined from the map using the Rectangle Extents tool.

Figure 4.6. New Iraq Data Depot named.
Figure 4.7. From Map box checked to define extents.

Figure 4.8. World map with Magnifying Glass tool zooming on Iraq.
The final step in creating a new Data Depot is to actually load the data. This is accomplished by specifying the directory from which the data are to be loaded in the Load From area, selecting the appropriate data source type to be loaded from the Data Source Type drop-down list, and then clicking Load as shown in Figure 4.10. During the loading process, a window will inform the user of the progress and successful completion. If the loading is not successful, an error message will also appear. The name of the Data Depot into which the data are being loaded must be highlighted in the left-hand pane of the Data Depots window before the Load button is selected. The highlighted Data Depot is shown as the Current Depot near the top of the window. In Figure 4.10, the Current Depot is shown as Iraq.
If multiple data source types are to be loaded or if data are to be loaded from multiple CDs, the user simply repeats the process of specifying the directory from which to load the data, selecting the appropriate data source type, and clicking the Load button. Once all of the data have been loaded into the Data Depot, close the Data Depot window by clicking on the red X in the upper right corner of the window to complete the process. Additional data can be added to a Data Depot later by repeating this loading procedure.

Registering an existing Data Depot

After a Data Depot has been created by loading data as detailed in the previous section, multiple Toolkit users can access that same Data Depot if it is available on a network drive. The Data Depot may also be copied to another computer or to any other data storage device such as an external drive, CD, or DVD. In order to use such an existing Data Depot, the user does not have to repeat the loading process, but the Data Depot must be registered with the Toolkit software. This process of “registering” the Data
Depot simply serves to tell the Toolkit that the Data Depot exists and where it is stored on the computer or network.

Registering an existing Data Depot is also accomplished with the Data Depot window that was used for loading data to create a new Data Depot. The Data Depot window is accessed through the View menu as was shown in Figure 4.2. To register the existing Data Depot, right-click in the left-hand pane of that window and select New/Insert as was shown in Figures 4.3 and 4.4. For an existing Data Depot, the Toolkit automatically detects and adopts the name of that Data Depot once the user specifies the directory where the Data Depot is stored. Recall that Figure 4.1 showed an existing Data Depot named Baghdad stored in the C:\TETK\Data Depot directory. To register this existing Data Depot with the Toolkit, the user browses to that directory (or types in the proper path for the Directory) and clicks OK. Figure 4.11 shows the proper Directory specified and the Name left blank. After clicking OK, the Toolkit adds Baghdad to the list of available Data Depots in the left-hand pane of this window as shown in Figure 4.12.

Figure 4.11. Registering or inserting an existing Data Depot.
The “plus” sign next to the Baghdad Data Depot indicates that data are loaded into the Baghdad Data Depot. No data are loaded into the Iraq Data Depot and, thus, no plus sign appears. The Iraq Data Depot was created, but no data were loaded. Clicking on the plus sign by the Data Depot or any subfolders reveals a listing of the existing data types in that Data Depot or subfolder. Figure 4.13 shows this for the Baghdad Data Depot. A view of the geographic coverage for any data type can be viewed by selecting the View tab, zooming in on the area covered by the Data Depot using the Magnifying Glass tool, and double-clicking on any listed data type. The coverage of 1:100K TLM-100 Topographic Line Map data in the Baghdad Data Depot is shown in Figure 4.14.

This window cannot be used to actually view data or maps. It simply provides a tool enabling the user to view the geographic extent of coverage provided by the various data types in a Data Depot. This is particularly useful when a Data Depot is first loaded to confirm that the loaded data correspond to the geographic area that was expected by the user. It may also be helpful when working with a Data Depot created by another user to learn what data are available and what coverage is provided by each type.
Figure 4.13. Listing of data types in a Data Depot.

Figure 4.14. View of geographic coverage for 1:100K TLM data.
Downloading NGA data from the SIPRNET

Data to populate a Data Depot in the Toolkit can come from a variety of sources, including CDs produced by NGA or USGS, Internet sources, or the SIPRNET. One of the most comprehensive places to find data is the NGA Web site on the SIPRNET. This site provides a wealth of data that can be downloaded and loaded into Data Depots for use with the Toolkit. This section provides a brief summary of how to download and use data from this site with the Toolkit. To use this source, the user must of course have the proper clearance, must have access to the SIPRNET network, and must fully comply with all limitations and proper procedures for handling and use of data downloaded from that network.

The following is a step-by-step procedure for downloading these data for use with the Toolkit.

1. From a computer connected to the SIPRNET, open a Web browser and type in the following URL:

   http://gdn.geoint.nga.smil.mil/gdn/gdn.cgi

   This will bring up the main NGA Geospatial Data Navigator Web site from which the data can be accessed for downloading.

2. On the world map in the center of the page, move the cursor on the map and click on the desired location. By default, clicking will zoom in on the selected location. Continue to click on the map to zoom in to the desired location. Alternatively, the country of interest may be selected from the drop-down list located just below the map.

3. The data showing on the map is controlled by the second drop-down list located just below the country list. Select the desired background map for viewing from that list. Note that this does not control what data will be downloaded. It is only used to control the display on the map for navigating to the desired world location.

4. At any point in the process of zooming in on the desired location on the map, the Products List located below both of the above-mentioned
drop-down lists will show a complete listing of all data products that are available for the area displayed on the map.

5. The most right-hand column of that Products List will indicate for each data type if it is available for Download, if it is not available, or if the user must zoom in more closely on the map.

6. If Download appears in the most right-hand column of the Products List, click on Download to begin the download process.

7. A separate window will appear after Download is selected. The user will be prompted to select the desired data format (NGA Standard Format should be selected) and File Type (Windows Zip file should be selected).

8. After making the above selections, click Create File at the bottom of the window. This brings up another window indicating that the requested file is being created. Once the file has been created, the user will then be prompted to Download via FTP, Download via HTTP, or Download via Global Broadcasting Service. Select Download via HTTP.

9. After selecting Download via HTTP, the user will be prompted to Open, Save, or Cancel. Select Save, navigate to the desired folder in the Save As window, and click Save.

10. After the file has been saved to the selected location, open the Windows Explorer by clicking the right mouse button on Start on the Windows Taskbar and then select Explore. Navigate to the Zip file that was saved to the hard drive and double click on it using the left mouse button. This will open WinZip program. Select “extract” using the left mouse button and select the location where the files will be extracted.

11. Once the data have been extracted, open up the TeleEngineering ToolKit, open the View menu and select Data Depot. From there, load the data into the Data Depot as described in the New Data Depot for Loading Data section of this chapter. The data extracted from the Zip file, which was saved from the NGA Web site may be essentially treated in the same manner as data distributed on CD from NGA and are loaded into the Toolkit in the same way.
5 Basic Project Functions

Introduction

The concept of a “project” was created to facilitate the sharing of geospatial information between SMEs and requesters, and to provide organizational structure for information related to RFIs and responses. A project is implemented as a folder containing component information. A primary folder is created for the overall project, and subfolders are created for each separate type of component information that exists or is created for that project. For details on the project components, refer to Chapter 7.

Projects are user defined and can vary in size, depending on the user’s needs. A project can be limited in scope to contain information related to a single RFI concerning a bridge, road, airfield, or building, or a project can be broader in scope and contain multiple analyses for a specific area or region. Once the project is created, a folder or directory structure is established to organize and store all information associated with the project. Note that this is a distinct and separate set of folders from the Data Depot folders and does not contain the maps or other geospatial data contained in a Data Depot.

This chapter will present the basic information needed to create, modify, save, open, and close projects in the Toolkit. Chapter 6 will provide additional details on viewing maps and other geospatial data in a project and will provide an overview of the basic menus, tools, and utilities of the Toolkit software. Chapter 7 will then provide details of the various components that exist or can be created within a project.

Creating a new project

The window to create a new project is accessed from the File menu as shown in Figure 5.1. Selecting New Project will bring up the window shown in Figure 5.2. Note that three tabs appear in this window: General, Data Source, and Map. Each of these tabs contains some basic fields of information and selections that must be made before the new project can be created. The basic information required in each of these is as follows:
Figure 5.1. Accessing the New Project window.

Figure 5.2. New Project window.
General tab

The basic information required in the General tab includes Project Name, Location, Extents, Security Classification, and General Information.

Name

The Name is typed into the Name field and can be anything appropriate for the project, such as the geographic location of the project or something referring to the technical problem or issue for which that the project is created. The project name may not contain any of the following characters:

*  |  \  /  :  “  <  >  ?

Location

The Location field defines the directory on the computer or network where the project folder will be stored. This can be typed, or the user can browse to the desired directory by clicking on the button with the three small dots at the right end of the location field and browsing to the desired directory.

Extents

The geographic boundaries of the project are defined by the Extents. This can be specified by typing the coordinates of the northeast and southwest corners of the area, or by selecting the extents on the map in the Map tab. Checking the From Map box will enable this option. The process of defining the extents from the map is detailed later in this section.

Security Classification

The appropriate security classification for the project can be chosen from the drop-down list in the Security Classification field, and this label can then be displayed at the top and bottom of the main viewing window.

General Information

The user has the option of typing any general information related to the project in the General Information field. This field may be left blank. Figure 5.2 shows an example of the information in the General tab.
Data Source tab

The Data Source tab is used to designate specifically which Data Depot is to be used for the background maps and geospatial data in the new project that is being created. There may be multiple Data Depots on a given computer, and for each data source (type of map or other geospatial data) the user must specify which Data Depot is to be used. It is possible to use more than one Data Depot for a single project whereby certain types of data are pulled from one Data Depot while other types of data are from a different Data Depot. The Data Source tab in the New Project window consists of two panes. The left pane provides a listing of all of the potential data types that may exist in a Data Depot, and the right pane contains a listing of Toolkit-registered Data Depots on the computer.

Three steps must be completed to designate the Data Source for a new project. The first step is to highlight the appropriate Data Depot in the right pane. The second step is to highlight the Data Source types in the left pane that are to be set from that Data Depot. Initially the user should select the entire list of Data Source types, even if the Data Depot being used does not contain all of those types. The third step is to click on the Set Depot button. When this is completed, the name of the Data Depot adjacent to each listed Data Source type in the left pane should change from No Depot to the name of the selected Data Depot. The user must be certain to click Set Depot before clicking OK.

The user may select all of the Data Source types to be from a single Data Depot, or the user may select only specific Data Source types to be from one Data Depot while the remaining Data Source types are from a second (or third, or more) Data Depot. To use multiple Data Depots for a single project, simply highlight a different Data Depot, select the Data Source types that are to be from that different Data Depot, and click Set Depot again. The Data Depot name adjacent to those Data Source types should then change to reflect the different Data Depot.

Figure 5.3 shows the Data Source tab of the New Project window with all of the Data Source types highlighted and the Baghdad Data Depot selected. Figure 5.4 shows that the name adjacent to each Data Source type has changed from No Depot to Baghdad after clicking the Set Depot button.
Figure 5.3. Data Source tab of New Project window.

Figure 5.4. Data Depot set to Baghdad.
Map tab

The geographic extents of the project can be specified in one of two ways. One way is to type in the coordinates of the northeast and southwest corners of the area in the General tab, and the other is to check the From Map box in the General tab and to then define the geographic extents on the map in the Map tab.

To use the map option, first check the From Map box in the General tab and then select the Map tab of the New Project window. This will bring up a map of the world as shown in Figure 5.5. If for some reason this entire map does not appear, the world map can be refreshed by clicking on the button labeled “1:1” just above the map window. Using the magnifying glass button, zoom in on the general geographic area for the project being created by holding down the left mouse button and dragging a window around the area of interest. Finally, define the geographic extent for the project using one of the three selection buttons provided. These three buttons provide the option to select a country (multiple countries may be selected by holding down the Ctrl key on the keyboard and selecting several countries), to define a rectangular box, or to define a polygon to define the boundaries or extent of the project. These three buttons are shown in Figure 5.5, which also shows the world map and magnifying glass button that is used to zoom in on the more detailed view of the project area.

Figure 5.6 shows an example of the geographic extent selected by dragging a box around the area of interest using the box selection tool. The geographic size of the project should be limited as much as is practical. During the operation of the Toolkit, time required to plot geographic scenes can be reduced by limiting the size of the project. For example, a project used to analyze potential fording sites may be only a few kilometers square. A project for this purpose and size would allow the user to view the data for that area of interest, to mark the exact sites for subject matter experts to analyze, and to view the SMEs’ graphical responses, while minimizing plotting times. Once this step is completed, clicking OK will complete the process and the new project is created.
Chapter 5 Basic Project Functions

Figure 5.5. World map with magnifying glass and extent selection tools.

Figure 5.6. Selection of geographic extents using box selection tool.

Country, Box, and Polygon selection tools
Prior to clicking OK, it is wise to double-check each of the three tabs in the New Project window to ensure that the proper information has been entered or selected. Once the project has been created, there are some aspects of the project that cannot be modified later. So, it is worthwhile to check the initial input prior to finalizing the project creation.

Figure 5.7 shows an example of the initial view that results when a new project is first created. The View Control window is on the left and contains a series of folders that will be used to work with the various project components that are detailed in Chapters 7 and 8, and the main viewing window is on the right. That main viewing area is initially a blank dark area with only the selected security classification for the project shown. The user must specify what type of map or image to display before data will appear in the main viewing window. Chapter 6 will provide guidance on viewing maps, imagery, and other geospatial data.

Figure 5.7. Initial project view.
Saving a project

As soon as a new project has been created, it is good practice to save that project. Saving a project in the Toolkit simply requires selecting Save Project in the File menu as shown in Figure 5.8. Note that, in the File menu, there is also a Save option; however, this is used when working with documents and other files in the Toolkit, and Save Project must be selected to save a Toolkit project.

![Figure 5.8](Image) Selecting Save Project from the File menu to save a project.

Modifying a project

After a project is created, several aspects of the project cannot be changed. The project name, the directory in which the project is stored, and the geographic extent of the project cannot be changed. However, some items can be changed. The security classification, the general information, and the data source can be modified. To modify any or all of those items, select Modify Project from the File menu as shown in Figure 5.9. This will bring up the Modify Project window shown in Figure 5.10.
Chapter 5  Basic Project Functions

Figure 5.9. Selecting Modify Project from the File menu.

Figure 5.10. The Modify Project window.
Modifying the security classification

Under the General tab, the security classification can be changed simply by selecting a different classification level from the drop-down list. Figure 5.11 shows the standard security classification options. The user may provide any releasability or other special caveats that are needed for the classification of a project by typing them into the box to the right of the standard security classification options. The user-provided information will appear at the top and bottom of the main viewing window along with the selected standard security classification option.

![Figure 5.11. Modifying the security classification.](image)

Modifying the general information

Changes to the general information or comments can be made by simply typing new comments or editing the existing comments in the General Information area of the Modify Project window.
Modifying the data source

The Data Depot for any data source may be changed on the Data Source tab of the Modify Project window. Figure 5.12 shows the Data Source tab with Baghdad as the Data Depot for all of the data source types in the project. The Data Depot can be modified for some or all of those data sources. To do so, the user highlights the specific data sources that are to come from a different Data Depot and then highlights the Data Depot to be used for those data sources. Clicking the Set Depot button will modify the data source. For example, to set Iraq as the Data Depot for all of the ADRG Data Source types, those data source types are highlighted and then the Iraq Data Depot is highlighted as shown in Figure 5.12. After clicking the Set Depot button, the name of the Data Depot for those data sources changes from Baghdad to Iraq, as shown in Figure 5.13. This process can be repeated to assign additional Data Depots for other data sources as needed. Note that it is critical to click Set Depot for this modification to take effect. Clicking the OK button will close the Modify Project window and the changes will take effect. The project should be saved to ensure that all of the changes are retained for future use.
Opening a project

Opening an existing Toolkit project can be accomplished in several ways. A project can be opened by browsing in Windows to the folder with the Project File. This file will be in the folder to which it was saved when the project was created. Recall that the location of the project folder is specified in the General tab of the New Project window (see Figure 5.2). The Toolkit project file has the same name as the project with the “.tep” file extension. For example, to open the project named Baghdad_North, the user would double-click on the file named Baghdad_North.tep. These files have a Corps of Engineers castle icon as shown in Figure 5.14.

The other methods of opening a Toolkit project are accessed through the File Menu as shown in Figure 5.15. The simplest way to open a recently used project is to select the desired project from the list of recently used projects, which appears at the bottom of the File menu. As shown in Figure 5.15, a numbered list of the four most recently used projects is shown, and clicking on any item in that list will open that project. (The number of recently used projects can be changed to a maximum of nine.)
Chapter 5   Basic Project Functions

Figure 5.14. Toolkit project file in project folder.

Figure 5.15. Options to open a Project from the File menu.
If the desired project does not appear on that list, Open Project should be selected from the File menu. When Open Project is selected, the Open Project window shown in Figure 5.16 will appear. This is essentially a world map with red boxes over the geographic locations of existing projects. Note that the location and number of these red boxes will differ on each computer depending on the specific existing projects on that computer and will not appear exactly as in the example shown here.

From the Open Project window, there are four ways to open a project. The first is to click on a red box on the map, which will result in the path to that project appearing at the top of the window. Clicking OK will then open that project. In some cases multiple projects exist or overlap in the same geographic location. For example, in Figure 5.16 the two projects in Iraq overlap. An Iraq project encompasses the entire country and a smaller Baghdad_North project is in the center of the country. Clicking where those projects coincide brings up the Select Project window in Figure 5.17. Selecting the desired project from that list places the path to that project at the top of the window, and clicking OK then opens the project as shown in Figures 5.18 and 5.19.
Figure 5.17. Select Project window.

Figure 5.18. Selecting desired project from list.
The second method of opening a project from the Open Project window is to click on the arrow at the right end of the project file area to bring up a drop-down listing of previously opened projects. Figure 5.20 shows an example of this. Selecting the desired project and clicking OK will open that project.

The third method is to click on the button with the three small dots near the upper right corner of the Open Project window. This will open up a file browser, and the user can browse to the project folder, select the project file, and click Open. This will place the path to that project file in the top of the main Open Project window, and clicking OK will open the project. Figure 5.21 shows an example of this method.

The fourth and final way to open a Toolkit project is to simply type the path to the desired project file in the top part of the Open Project window and click OK.
Figure 5.20. Opening a project from the drop-down project list.

Click to open browser

Figure 5.21. Browsing to project file in Open Project window.
Closing a project

A Toolkit project can be closed by either selecting Close Project from the File menu, as shown in Figure 5.22, or by simply clicking in the red X in the upper right corner of the main viewing window.

Figure 5.22. Closing a project.
6 Basic Display Operations and Utilities

Introduction

This chapter provides an overview of the tools, menus, system settings, and utilities available in the Toolkit. The information in this chapter will give the user the knowledge required to display maps and other geospatial data, to use the tools for navigating through those maps and data, and to understand the menus and available options within those menus.

The information in this chapter is based on the assumption that the user is familiar with creating and managing Data Depots and with creating, opening, and managing projects as described in Chapters 4 and 5 of this manual. Upon creating a project in the Toolkit, the initial appearance of the Toolkit will be similar to that shown in Figure 6.1. The specific arrangement of the toolbars, project name, and security classification may not be exactly as shown, but the general layout will be similar.

![Figure 6.1. Basic layout of Toolkit interface.](image)
The main components of the Toolkit window include the six menus (File, Edit, View, Utilities, Window, and Help) at the top, several toolbars just below those menus, the View Control window to the left, and the main viewing window to the right. Note that there are six tabs across the bottom of the View Control window, each of which brings up a different view in the View Control window for various functions in the Toolkit. The following sections describe each of these components of the Toolkit in detail.

**Menus**

**File menu**

Figure 6.2 shows the File menu. This menu provides the ability to (1) print maps and displays from the main viewing window, (2) export an image from the main viewing window, (3) create, open, save, modify, and close Toolkit projects, and (4) exit the Toolkit software. Note that the New, Open, Close, Save, and Save As options are grayed out. These become active only when certain components of a Toolkit project are being used.
Edit menu

The Edit menu allows the user to copy the map or image presently displayed in the main viewing window to the clipboard. That map or image can then be “pasted” into another application such as Microsoft PowerPoint® or Microsoft Word®. This provides a very simple and powerful tool for quickly creating presentations and documents with high-quality graphics and maps. To use this tool, simply select the “Copy Map to Clipboard” entry on the list as shown in Figure 6.3 to copy the display to the clipboard. Then, while the mouse pointer is in an active PowerPoint® slide or Word® document, press “Ctrl-v” or right-click with the mouse and select Paste to place the image into that slide or document. The image will be copied as a bitmap image at the location of the cursor. Note that the Cut, Copy, and Paste options in this menu are grayed out. These will become active for use only with selected applications or components of the Toolkit, and their use will be detailed in the description of those components of the Toolkit later in this document.

![Edit menu](image)

Figure 6.3. Edit menu.
View menu

The View menu allows the user to control the various Toolbars, to open and close the View Control window, to open and close the Output Control window, to turn on or turn off the Status Bar, to view and manage Data Depots, and to view or change the System Settings by selecting Options. Figure 6.4 provides an image of the View menu, and the following sections detail the function of each option in that menu.

Toolbars

As shown in Figure 6.5, the Toolkit offers five toolbars that can be controlled through the View menu: Map Mode, Zoom Bar, Contrast Bar, Jump Bar, and Edit Bar. Each of these toolbars is identified in Figure 6.6.
Figure 6.5. Toolkit toolbars.

Figure 6.6. Toolbars identified.
Map Mode

The Map Mode tools are used as follows:

- The arrow puts the cursor in normal mode. Use this mode when selecting items on the map or marking a location on the map for the Jump Bar (see below).

- The crosshair, or center project button, is used to redraw the map or image in the main viewing window and to center the display at the geographic center of the project extents.

- The hand puts the cursor in pan mode, and the user can move the map by holding down the left mouse button while dragging the map in the main viewing window in the desired direction. Releasing the mouse refreshes the screen with the map at the new location.

- The magnifying glass is used to zoom in to a more detailed view in the main viewing window. Click and hold the left mouse button and drag a window around the desired area, release the button, and the map or image will refresh and will be zoomed in on that selected area.

- The distance wheel is used to measure straight-line distances in the main viewing window. Hold the left mouse button and drag the cursor across the screen. The location of the starting and ending points, the distance between the points, and the azimuth of the line between the two points is displayed at the bottom of the Toolkit window in the Status Bar area (see Status Bar description later in this chapter). A history of measurements is displayed in the Output Control window, which is described later in this chapter.

Zoom Bar

The zoom bar buttons are shortcuts for zooming in and out on the map or image in the main viewing window. The Zoom Bar buttons are used as follows:
• **1:1** The 1:1 button will redraw the map or image in the main viewing window at its normal scale or resolution. If for some reason the user zooms too far in or too far out on the map or image, clicking this button will bring the map or image back to a normal scale for better viewing.

• **x½** The x½ button will redraw the map or image in the main viewing window at ½ the scale, or “zoomed out” by a factor of 2.

• **x¼** The x¼ button will redraw the map or image in the main viewing window at ¼ the scale, or zoomed out by a factor of 4.

• **x2** The x2 button will redraw the map or image in the main viewing window at 2 times the scale, or zoomed in by a factor of 2.

• **x4** The x4 button will redraw the map or image in the main viewing window at 4 times the scale, or zoomed in by a factor of 4.

• **Zoom All** The zoom all button will redraw the map or image in the main viewing window to the full geographic extent of the project. Caution should be used with this button. Note that a long delay may occur while the Toolkit redraws the screen if this button is clicked when detailed imagery or maps are displayed and the project encompasses a large geographic area.

---

**Contrast Bar**

The contrast bar allows the user to control the brightness of the map or image in the main viewing window. The tools are used as follows:

• **Black Circle** Pressing the black circle will cause the entire main viewing window to be displayed black.

• **Black Arrow** The black arrow will darken or reduce the brightness of the main viewing window by 10% each time it is selected.
The black and white circle redraws the main viewing window at its normal or native brightness. If the Toolkit screen appears black or white, and the reason is unknown, clicking this button may solve the problem by returning the display to normal brightness.

Pressing the white arrow will lighten or increase the brightness of the main viewing window by 10% each time it is selected.

The white circle will cause the entire main viewing window to be displayed white.

**Jump Bar**

The Jump Bar is used to redraw the map or image in the main viewing window with the display centered at a specified location.

The location window contains the coordinates of the geographic location that will be the center of the display when the jump button is clicked. Coordinates can be typed or pasted into this window, or the user may select the Arrow tool from the Map Mode toolbar and click on any location on the map. The coordinates of that location are automatically entered into the location window, and clicking the jump button re-centers the map at that location. The coordinates in the location window can be in Military Grid Reference System (MGRS), Universal Transverse Mercator, or geographic (latitude/longitude) formats.

When the jump button in clicked, the image in the main viewing window will be redrawn and centered at the geographic location corresponding to the coordinates in the location window.

**Edit Bar**

The tools in the Edit Bar are used when creating or editing geographic objects in the various components of the project as overlays to the map or image in the Toolkit.
The Enter/Extend button will return the cursor to the mode of entering additional points along a line or polygon that is being created or along a line that is being edited.

The Edit button will allow the user to edit the points of a line or polygon while the line or polygon is being created or edited.

Clicking the Cancel button will cancel any edits or changes that have been made to the current object during the current editing of the object.

The Done button is clicked when creation or editing of the geographic object is complete. This button commits the creation or modification of the geographic object to the component of the project that is currently active.

The Undo button can be used to undo or nullify the most recent point entered while a line or polygon is being created or while a line is being edited. Clicking the undo button multiple times will simply repeat the “undoing” of points one at a time until the line or polygon is essentially deleted.

View Control

Selecting View Control from the View Menu will toggle the View Control window at the left side of the Toolkit display on or off. If for some reason the View Control window is no longer visible, select View Control and this may bring back or reopen that View Control window. There is also a shortcut to this option with this same icon located along the main toolbar near the top of the Toolkit display.

Output Control

Selecting Output Control from the View Menu will toggle the Output Control window at the bottom of the Toolkit display on or off. The Output Control window is not open for most operations in the Toolkit. However, there are some applications for which it is used, one of which is recording and processing data from the Automated Route Reconnaissance Kit.
Figure 6.7 shows the Toolkit display with the Output Control window open. One very useful application of the Output Control window concerns data for distance measurements made using the distance wheel from the Map Mode toolbar. The start point, end point, distance, and azimuth are written in the Output Control window as each measurement is made. If desired, this information can be copied and pasted into another application such as a document or notepad and can be saved.

![Output Control window](image)

**Figure 6.7. Output Control window Open.**

**Status Bar**

Selecting Status Bar from the View Menu toggles the Status Bar at the bottom of the Toolkit display on or off. The Status Bar provides the current grid coordinate location of the cursor as it moves around the main viewing window. Figure 6.8 shows the location of the Status Bar.
Data Depots

Selecting Data Depots from the View Menu brings up the Data Depots window. Details on the use of the Data Depots window are provided in Chapter 4 of this manual.

Options

Selecting Options from the View Menu brings up the System Settings window. Through the System Settings window, the user can control or change various settings via the five tabs: Configuration, User Interface, User Profile, Elevation Profile, and Database Manager. Each of these is described in greater detail below.

- The Configuration tab, shown in Figure 6.9, allows the user to change the configuration directory name and path. The configuration directory stores a variety of Toolkit configuration data, such as overlays. Changes to this are not recommended.
The User Interface tab allows the user to control several features of the interface, as shown in Figure 6.10. This tab can be used to control whether the “stacker” automatically redraws the display (see later in this chapter for details on the “stacker”), to control the number of recently opened projects on the File menu, to specify the selection tolerance (number of pixels) that dictates the maximum distance on the screen between an object (annotation, icon, etc.) and the mouse pointer when a selection is made, to toggle the display of the security classification on the map, and to control the auto pan mode.

The User Profile tab allows the user to add, modify, and delete user profiles. For example, clicking Add in the User Profile tab will bring up the Add/Modify User Profile window as shown in Figure 6.11. Information about a specific user can be entered into this window to create a new user profile after clicking OK. Other user profiles may be added, edited, or deleted by then selecting the Add, Modify, or Delete buttons on the User Profile tab.
Figure 6.10. User Interface tab in the System Settings window.

Figure 6.11. User Profile tab in the System Settings window.
The Elevation Profile tab as shown in Figure 6.12 allows the user to change the profile spacing for the x-axis of the graph that is created when an elevation profile is plotted along a line across the terrain in the main viewing window. Decreasing the number will increase the number of points plotted, thereby increasing the detail of the plot. However, the user must be aware of the native scale or resolution of the digital terrain data being plotted. For example, if the horizontal resolution of the digital terrain data is 30 meters, then changing the profile spacing value to anything less than 30 meters does not create more detailed terrain data. It simply causes more points to be plotted along the line across that 30-meter resolution data, although inherently there is still only an elevation data point once every 30 meters across the terrain from which to plot those points. The DTED must also be present in the specified Data Depot for the project before an elevation profile can be plotted. An elevation profile will not be created if no DTED data exist for the location being analyzed.

Figure 6.12. Elevation Profile tab in the System Settings window.
The Database Manager tab in Figure 6.13 allows the user to define the directory or folder path for the current database and working folder. The database can be a remote location on a network or server to create a centralized database for multiple users to store and share annotations and documents.

Utilities

The Utilities menu as shown in Figure 6.14 provides links to open several tools and utilities in the Toolkit. These include the QuickBird Histogram, Global Positioning System (GPS) Control, Coordinate Calculator, and Spreadsheet Coordinate Converter. Each of these is described in more detail in the following sections.
Figure 6.14. Utilities menu.

QuickBird Histogram

The QuickBird Histogram utility is used when importing a QuickBird image that has been split into multiple images to fit onto multiple CDs when the original image is too large to fit onto a single CD. The QuickBird data is 11 bits per pixel, and most computer graphics cards support only 8 bits per pixel for display per channel.

The Toolkit software generates statistics to reduce the data from 11 bits to 8 bits on an image-by-image basis. When using this utility, the statistics will be generated from all of the CDs rather than just the one image, thus allowing the 11-bit to 8-bit conversion to be the same for all of the images. The reason that the statistic will be different for each of the split images is that some of the images may be only a small piece of the original. The statistics are stored in a file in the TETK\Configuration\QuickBird folder. If QuickBird images are viewed without using this utility, the seams between the images that have been split may be visible.
GPS Control

GPS Control allows a user to set up a global positioning system to collect data from a moving vehicle. To configure a GPS with a laptop, the proper communication ports must be selected for that computer. Clicking Options on the GPS Control window will display the GPS Control Options window, as shown in Figure 6.15. Once the proper settings are entered or selected in the GPS Control Options window, clicking OK in that window and selecting Activate in the GPS Control window will allow data collected from the GPS to be shown through the GPS Tracker in an open project.

![Figure 6.15. GPS Control and GPS Control Options windows.](image)

Coordinate Calculator

The Coordinate Calculator utility converts a given coordinate from one coordinate system to another. Selecting Coordinate Calculator from the Utilities menu brings up the Coordinate Calculator window (Figure 6.16). As Input, the user enters the coordinate to be converted and selects the appropriate coordinate system for the original coordinates from the drop-down menu. The desired Output coordinate system is selected, and clicking Convert performs the conversion and displays the results.
As an example, Figure 6.17 shows coordinates in the Input section with MGRS selected from the drop-down menu to the left. In this example, the desired output is geographic coordinates (latitude/longitude) expressed in degrees, minutes, and seconds. This option (Geodetic Degrees Minutes Seconds, GEO DMS) is selected from the drop-down menu in the output section, also shown in Figure 6.17. The user may also specify the datum and specific format for the output using the tabs near the bottom of the window. Clicking Convert will perform the coordinate conversion, and the results are as shown in Figure 6.18.

The tabs along the bottom of the Coordinate Calculator window can be used to specify a certain datum, to select output formats, to identify Universal Transverse Mercator (UTM) zones, and to view a history of recently converted points.

The Toolkit supports several coordinate systems and formats: Military Grid Reference System (MGRS), UTM Integer (UTM Int), UTM Decimal (UTM Dec), Geographic Decimal Degrees (GEO DEC), Geographic
Degrees Minutes (GEO DM), GEO DMS, and World Geographic Reference System (GEOREF).

Figure 6.17. Coordinate Calculator example input.

Figure 6.18. Coordinate Calculator example output.
Spreadsheet Coordinate Converter

The Spreadsheet Coordinate Converter utility enables coordinates that are contained in a Microsoft Excel spreadsheet or Microsoft Access Database file to be converted from one coordinate system to another in one batch operation rather than converting the points one at a time using the Coordinate Calculator. Selecting Spreadsheet Coordinate Converter from the Utilities menu will bring up the window shown in Figure 6.19.

In the Spreadsheet Coordinate Converter, the user specifies the name of the file containing the coordinates to be converted as the Data Source by clicking on the button with the three dots to the right of the Data Source block and browsing for the appropriate file. If the spreadsheet or database file has more than one worksheet or table, the Sheet/Table drop-down menu will automatically list the names of those worksheets or tables and the user selects the correct one from that list. The actual file being converted can be viewed by clicking on View Source and, if changes are made to that file while the Spreadsheet Coordinate Converter is open, the contents of that file can be updated by clicking Update Source. Finally, the Input and Output formats are specified using the series of drop-down menus, and clicking Convert will complete the conversion process.

For example, five points with MGRS coordinates shown in Figure 6.20 will be converted to latitude/longitude using the Spreadsheet Coordinate Converter. The name of the spreadsheet is MGRS_Convert1.xls, and the
data are contained in Sheet1. Figure 6.21 shows the fields of the Spreadsheet Coordinate Converter with the Input and Output formats specified. Clicking Convert will result in the Latitude/Longitude column being populated with the converted coordinates as shown in Figure 6.22. The same procedure can be used to convert latitude/longitude coordinates back to MGRS, or any other supported coordinate system.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Latitude / Longitude</td>
</tr>
<tr>
<td>1</td>
<td>MGRS</td>
</tr>
<tr>
<td>2</td>
<td>38 S L C 20087 58325</td>
</tr>
<tr>
<td>3</td>
<td>38 S N B 57548 10623</td>
</tr>
<tr>
<td>4</td>
<td>38 S L A 44947 98167</td>
</tr>
<tr>
<td>5</td>
<td>38 S N C 47502 95719</td>
</tr>
<tr>
<td>6</td>
<td>38 S L C 36000 56536</td>
</tr>
</tbody>
</table>

Figure 6.20. Points to be converted from MGRS to latitude/longitude.

![Spreadsheet Coordinate Converter](image)

Figure 6.21. Spreadsheet Converter window for MGRS to lat/lon conversion.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Latitude / Longitude</td>
</tr>
<tr>
<td>1</td>
<td>MGRS</td>
</tr>
<tr>
<td>2</td>
<td>38 S L C 20087 58325</td>
</tr>
<tr>
<td>3</td>
<td>38 S N B 57548 10623</td>
</tr>
<tr>
<td>4</td>
<td>38 S L A 44947 98167</td>
</tr>
<tr>
<td>5</td>
<td>38 S N C 47502 95719</td>
</tr>
<tr>
<td>6</td>
<td>38 S L C 36000 56536</td>
</tr>
</tbody>
</table>

Figure 6.22. MGRS coordinates converted to latitude/longitude.
Window

The Window menu provides a number of tools for managing the display of multiple windows in a Toolkit project. By default, a single window is created in the main viewing area when a project is created, but the Window menu includes tools to create additional windows and to manage and control the window arrangement. Figure 6.23 shows the Window menu with a single window open in the main viewing area of the Toolkit interface.

New Window

Clicking New Window in the Window menu will create a second window. Figure 6.24 shows an example with two open windows in the main viewing area, Baghdad_North:1 and Baghdad_North:2. This New Window option can be selected multiple times to open any number of windows in the main viewing area. These windows can be arranged in any manner the user desires by simply resizing, maximizing, or minimizing them manually with the mouse as with any standard window.
Cascade

The Cascade tool in the Window menu will arrange the windows in a cascading manner as shown in Figure 6.25.

Tile

The Tile tool in the Window menu will arrange the windows in a tiled manner as shown in Figure 6.26.

Note (as shown in Figures 6.25 and 6.26) that one of the two windows is darker blue or highlighted compared with the other window (the Baghdad_North:2 window in both cases). This is the active window, and any changes or operations that are selected in the Toolkit will take effect on the map display in that window. A window can be made active simply by clicking anywhere in or on the window.
Figure 6.25. Cascade arrangement of windows.

Figure 6.26. Tile arrangement of windows.
Arrange Icons

If multiple windows have been opened and minimized, and if the resultant icons for each window have been manually rearranged or moved, selecting Arrange Icons will relocate those window icons in line along the bottom of the main viewing window area.

Active Window List

The Window menu also has an option for activating windows that becomes available once multiple windows have been opened. Figure 6.27 shows the Window menu with this option included. The name of the window that has the check mark by it will be the active window, and simply clicking by another named window on that list will make that window the active window.

![Figure 6.27. Active Window tool in Window menu.](image)

More Windows

If multiple windows are open, the Window menu includes a More Windows option. Clicking this brings up the window in Figure 6.28. A
single window can be selected and then closed or minimized. Holding the Shift or Ctrl keys on the keyboard allows multiple windows to be selected or highlighted, and the Cascade, Tile Horizontally, and Tile Vertically options can then be used.

![Figure 6.28. More windows management options.]

In the examples presented above, both of the windows had the same map display. However, the power of using multiple windows is that each window can have a different map or image background. Changing the map background in the main viewing window is covered in Chapter 7, but an example of having two different map backgrounds in two different windows is shown in Figure 6.29.

Note that instructions on how to select and display maps and images in the main viewing window as shown in Figure 6.29 are provided in the following View Control window section under the Background tab description.
Chapter 6   Basic Display Operations and Utilities

View Control window

The View Control window in the Toolkit has six tabs along the bottom of the window, each of which provides various tools and options for the user. These include managing various components of the Toolkit project with the Project tab, controlling which maps or imagery are displayed in the main viewing window with the Background tab, viewing the legend with the Legend tab, organizing and managing overlay displays with the Stacker tab, setting the coordinate system for the project with the Coordinates tab, and viewing the extents of the project with the Extents tab. Figure 6.30 shows the View Control window with these six tabs identified.

The following sections provide an overview of the use and capabilities that are available through the View Control window. Chapter 7 presents details regarding most of the components of the Project tab.
The Project tab view in the View Control window is displayed in Figure 6.30. The Project tab contains a series of folders that are used to create and manage the various components of a project. The user may create annotations, manage documents, import shapefiles, and perform a number of other functions through the folders in the Project tab. This section merely presents a brief overview of the Project tab. Details of each available project component are provided in Chapter 7.

The Background tab is used primarily to control or specify what map, image, or other geospatial data will be displayed in the main viewing window. Figure 6.31 provides a view of the Background tab display in the View Control window. Each of the buttons and drop-down menus in the Background tab is described below.
Redraw

The Redraw button will simply redraw or refresh the display in the main viewing window. After selecting a new Type or Source (a new map or image) from the drop-down menus, this button must be clicked for that change to take effect and for the new map or image to appear in the main viewing window.

![Image of the View Control window with map and buttons for Redraw and Export Image]

Figure 6.31. Background tab display in View Control window.

Export Image

The Export Image button enables the user to export an image of the current display in the active main viewing window. Clicking the Export Image button will bring up the Export Image window as shown in Figure 6.32. After choosing a file name and selecting the other desired options for the image, clicking OK will save a georeferenced image file that can be viewed using standard image viewing software or imported into another application such as a PowerPoint presentation or document.
Types

The Types drop-down menu in the Background tab contains a listing of all of the primary types of data (maps, imagery, and other geospatial data) that can be displayed in the Toolkit. To display a certain type of data, the user must first select the appropriate Type from this menu. Figure 6.33 shows the Types drop-down menu. For each of the types of data listed, there are generally multiple data sources included within that data type. Those sources include the various scales of maps or imagery of different resolutions. Once a particular type is selected from the drop-down menu, the Source drop-down list(s) and other settings that are available for the selected data Type will be shown.

Appendix A includes a complete listing of the data Types that are supported for use with the Toolkit, along with a listing of the data Sources that are available within each data Type.
Source

The Source drop-down list is used to select the specific Source from within the selected Type. After selecting the desired data Source, the user must click the Redraw button to refresh or update the main viewing window with the desired map or image. Note that only some of the possible data Sources may actually be loaded into a given Data Depot. This is reflected by the red and green dots in the data Source listing. A green dot indicates that a particular Source is loaded into the Data Depot, while a red dot indicates that it is not.

For most of the common data types (such as the standard NGA and USGS map and imagery data), the only option will be to select the desired data type from the Source drop-down list. An example of this is provided in Figure 6.34 where the drop-down list of the available sources for the CADRG/CIB data type is shown. Here, the 1:250K JOG Joint Operations Graphic is highlighted. After selecting this Source and clicking the Redraw button, the main viewing window is redrawn to show the 1:250K JOG map, as shown in Figure 6.35.
Figure 6.34. Data Source drop-down menu.

Figure 6.35. Main viewing window redrawn with 1:250K JOG source.
Other options and selections are available for some of the other data types. For digital terrain data such as DTED, the Elevation Tint or Relief data type may be selected, and for each of these types the user can adjust the display in the main viewing window. For Elevation Tint, the grayscale starting and ending values can be adjusted, and for Relief, the Vertical Exaggeration. Figures 6.36 and 6.37 show the Elevation Tint and Relief data types selected with the associated options shown under Source.

For data sources that involve multi-spectral imagery, the user will select the Red, Green and Blue sources. This includes such data types as IKONOS-2 Multi-Spectral, LandSat 7 Multi-Spectral, and QuickBird Multi-Spectral. An example of this is shown for IKONOS-2 Multi-spectral Imagery in Figure 6.38.

![Figure 6.36. Source options for Elevation Tint data type.](image)
Figure 6.37. Source options for Relief data type.

Figure 6.38. Source options for multi-spectral imagery.
Data Depot

The Data Depot area lists the name of the Data Depot that has been set for the current project. It is from this Data Depot that the selected data Type and Source is drawn. Note that if the words No Depot appear under Data Depot, then no Data Depot has been set for the project and the main viewing window will be blank. If the main viewing window is blank for some unknown reason, the user should check this to ensure that the Data Depot has been set for the project. If it has not, the user can correct this under the Modify Project option in the File menu as described in the Modifying a Project section of Chapter 5.

Grayscale

Checking this box and clicking Redraw will cause the map or image in the main viewing window to be redrawn with grayscale coloring.

Legend tab

Clicking on the Legend tab in the View Control window will display the legend for the annotations, layers, or other overlays that are open. If none of these open is at the time, the Legend tab will be blank. Figure 6.39 shows an example of the Legend tab when a surface material overlay is open in the project. Chapter 7 provides details on how to create and open annotations, layers, and other overlays that will have their legend displayed in the Legend tab.
Stacker tab

The Stacker displays a listing of every active layer in the project. The Stacker is used to toggle the display of individual or multiple layers on or off, and it is used to control the order in which the layers are drawn on the screen, i.e., which ones are drawn on top of others.

Figure 6.40 shows the Stacker with surface material and drainage overlays. In the main viewing window, the tan area is material ML, the blue areas are various water features, and the small green icons along the river are dams. In Figure 6.41, the boxes for Open Water and Streams have been unchecked, the Redraw shortcut at the top of the screen clicked, and the display redrawn with those overlay categories no longer displayed.

The order in which the overlays are drawn is controlled by the order in which they are listed. Those at the top are drawn last. In Figure 6.42, the Dams overlay has been dragged above all of the other overlays and the screen redrawn. Note that the green dam icons are now drawn on top of the shaded areas and are more clearly visible on the screen.
Figure 6.40. Stacker tab example.

Figure 6.41. CL surface material category display turned off.
Coordinates tab

The Coordinates tab is used to specify the coordinate system displayed in the Status Bar, to select the unit format and accuracy, and to select the distance units used when measuring with the Distance Wheel tool. Figure 6.43 shows the Coordinate tab display, and Figure 6.44 shows the drop-down menu of available coordinate systems supported in the Toolkit.

As an example, Figure 6.45 shows that GEO DMS has been selected as the coordinate system. In the lower left portion of the interface in the Status Bar area, note that the coordinates for the location of the cursor on the map in the main viewing window are given in that format. If the user would like to use a specified datum for the selected coordinate system, the Datum box may be checked and the appropriate datum selected from the drop-down menu.

In the drop-down menu for Distance as shown in Figure 6.46, several distance units are available for use with the Distance Wheel measurement tool (see description of Map Mode toolbar earlier in Chapter 6).
Figure 6.43. Coordinate tab.

Figure 6.44. Available coordinate systems.
Chapter 6 Basic Display Operations and Utilities

Figure 6.45. Geodetic coordinates in status bar.

Geodetic coordinates – degrees, minutes, seconds

Figure 6.46. Available units for distance measurement.
Extents tab

The Extents tab provides a spatial reference for the geographic extent of the project, the area of the current active display window, and the coverage area for the data in the assigned Data Depot. Figure 6.47 is an example of the display in the Extents tab. The green area represents the geographic extent of the current project, and the black area represents the geographic extent of the active display window. In this example, the map area being viewed or displayed in the main viewing window is just slightly to the east of the geographic center of the project extents.

The geographic extent of any data type available in the project for the assigned Data Depot can be displayed by clicking in the drop-down list above the word Depot. Selecting any of the items on the list by double-clicking brings up a red crosshatched area in the display, which represents the geographic extents for that data source and type in the assigned Data Depot. Figure 6.48 shows the CADRG/CIB 1:500K TPC data selected from the drop-down menu, and the red crosshatched area in Figure 6.49 represents the area covered by that data type.
Figure 6.48. Drop-down menu of data sources in Extents tab.

Figure 6.49. Red crosshatched area representing extents of selected data.
Note that the words Project, Data, and View appear just below the green area in this display, and the words Project, Data, and View are shown in green, red, and black text, respectively. The green color for the word Project is a reminder that the green-shaded rectangular area above represents the extents of the project. Similarly, the red and black colors for Data and View are reminders that the black rectangle represents the extents of the view or display window, and the red crosshatched area represents the extents of the selected data type and source.

Figure 6.50 shows another example with the view in the main viewing window moved slightly south of where it was in Figure 6.49. Note that the view in the main viewing window (represented by the black rectangle in the View Control window) has been moved to where it is partially outside the extent of the selected data (represented by the red crosshatched area in the View Control window). The main viewing window has a blank screen where there are no available data, and the View Control window shows the black rectangle partially extending beyond the red crosshatched area. The area inside the black rectangle but outside the red crosshatched area corresponds to the blank area of no data in the main viewing window.

Figure 6.50. Example with view extents partially outside of data extents.
There are a couple of important aspects of a Toolkit project for which the Extents tab is a very useful tool. First, the drop-down menu listing the available data types and sources, as shown in Figure 6.48, provides a quick way to determine exactly which data types and sources actually are available for the assigned Data Depot in the project. That drop-down menu lists only the data that are available, and if a particular data type and source is not shown in the list, it does not exist in the assigned Data Depot. Second, if for some reason the view in the main viewing window is blank, the user can go to the Extents tab and quickly determine if the problem might be that the current view in the main viewing window is simply outside the extents of the selected data.

Figure 6.47 showed an example case in which the view in the main viewing window was partially beyond the extents of the selected data; thus, the display in the main viewing window was partially blank. If the view in the main viewing window is entirely beyond the extents of the selected data, the display in the main viewing window would be entirely blank. To easily rectify this problem, the user can click somewhere inside the red crosshatched area in the Extents tab and then click on the Jump button. Clicking in the red crosshatched area will put coordinates in the location window of the Jump Bar where the user can be certain that data exist, and clicking on the Jump button then redraws the map centered at that location and the user is assured that a map will appear in the main viewing window. Note that the Data Type and Source that are selected in the Background tab must be the same as the Data Type and Source selected from the drop-down menu in the Extents tab for this to work. Selecting a particular data type and source from the drop-down menu in the Extents tab does not change the selected Data Type and Source in the Background tab, and thus does not control what map or image is actually being shown in the main viewing window.
7 Project Components

Introduction

The Toolkit Project components may be described as “applications” associated with each project. The project components are shown in the Project tab of the View Control window when a project is open. These components or applications include Documents, Airfields, Annotate, GPS Track, Layers, Overlays, Plot Data, Recon, Route Database, and Shapefiles as shown in Figure 7.1. Each component is designed to store, accept, and/or display data relative to the project as defined by the user. Note that different Toolkit distribution copies may be designed for specific purposes, or a custom installation may have been performed as detailed in Chapter 9, and therefore the project components list may vary.

The following sections describe these project components and provide general instructions on their use.
Documents

The Toolkit Document Manager provides a mechanism for organizing and cataloging documents (or other types of files) by georeferencing them to a point, line, or area. For example, a file of any type (Word®, Excel®, PowerPoint®, WinZip®, text file, graphics file, etc.) can be stored within the Toolkit with a geographic coordinate (or coordinates) for reference. The Toolkit provides icons to indicate geographic locations referenced by one or more files. To access the Document Manager, click on the plus (+) sign to expand the Documents component of the project in the View Control window. This reveals the default folders for documents the Toolkit is set up to manage, and expanding each of those folders reveals a series of more detailed document categories as shown in Figure 7.2.

Creating new documents folders and categories

New or additional folders and/or categories of documents can be added to the default folders and categories. Right-click on Documents and select New as shown in Figure 7.3 to initiate this process. This brings up the New Category window as shown in Figure 7.4.
Figure 7.3. Adding a new document folder and category.

Figure 7.4. New Category window for documents.
A new category of documents can be created in an existing document folder by selecting the name of the existing folder from the drop-down Folders menu, and the new category within that folder is entered as the Name. An entirely new folder can also be created by typing a new folder name in the Folder text box, and the new category is entered as the Name. As an example, a new Folder for Construction Projects with a new category named Road Construction is created as shown in Figure 7.5. After entering this information and clicking OK, the new Folder and Category are added to the Documents list in the View Control window as shown in Figure 7.6.

Figure 7.5. Creating a new documents folder and category.
Figure 7.6. New documents folder and category added.

Adding documents to a project

To add a file to the Document Manager, open a Windows Explorer® window and highlight the desired file as shown in the example in Figure 7.7. With the cursor or mouse pointer on the highlighted file, depress the left mouse button and “drag” the file to the map window in the Toolkit while holding down the left mouse button. Move the cursor to the Toolkit map, and “drop” the file onto the map window by releasing the left mouse button. The Add Document window illustrated in Figure 7.8 will appear.
Figure 7.7. Sample document highlighted.

Figure 7.8. Add Document window.
In the Add Document window, the appropriate category for the document is selected by clicking in the check box by the category name in the Categories area. This window also provides text boxes for general information and a point of contact for the document for future reference.

The location at which the document will be georeferenced can be specified in several ways, all of which are summarized below:

- The coordinate currently displayed is the location where the file was “dropped” onto the map after it was “dragged” from the Windows Explorer window. If that location is acceptable, then no change is required.

- The coordinate can be manually typed into the Location text box in geographic, UTM, or MGRS units.

- The coordinates may be selected graphically with the mouse and pointer using one of the four Location Types listed in the Add Document window. These Location Types are used as follows:

  - From World Map – Select “From World Map” and then select the World Map tab in the Add Document window. On the World Map, click on the country in which the document is to be georeferenced. Hold down the CTRL key on the keyboard to select multiple countries. The document will be georeferenced to the country or countries selected.

  - Point – Select Point, click once on the Location button, and the cursor will become a “crosshair.” Move the cursor to the desired location on the map or image in the main viewing window and click once. The coordinates of that location will appear in the Location text box.

  - Line – Select Line, click once on the Location button, and the cursor will become a crosshair. Move the cursor to the desired location on the map or image in the main viewing window, click to define any number of points along the line, and right-click to define the ending point of the line. The coordinates of the points
along the line will appear in the Location text box, and the document will be georeferenced to that line.

- **Area** – Select Area, click once on the Location button, and the cursor will become a crosshair. Move the cursor to the desired location on the map or image in the main viewing window, click to define any number of points around the perimeter of a polygon area, and right-click to define the ending point and close the area. The coordinates of the points around the perimeter of the area will appear in the Location text box, and the document will be georeferenced to that area.

Figure 7.9 shows the Add Document window completed for the file added in this example. The Location Type is Point, and the document category is Airfields under the Mobility folder. Press “OK” to finalize the input. Double-click the check box by the category for the document in the View Control window, and an icon will appear on the map representing the document as shown in Figure 7.10.
Viewing and managing documents

To view and manage documents that are added to the Document Manager, the category or categories that contain the document(s) of interest must be activated or checked in the View Control window. Note the Documents toolbar that appears along the right side of the interface as referenced in Figure 7.10. The icons on that toolbar are briefly described below.

Document Toolbar

**Symbology**

The Symbology icon is used to open the Category Symbology window as shown in Figure 7.11. This window is used to define the Point, Line, Area, and Country symbology via the buttons along the right side of the window. First, a Category is selected from the list on the left side of the window, and then the symbologies for that category may be edited and defined via the Symbol Editors that come up for each symbology button. When the
symbology for a category has been changed, click Apply for the changes to take effect. Click OK when all desired changes have been applied.

![Category Symbology window](image)

**Figure 7.11. Category Symbology window.**

**Refresh**

Use this icon to refresh or update the display after deleting document icons, if the display does not automatically refresh or redraw.

**Select**

This icon enables the user to select a document icon from the active category. Once selected, the document may be deleted with the Delete icon, and details of the document may be viewed in the Output Control window as shown in Figure 7.12 for the sample document presented here. Recall that clicking the Output Control icon opens the Output Control window at the bottom of the Toolkit interface.
Select Previous

This selects the previous document from the listed documents in the active category.

Select Next

This selects the next document from the listed documents in the active category.

Delete

This deletes the selected document and associated icon. Note that there is no “undo” button and no prompt for the user to confirm the deletion. Once an item is deleted, it cannot be brought back without going back through the steps to add the document to the project.
Document Management in Output Control Window

As shown in Figure 7.12, details associated with a selected document appear in the Output Control window. This includes basic information about the file such as the document name, information that was provided when the document was originally added to the project, the Category to which the document belongs, when the document was last modified, and the contact information that was provided when the document was added to the project.

The Information text box can be edited to change the existing information or add new information. The category for the document can be changed by clicking in the check box by a different category and clicking to uncheck the box for the original category. The document may belong to more than one category by checking the box by multiple categories. The Update Document button must be clicked for any of these changes to take effect.

A document may be viewed by clicking on the View Document button. This brings up the document in a read-only mode with the appropriate application for the document, i.e., Word® for a document, Excel® for a spreadsheet, etc.

To edit a document or file, it must be “checked out” first. This procedure allows only one user at any given time to edit a document. Once it is checked out by one user, others will be able to view the file only in a read-only mode until it has been checked back in. To use this function, click on the Check Out button, and the Check In and Edit Document buttons will then become active and the Checked Out box is checked as shown in Figure 7.13. The document or file will be opened in the associated application. Next, click the Edit Document button and the user may edit the file as needed. When edits are complete, the file should be saved in the application (Windows or Excel, etc.). After saving and exiting the application, click the Check In button and the edited file will be saved in the project. The file is now available to be checked out and edited by another user. Clicking the Undo Check Out button will check the document back in without any edits taking effect or being saved.
Airfields

Airfields is an applet that imports the NGA AAiff airfields database into the Toolkit. To use this feature, insert the NGA AAiff database CD into the computer disk drive, expand Airfields by clicking on the plus (+) sign, and double-click on the smaller Airfields text that appears. This will import the AAiff data for use in the Toolkit.

Annotation

The Annotation project component provides a tool for creating georeferenced annotations such as lines, polygons, text, arrows, and geometric shapes that can be displayed over maps, imagery, or other geospatial data in the main viewing window of the Toolkit. This graphics tool facilitates efficient communication between personnel submitting RFIs, the TEOC, and the subject matter experts by creating a small annotation file that can easily be shared as an e-mail attachment rather than having to transmit large graphic or image files. Once one user has created an annotation file, it can simply be copied into the Annotation folder of another user’s Toolkit project and displayed. Annotations, like
documents, can be stored on a centralized server for multiple users to share, and the following sections provide an overview of creating basic Annotations.

Creating a new annotation

To create a new Annotation, right-click on Annotate in the View Control window and select New as shown in Figure 7.14. This will bring up the New Annotation window shown in Figure 7.15. In this window, enter a name for the annotation and optionally enter the name for the folder to store the annotation file in. If Folder is left blank, the annotation will be saved directly in the Annotate folder. If a folder name is entered, a folder with that name will be created under the Annotate folder and the annotation file will be stored there. In this manner, the user can create whatever folder structure meets the needs of the project. If folders already exist under the Annotate folder, the names of those folders will appear in the Folder drop-down menu and the user can select from there. Multiple annotation folders can be created and multiple annotations can be created within each folder, as needed by the user.

Figure 7.14. Creating a new annotation.
Figure 7.15. New Annotation window.

Figure 7.16 shows an example of a new annotation named Annotation_1 being created in a folder named Folder_1. After clicking OK in the New Annotation window and expanding the Annotate folder in the View Control window, the new folder and annotation can be seen as shown in Figure 7.17. With these initial steps completed and the annotation file created, the user is now ready to populate the annotation with lines, polygons, text, or other graphics as needed.

To add graphics to the annotation, double-click on the name of the annotation or in the small box to the left of the annotation name in the View Control window. This will result in that small box being “checked” which indicates that the annotation is active, and a series of drawing tools will appear in the Annotation toolbar along the right side of the Toolkit interface as shown in Figure 7.18. Depending on the size of the Toolkit interface, the entire Annotation toolbar may not appear along the right side of the screen. If this is the case, simply click on the two small arrows at the bottom of the toolbar as shown in Figure 7.19, and the remainder of the toolbar icons will appear.
Figure 7.16. Sample new annotation and folder.

Figure 7.17. New annotation and folder.
Figure 7.18. New annotation activated and Annotation toolbar displayed.

Figure 7.19. Expanding the Annotation toolbar.
To add graphics to the annotation, first ensure that the annotation has a check mark in the box to the left of the annotation name and that the annotation is selected or highlighted as shown in Figure 7.20. To create a graphic in the main viewing window, click on the desired drawing icon from the Annotation toolbar.

Annotation symbology

Before drawing any annotation, it is good practice to specify the symbology for the annotation. The symbology defines the color, line width, and line pattern for lines and arrows; the font and color for text; and the fill color and/or fill pattern for polygons and other geometric shapes. To define the symbology for any annotation graphic, first select the drawing icon for the desired graphic (line, arrow, polygon, text, or geometric shape) from the Annotation toolbar and then click the Symbology icon at the top of the Annotation toolbar. For example, to define the symbology for a line annotation, select the line drawing icon and then click on the Symbology icon as shown in Figure 7.20. The Symbol Editor window will appear, and the color, pattern, and line width can be defined using the drop-down menus in that window. Figure 7.21 shows the default line symbology, and Figure 7.22 shows the symbology changed to a green dashed line. Once that symbology has been changed, all subsequent lines will be drawn with that symbology until it is changed again.

Symbology for all annotation graphics is defined in the same manner. Simply click on the drawing icon for the desired annotation graphic (line, arrow, text, polygon, geometric shape) and then click on the symbology icon. The symbol editor for that graphic will appear, and the user can define the desired symbology. Symbology for annotations can also be changed or edited after the graphics have been created. Details on this are provided later in this chapter, in the section on Editing Annotations.
Figure 7.20. Setting the annotation symbology.

Figure 7.21. Default line symbology.

Figure 7.22. Changed line symbology.
Line annotation

To draw a line, select the Line Drawing icon on the Annotation toolbar as shown in Figure 7.23. The cursor should turn into a crosshair at this point, indicating that the Toolkit is ready for the line annotation to be drawn. Move the cursor into the main viewing window and click to begin creating points along the desired line as shown in Figure 7.24. Continue to click points along the line with the left mouse button to create the line. A line can also be drawn by holding down the left mouse button and moving the cursor along the desired path of the line to draw a more “freehand” style line. When the line is complete, click on the Done button in the Edit toolbar as shown in Figure 7.24. The completed line will then appear as shown in Figure 7.25.

Figure 7.23. Selecting the Line Drawing icon from the Annotation toolbar.
Figure 7.24. Drawing a line annotation.

Figure 7.25. Completed line.
Polygon annotation

To draw a polygon, select either the Filled Polygon or Polygon Outline drawing icons. Click with the left mouse button in the main viewing window to create points along the perimeter of the polygon as shown in Figure 7.26, or hold down the left mouse and move the cursor “freehand” to draw the polygon. When finished, click the Done button on the Edit toolbar, and the completed polygon will appear as in Figure 7.27.

The Filled Polygon and the Polygon Outline drawing icons are used in the exact same manner as described in the paragraph above. When a polygon is drawn using the Polygon Outline tool, the resultant polygon will only display the polygon outline. However, when a polygon is drawn using the Filled Polygon tool, the resultant polygon can be displayed with or without a fill color or pattern. If it is displayed without a fill color or pattern, then it has the same effect as the Polygon Outline. Thus, the Filled Polygon drawing icon offers greater flexibility. Details on controlling these display options are provided in the Symbology section of this chapter.
Chapter 7  Project Components

Filled circle/radius annotation

A circle with a specified radius can be drawn using the Filled Circle/Radius icon from the Annotation toolbar. First click on the drawing icon and then click in the main viewing window at the location where the center of the circle will be located. In the Input Radius window that appears, enter the desired radius for the circle, select the proper units from the drop-down menu, and click OK as shown in Figure 7.28. Figure 7.29 shows an example of a circle with a 3-kilometer radius drawn in this manner.

Icon annotation

Icon annotations can be drawn by selecting the Icon Annotation tool and clicking in the main viewing window at the desired location for the icon. Figure 7.30 shows the Icon Annotation tool, and Figure 7.31 shows a sample icon in the main viewing window. Note that the default size for the icon may be too large. Selecting the Symbology tool and changing the size prior to clicking on the main viewing window can change this.
Figure 7.28. Filled circle/radius annotation.

Figure 7.29. Sample filled circle with specified radius.
Chapter 7   Project Components

Figure 7.30. Icon Annotation tool.

Figure 7.31. Sample icon annotation.
Text annotation

To create Text annotations, select the Text icon (the capital letter “A”) from the Annotation toolbar. This will bring up the Text annotation window (see Figure 7.32). In this window, type the desired text in the top pane and select the color for the fill, outline, and background of the text box. Check the appropriate boxes if bold or italics are desired, and specify the size, rotation, alignment, and origin for the text. Setting the location at which the text will appear can be done 1) by typing the coordinates in the pane near the bottom of the window just to the right of the LOC (location) button or 2) by clicking once on the LOC button and then clicking once in the main viewing window at the desired location for the text, so that the coordinates of that point appear in the LOC pane. The selected Origin will determine where the Text appears relative to the selected location. Finally, click Apply and the text will appear in the main viewing window. Additional text can be added while the Text window is open by repeating the above steps. When all text has been applied, click OK to close the Text window. Figures 7.33 and 7.34 show an example of the Text window completed and the resultant text in the main viewing window.

Figure 7.32. Text Annotation window.
Click LOC, and then click location on map where to apply text.

Click Apply to add text to display.

Figure 7.33. Text Annotation window completed.

Figure 7.34. Sample text annotation.
Note that the size of the text can be specified as being fixed or scaled with the Size drop-down menu. If fixed is selected, the size of the text on the screen will remain fixed at the specified size, regardless of whether the user zooms in or out. If scaled is selected, the size of the text will change as the map or image in the main viewing window is scaled up or down. The size of the scaled text will be set at a certain size in real-world coordinates. If the user zooms out, the size of the text will appear smaller; if the user zooms in, the size of the text will appear larger.

Arrow annotation

Create Arrow annotations by selecting the Arrow icon as shown in Figure 7.35. The color, size, and arrow point types may be specified with the Symbol Editor as shown in Figure 7.36. Once those options are set, click the points in the main viewing window to define the starting and ending points for the arrow, and click Done as shown in Figures 7.37 and 7.38. The may have two points (start and end) to define a straight-line arrow or multiple points to define an irregularly shaped line with an arrowhead at one or both ends.

Figure 7.35. Arrow Annotation tool.
Figure 7.36. Arrow Annotation Symbol Editor.

Figure 7.37. Drawing an arrow annotation.
Figure 7.38. Completed arrow annotation.

Geometric shape annotations

Annotations using various geometric shapes can be drawn by selecting the desired shape from the Annotation toolbar. Figure 7.39 shows the Square Outline shape being selected. Once the desired shape has been selected, click in the main viewing window and hold down the left mouse button to “drag” the shape to the desired size and orientation. Release the mouse button when the size and orientation are correct. The size, orientation, and location can be altered at this point by clicking on the small points on the perimeter of or in the center of the shape and dragging as needed to resize, rotate, or move the shape. When satisfied with the shape, click the Done button to complete the annotation, as shown in Figures 7.40 and 7.41.
Figure 7.39. Square outline geometric shape.

Figure 7.40. Square annotation in progress.
Editing annotations

Annotations can be edited by first selecting the Question Mark icon near the top of the Annotation toolbar, as shown in Figure 7.42. This then allows the user to select any graphic or text in the active annotation. Click on the desired graphic or text, and that graphic or text will become highlighted once it has been selected. Figure 7.43 shows an example of a line annotation that has been selected in this manner. Once the graphic or text has been selected, click on the Edit icon as shown in Figure 7.43 and the appropriate symbology or text editor for that annotation will appear. Make the desired changes to the color, line pattern, line width, fill pattern, or other symbology and then click the Done button for the changes to take effect. Figures 7.44 and 7.45 show the default symbology and the edited symbology, respectively, for the sample line annotation. Figure 7.46 shows the edited line.

Figure 7.41. Complete square outline annotation.
Chapter 7   Project Components

Figure 7.42. Annotation Selection tool.

Figure 7.43. Annotation selected for editing.
Chapter 7   Project Components

Figure 7.44  Default line symbology.  Figure 7.45  Changed line symbology.

Figure 7.46.  Edited line.

Click Done to complete edits.
Note that not only can the color or appearance of the line be edited, but the shape and location of the line (or other annotation graphic) can also be edited. Once the graphic has been selected and the Edit icon chosen, the line (or other graphic) will appear as shown in Figure 7.47 with points along each segment of the line. These points can be dragged with the left mouse button to reshape the graphic. Figure 7.48 shows one point along the sample line that has been moved in this manner, and clicking the Done button will cause any changes to take effect. The edited line can be seen in Figure 7.49.

Additional points may be added to an annotation by selecting it in the main viewing window, clicking the Edit icon, and then clicking on the Input/Extend icon in the Edit toolbar as indicated in Figure 7.47. Once this has been selected, click in the main viewing window to add new points or extend the line.
Figure 7.48. Point on line relocated.

Figure 7.49. Line edits complete.
Deleting annotations

Any annotation graphic or text can be deleted by selecting or highlighting it using the Question Mark tool and selecting the Delete icon (the red X) on the Annotation toolbar as in Figure 7.50. There is no “undo” button for deletions, nor a prompt to confirm the deletion. Once an annotation has been deleted, it cannot be returned without recreating it entirely.

Measurements with annotations

Basic measurements of length, perimeter, and area can be made with line, polygon, circle, or geometric annotation graphics. To do so, select the line, polygon, circle, or geometric annotation graphic of interest using the Question Mark tool, and then click on the SZ icon from the Annotation toolbar as shown in Figure 7.51. If the selected graphic is a line, then the length of the line will be shown on the screen as in Figure 7.51. If the selected graphic is a polygon, circle, or other geometric shape, the perimeter and enclosed area within the shape will be shown on the screen. Figure 7.52 shows an example of this for a polygon annotation.
Figure 7.51. Size (SZ) icon on Annotation toolbar.

Figure 7.52. Example measurement for polygon annotation graphic.
Elevation profile with line annotations

The elevation profile or topography along a line annotation graphic can be displayed by first selecting the line using the Select tool and then clicking on the Profile tool as shown in Figure 7.53. The elevation profile along the selected line will be displayed in a separate window. An example is shown in Figure 7.54. Note that there must be digital elevation data in the Data Depot that correspond to the location of the selected line in order for this tool to work. In the Elevation Profile window, the Copy button will place a copy of an image showing that window in the Windows “clipboard,” which can then be pasted into another application such as a Word® document or PowerPoint® slide. The Export button will allow the user to save a text file that contains the x, y, z location and elevation coordinates of the points along the selected line. That text file could then be imported into another application, such as Excel®, if desired.
GPS track

GPS track allows the user to connect a global positioning system to a laptop and monitor the current location of the GPS. Normally, a user would collect GPS data through the Recon capability instead of using the GPS track.

To use the GPS track, the GPS should be connected to the Com port on the back of the laptop computer. The GPS interface is then activated by selecting Utilities from the main toolbar and then selecting GPS Control. The GPS Control window as shown in Figure 7.55 will be displayed. Once the Activate button is selected, the GPS readout should be shown in the window. This indicates that the GPS is active. The Options button brings up the GPS Control Options menu as shown in Figure 7.56, and this allows the user to assign different com ports to the GPS and to change the way data are received from the GPS. Once finished, close the GPS Control window by selecting the Close button. The GPS icon should be visible in the main viewing window. To stop the GPS track function, reopen the GPS Control window and select the Deactivate button.
Figure 7.55. GPS Control to activate GPS.

Figure 7.56. GPS Control Options menu.
Layers

Layers is an applet that allows the user to create and assemble graphic and text overlays into layers containing objects. The intent is to provide a tool whereby an overlay can be created to contain objects (graphics or text) that have some commonality. For example, a user may want to display all communications assets, armor assets, or critical infrastructure on an installation using Layers. As described, the graphics, text, and icons representing these items would be overlays and could be logically grouped into several layers. Thus, all communications lines, towers, buildings, cables, etc., could be under a Communications overlay. Likewise, all armor assets could be in another overlay named Armor Assets. Critical infrastructure could be in another overlay. This allows the user to see all items with a type of commonality at the same time in the same layer or in the same overlay. Additionally, if the user wanted to see all the layers or overlays at the same time, opening up all of these would allow for this display.

Do not confuse Annotations with Layers in the Toolkit. Annotations can be thought of as single objects in single layers. Layers can be thought of as multiple objects in one or more layers in one or more overlays.

Layers allow the user to name an overlay and have multiple layers that compose it, and each layer may have multiple objects. For example, a transportation overlay may include layers for highways, secondary roads, and railroads, which may be shown together or separately as needed.

Creating a new layers overlay

In the View Control window, right-click on Layers and then click on New, as shown in Figure 7.57. The New Layers window as shown in Figure 7.58 appears where the name of the layer can be entered, along with the name of a folder to store the layer. Naming a folder is optional and, if folders have been created previously for Layers, those folders will appear in the drop-down menu and can be selected. Once the overlay has been named, clicking OK in the New Layers window completes the new overlay creation.

The overlay can be opened in the View Control window by expanding the Layers folder and double-clicking the box by the name of the overlay as
shown for the example Transportation overlay in Figure 7.59. Note that toolbars appear on the right side of the Toolkit interface and above the main viewing and View Control windows when the overlay is opened. These toolbars are used to create and manage layers and objects in the overlay. As always, it is good practice to save this to the project with Save Project under the File menu to ensure that no work is lost.

Figure 7.57. Creating a new Layers overlay.
Figure 7.58. New Layers window.

Figure 7.59. New overlay opened with toolbars.
Layers toolbars

Several toolbars associated with Layers appear in the Toolkit when an Overlay is opened, as shown in Figure 7.59. The specific location and alignment of the toolbars may vary depending on the size of the Toolkit interface and the specific display settings and may not appear exactly as shown in Figure 7.59. These toolbars and their uses are described below.

Layers Name Toolbar

The Layers Name toolbar is used to manage layers within an Overlay.

NEW Button

When a new Overlay is created, a Layer with the default name Layer 1 appears in the text box in the Layers Name toolbar. A new layer can be created by clicking NEW on this toolbar which brings up the New Layers Layer window as in Figure 7.60. In this example, a layer named Railroads is created in the Transportation overlay. Clicking OK creates the layer that will appear with Layer 1 in the drop-down list for the Layer Name.

Figure 7.60. Naming a new layer.
REN Button

The REN button in this toolbar is used to rename an existing Layer. For example, to rename the default Layer 1, click in the drop-down menu for the Layer name as shown in Figure 7.61 and select Layer 1. This will make Layer 1 the active layer, and the name Layer 1 should then appear in the layer name text box. With this as the active layer, clicking on the REN button will bring up the Rename Layer window as shown in Figure 7.62. This window shows the Current layer name and provides a text box in which the new name can be entered. In this example, Layer 1 will be renamed to Highways. Clicking OK in the Rename Layer window will complete the renaming process, and the new layer name will appear in the layer name text box where Layer 1 previously appeared.

![Figure 7.61. Selecting a layer to be the active layer.](image-url)
The Move button allows the user to move all of the objects in one layer into another layer in the overlay. Clicking this button will bring up the Move Layer window shown in Figure 7.63. The active layer is shown as the source layer, and the drop-down menu allows the user to select any other active layer in the overlay as the Destination layer into which the objects from the Source layer will be moved.

CLR Button

The CLR button will clear all objects from the active layer.

DEL Button

The DEL button will delete the active layer from the Overlay.
Layers Size (SZ) Toolbar

The Layers Size (SZ) toolbar enables the user to create geometric shapes and objects in a layer with predetermined and fixed dimensions. Clicking on this toolbar where the Width/Radius and Height/Depth values are shown, as in Figure 7.64, will bring up the Layers Object Size window. Here, the user can enter the desired Width/Radius and Height/Depth values and units for the object.

The Width/Radius value provides dimensions for the following objects:

- Radius of a circle
- Length of each side of a square
- Width of a rectangle
- Width of an ellipse
- “Radius” for a pentagon, hexagon, or octagon
- Radius of a fan
- Radius of an arc
- Outer radius of a sector
The Height/Depth value will provide dimensions for the following objects:

- Height of a rectangle
- Height of an ellipse
- Inner radius of a sector

After the dimensions have been set in the Layers Object Size window, the user then clicks on the red SZ button and that button should remain depressed or pushed in. Then, when any of the above-noted objects or geometric shapes is created, it will automatically have the exact dimensions that were entered into that window. After an object or geometric shape has been created in this manner, the location and orientation of the object can be edited by moving or rotating it, but the dimensions will remain fixed.

Figure 7.64. Layers Object Size window.

Layers Input Toolbar

The Layers Input toolbar contains icons and tools to define and control the types of objects a user will create in a layer, to manage and query those
objects once they have been created, and to create new legends for layers objects. Each button in this toolbar is presented below, along with a brief description of its use.

*Current Layer* [Image]

When this button is selected, objects on the screen may be selected from the current active layer.

*All Layers* [Image]

When this button is selected, objects on the screen from all layers within the overlay may be selected.

*Move to Top* [Image]

This tool will move the selected object to the top of the active layer such that it will be drawn on the screen on top of any other objects in the layer.

*Move Up* [Image]

This tool moves the selected object up one place among the objects in the active layer.

*Move Down* [Image]

This tool moves the selected object down one place among the objects in the active layer.

*Move to Bottom* [Image]

This tool moves the selected object to the bottom of the objects in the active layer such that it will be drawn first (underneath) any other object.

*Delete* [Image]

This will delete the selected object from the layer. Note that there is no “undo” button, nor is there a prompt for the user to confirm the deletion.
**Edit Legend**

This button will invoke the Layers Legend window where legends for layers objects can be defined and managed. Details on how legends may be created and applied for layers objects are presented in the following section of this chapter, Creating Layers Legends.

**Edit**

The Edit button allows the selected object to be edited.

**Size**

The Size button will return the dimensions of the selected object such as length, perimeter, area, and radius.

**Select Previous**

This tool will automatically select the previous object in the layer.

**Select Next**

This selects the next object in the layer after the one currently selected.

**Select**

This button puts the cursor into “select” mode such that objects can be selected from the appropriate layer(s) in the main viewing window.

**Input Filled Polygon**

This allows the user to create color-filled objects. The color and level of transparency of that color-fill can be adjusted with the symbol editor.

**Input Line**

When this is selected, linear objects can be created and, when any polygon or other geometric shape is created, it will be only an outline of the polygon or shape and will have no color-fill available.
**Input Vector**

This will enable the user to create vectors or arrow objects.

**Input Icon**

This allows the user to create point icon objects.

**Input Text**

This allows the user to add text objects to the layer.

**Input Unit**

This allows the user to create and place standard military unit objects in the layer.

**Layers Mode Toolbar**

The Layers Mode toolbar allows the user to specify exactly what type of linear or geometric object will be created in the layer. The user must first select either the Input Filled Polygon or the Input Line icons from the Layers Input toolbar, and then select the desired object from the Layers Mode toolbar. The characteristics of the object will depend upon which of those icons from the Layers Mode toolbar is selected. That is, the object will be color-filled if Input Filled Polygon is selected and will be a linear outline if Input Line is selected. The types of objects that can be selected from this toolbar are listed below.

- Line
- Polygon
- Circle with specified radius
- Circle
- Square
- Rectangle
- Ellipse
- Pentagon
- Hexagon
Note that if the red SZ button on the Layers Size toolbar is selected or depressed, then the dimensions that are entered into the Layers Size toolbar will dictate the size of any circle, square, rectangle, ellipse, pentagon, hexagon, octagon, fan, arc, or segment that is created. If that red SZ button is not selected or depressed, the user will drag the desired size of the object with the mouse on the screen when creating the object.

Creating layers legends

Prior to creating or adding objects (lines, polygons, text, etc.) to a layer, the user may find it convenient to create a series of legends to represent the objects that will be used to populate the layers. This process essentially involves defining the symbology and providing a description for the various objects that the user wishes to create. Then, when the objects are created, the symbology from those predefined legends can easily be applied or linked to each object to achieve the desired display.

To create a layers legend, click on the Edit Legend icon on the Layers Input toolbar. This will bring up the Layers Legend window as shown in Figure 7.65, which initially contains a single default legend if no previous legends have been created.
The buttons, text boxes, and options in the Layers Legend window are described below.

Add

This button will add a new legend below any existing legend.

Insert

This will insert a new legend above the active legend. Note that clicking within any active text box, drop-down menu, or symbology button will cause a legend to become the active legend.

Move Up

This will move the active legend up one place in the list of legends. Move Up becomes active only when more than one legend exists and when the active legend is not the top legend.
Move Down

This will move the active legend down one place in the list of legends. Move Down becomes active only when more than one legend exists and when the active legend is not the bottom legend.

Delete

This will delete the active legend. Note that there is no “undo” button, nor is there a prompt for the user to confirm the deletion.

Type

The drop-down menu for Type contains three choices. These include Subtitle, Information, and Clause, as shown in Figure 7.66. The Subtitle and Information type legends are used solely for creating subtitles and information lines for the legend display in the View Control window. They are not used to actually create legends or define symbology for objects. The Clause type of legend is used for defining symbology and creating a legend for specific types of objects.

Description

This text box allows the user to enter a brief description of the object for which the legend is being created.

Symbol Type

This drop-down menu becomes active only when Clause is selected as the Type of legend. The Symbol Type menu includes choices for Point, Unit, Text, Vector, Line, and Area, as shown in Figure 7.66. The user simply chooses the appropriate type for the legend that is being created.
Edit Symbology

The Edit Symbology button is the rectangular area with the red circle, as shown in Figure 7.66. Clicking this brings up the appropriate Symbol Editor for the selected Symbol Type. Each Symbol Type has a unique editor to specify the characteristics and symbology, such as point size and color, line color, line pattern and width, unit details, text color and font, vector color and size, and area outline with fill colors and patterns.

As an example, legends for two Clause types of objects are created along with examples of Information and Subtitle types. An Information type legend is created by clicking on the Edit Legend icon and selecting Information as the Type in the Layers Legend window. In the Description text box, Surface Roads will be entered as shown in Figure 7.67.

Next, a Subtitle type is created by clicking Add in the Layers Legend window. This adds a new legend below the Information Legend just created. For this new legend, Subtitle is selected as the type and Highways is entered as the Description. The result of this is shown in Figure 7.68.
Figure 7.67. Creating an Information legend type.

Figure 7.68. Adding a Subtitle legend type.
Next, a Clause type legend for Two-Lane Highway is created below the Information legend by clicking on the Add button, selecting Clause as the Type from the drop-down menu, and entering Two-Lane Highway as the Description. Note that the Symbol Type menu will then become active, and Line is chosen as the Symbol Type as shown in Figure 7.69. The Edit Symbology button also changes to reflect the line Symbol Type, and clicking the Edit Symbology button will bring up the Symbol Editor for lines, as shown in Figure 7.70. Using the drop-down menus in this window, the line color, pattern, and width can be defined, which in this example is a wide blue dashed line. Figure 7.71 shows the resultant legend after clicking OK in the Symbol Editor.

Finally, a Clause type legend for Four-Lane Highway is created above the Two-Lane Highway legend by clicking on Insert with the Two-Lane Highway legend being the active legend as indicated in Figure 7.72. The Four-Lane Highway symbology is defined as described above but with a solid yellow line. Click OK in the Layers Legend window when all legends have been created. Click on the Legend tab of the View Control window to view the legend as created (in this example, Figure 7.73).
Figure 7.69. Adding a Clause legend.

Figure 7.70. Line Symbol Editor.
Figure 7.71. Line legend added.

Figure 7.72. Line legend inserted.
Creating objects in layers

Objects such as lines, polygons, geometric shapes arrows, or text are created and added to layers in much the same manner as these items are created for Annotations. Before attempting to create an object in Layers, the Output Control window in the Toolkit interface should be opened by clicking on the Output Control icon on the main toolbar, as shown in Figure 7.74. Next, ensure that the Layer in which the object is to be created is the active or selected Layer. This is indicated by the layer name in the text box above the View Control window and in the Layer name in the Output Control window, as also shown in Figure 7.74. Drop-down menus are located in both places to select the active layer, and using either drop-down menu will change the active layer.
The type of object to be created is selected from the Layers Input Mode toolbar. The symbology is specified by clicking on the Edit Symbology button in the Output Control window and selecting the desired options in the Symbol Editor window. A Name, Description, and Information for the object can be added in the text boxes provided. Finally, the object is created in the main viewing window by moving the cursor onto the map or image and clicking with the left mouse button to create the object and clicking the Done button on the Edit toolbar to complete the object. An example showing the creation of a Line object in the Highways Layer of the Transportation Overlay is shown in Figures 7.75 and 7.76. Note that the symbology for this sample line has been changed for ease of visibility on the map, and a name and description have been added in the appropriate text boxes.
Figure 7.75. Line object being created.

Figure 7.76. Line object completed.
Viewing object name using Map Tip

The name of an object can be viewed by simply moving the cursor over the object using the Toolkit Map Tip feature. To do this, select the question mark (Select) icon from the Layers Input toolbar. Then, move the cursor over any object in the active layer, and the name of that object will appear in a Map Tip as shown in Figure 7.77. This will function only if a name has been provided for the object in the Name text box in the Output Control window. If the object has no name, no Map Tip will appear.

Linking legends with object symbology

Another option for defining symbology for an object is to “link” the symbology from an existing legend to the new object. To accomplish this, open the Legends tab in the View Control window to reveal the existing legends and simply “drag and drop” the desired legend from the View Control window onto the Edit Symbology button for the new object. The symbology for that new object will automatically be updated to adopt the new symbology from the Legend. This is demonstrated in Figures 7.78 and 7.79.
Figure 7.78. Drag and drop legend symbology to new Layers object.

Figure 7.79. Legend symbology linked with new object.
Exporting and importing shapefiles from layers

Objects in an Overlay can be exported from the Toolkit to create a Shapefile, and Shapefiles can be imported into the Toolkit to create new objects in an Overlay. To access these options, right-click on the Overlay name in the View Control window and a list of options will appear, as shown in Figure 7.80. Select either Export Shapefile or Import Shapefile.

Exporting Shapefiles

When exporting a Shapefile, the user is prompted for the folder into which the Shapefile(s) will be exported and saved. One or more Shapefiles may be created during this process, depending upon what types of objects exist in the Overlay. Separate Shapefiles will be created for point objects, line objects, and polygon objects. For example, if the Overlay contains some line objects and some polygon objects, then two Shapefiles will be created in the specified folder. One Shapefile will contain the lines, and the other will contain the polygons. Exported Shapefiles will automatically adopt the name of the Toolkit Overlay from which the objects are exported, with the word POINTS, LINES, or POLYGONS appended to the file name, depending upon what type of objects are in the file. So, if polygon objects are exported from an Overlay named Transportation, the resultant Shapefile would be named similarly (“Transportation_POLYGONS.shp”).

Importing Shapefiles

To import a Shapefile into a Toolkit Overlay, the user is prompted for the name of the Shapefile to be imported. Once the name of the Shapefile is entered, the user is stepped through a series of windows and is prompted to provide information regarding the geographic projection of the data in the Shapefile, to select from the data fields in the Shapefile to provide a name and description for the resultant objects, and to define the symbology for the objects. Clicking Finish in the last of these windows completes the import process, and a new Layer in the Overlay is then created that contains the objects from the Shapefile. The name of the Layer will be the same as the name of the Shapefile.
Importing annotations into layers

Annotations created in the Toolkit can be imported into Layers. To do so, right-click on the name of the Overlay in the View Control window and select Import Annotation. The Select Annotation File window shown in Figure 7.81 will appear. By default, this window will open into the Annotate folder in the current project, and this folder will contain any Annotation files that exist in the project. The Annotation files have a file extension of “.ano,” and Annotation files from other projects can be selected by navigating to those files. After selecting the desired Annotation file, click Open and a new Layer containing the objects from the Annotation will be created in the current Overlay. The symbology that was defined when the Annotation was first created will automatically be adopted for the objects in this new Layer. The name of the new Layer will be the same as the name of the Annotation file.
Exporting and importing C2PC MGC files from layers

C2PC is a command and control mapping and geographic information systems (GIS) software that uses MGC files for map overlays. Objects in a Toolkit Overlay can be exported from the Toolkit and saved in the MGC file format for use with C2PC, and MGC files can be imported into the Toolkit to create objects in an Overlay. To export or import C2PC MGC files from Layers, right-click on the name of the Overlay in the View Control window and select either Export C2PC MGC or Import C2PC MGC from the list, as shown in Figure 7.80.

Exporting C2PC MGC Files

When Export C2PC MGC is selected after right-clicking the name of the Overlay, the user is prompted for the folder where the MGC file(s) are to be saved. After selecting the folder and clicking OK, a separate MGC file is saved into that folder for each Layer in the Overlay. The name of each MGC file will contain both the name of the Overlay and the name of the Layer from within the Overlay that contained the objects used to create the MGC file. An MGC file created from the Railroads Layer of the
Transportation Overlay would be named “Transportation – Railroads.mgc.”

Importing C2PC MGC Files

When Import C2PC MGC is selected after right-clicking on the name of the Overlay, a file browser appears and the user is prompted to select the name of the desired MGC file. After selecting the appropriate file and clicking Open on the file browser, the MGC file is imported to create a new Layer in the Overlay. The new Layer will be given the same name as the file name for the MGC file that was imported. The MGC file will contain symbology information for the objects, and that symbology will be retained by the objects in the Toolkit after the file is imported.

Overlays

The Overlays component provides access to the terrain data overlays supported by the Toolkit. To view these terrain overlays, expand the Overlays component in the View Control window by clicking on the plus sign by Overlays, and then click on the plus sign adjacent to any data folder listed under Overlays. For example, Figure 7.82 shows the Overlay folder expanded and the subsequent Interim Terrain Data folder also expanded. Note that the specific datasets that are available will vary depending on what data exist in the assigned Data Depot.

Note that user-specified overlays can be created in the Toolkit. Please refer to Chapter 10 of this document for details on that capability.
Viewing overlay data features

To view a specific overlay, double-click on any data feature listed so that there is a check mark in the box by the name of the data feature, and the data available will appear in the main viewing window. Figure 7.83 shows the resultant display for ITD Vegetation features in the Interim Terrain Data overlay. Multiple overlays can be viewed simultaneously by simply double-clicking on the desired overlay names. If no data features appear in the main viewing window, there simply may not be coverage for that specific feature in the geographic area corresponding to the area in the main viewing window. This can be confirmed using the Extents tab in the View Control window as described in Chapter 6.
Figure 7.83. ITD vegetation data displayed.

Viewing overlay legends

The features in each overlay will be represented by various colored polygons, lines, or icons, depending on what the features represent. In the example shown above in Figure 7.83, colored polygons represent different types of vegetation. To view the legend for these features, select the Legend tab in the View Control window, as shown in Figure 7.84 for this example Vegetation overlay.
Querying OVERLAY FEATURES

Individual features in an overlay can also be queried to obtain additional detail. To do so, the overlay must be displayed as indicated by a check mark in the box by the overlay name, and the overlay must be selected or highlighted as the active overlay. Click on the name of the overlay to highlight it and make it active. Figure 7.85 shows the ITD Vegetation overlay selected. When this occurs, a query (question mark) icon appears in the upper right area of the Toolkit interface, as indicated in Figure 7.85. To query any overlay feature, click the query icon and click in the main viewing window over the feature of interest. The results of the query will appear in the Output Control window with whatever information exists in the database for that feature, as shown in Figure 7.86. Additional features can be queried by clicking other features on the map, or by clicking the Forward or Back buttons in the Output Control window. If more than one overlay is displayed, only the features in the active or highlighted feature can be queried. To query features in another overlay, click on the name of that overlay so that it becomes the active overlay; then, query the features in that overlay as described above.
Figure 7.85. Overlay highlighted and Query icon displayed.

Figure 7.86. Overlay feature query results.
Using the Stacker

The Toolkit Stacker is used to arrange the plotting order of data overlays or to control the plotting of one or more overlay features. To access the Stacker, select the Stacker tab in the View Control window where the individual features in the overlay are listed, as in Figure 7.87. Individual features in the Stacker are drawn in the Toolkit display in reverse order, i.e., the item at the bottom of the list is drawn first and the item at the top of the list is drawn last. Thus, if there is overlap between two or more data features, the one that is highest on the list in the Stacker appears on top of the others in the main viewing window. Those lower on the list may be partially or entirely hidden beneath the higher listed items in the display. The order in which the items are listed and displayed is changed by dragging items up or down the list with the mouse. Display of individual items can be turned off by clicking the box by the feature name to remove the check mark, and clicking the redraw button or icon to redraw the screen. Items are toggled back on for display by clicking again in the box so that the check mark returns and then redrawing the screen.

Figure 7.87. Stacker.
Plot data

This feature enables the user to import an Access® database file or an Excel® spreadsheet with a series of coordinates into a TETK project and to plot icons at the location of each set of coordinates contained in that database or spreadsheet file.

Figure 7.88 shows an example of the contents of a simple spreadsheet file that contains three columns of data: Location, Coordinates, and Priority.

<table>
<thead>
<tr>
<th>Location</th>
<th>Coordinates</th>
<th>Priority</th>
</tr>
</thead>
<tbody>
<tr>
<td>Landmark #1</td>
<td>38 S M B 21731 77843</td>
<td>2</td>
</tr>
<tr>
<td>Landmark #2</td>
<td>38 S M B 36344 74971</td>
<td>3</td>
</tr>
<tr>
<td>Landmark #3</td>
<td>38 S M B 28463 68779</td>
<td>1</td>
</tr>
</tbody>
</table>

Figure 7.88. Sample information for Plot Data feature.

To import these points into the TETK project using Plot Data, the user right-clicks on Plot Data and selects New in the View Control window, as indicated in Figure 7.89. The Plot Data Properties window shown in Figure 7.90 will appear. The user then provides a name and browses for the spreadsheet or database file to be imported by selecting the browser button to the right of the Data Source Field. After the appropriate data file is selected, the Plot Data Properties window will appear, as in Figure 7.91. If there are multiple worksheets in the spreadsheet, the appropriate worksheet may be selected from the drop-down list under Table or Query. Locations for the points in the data file may be provided in longitude and latitude, or in UTM or MGRS coordinates. If the coordinates are longitude and latitude, the longitude value must be in one field and the latitude in another field in the data file. That is, the longitude and latitude may not be combined as a single string in one data field. The user must select the appropriate fields for the longitude and latitude from the drop-down lists under Coordinate Fields, as shown in Figure 7.91. If the coordinates are provided as UTM or MGRS values, the coordinates for each point should be a single string in one field of the data file. In this case, the user selects Coordinate String Field under Coordinate Field(s) and selects the appropriate field containing the coordinates from the drop-down list, as shown in Figure 7.92. The completed Plot Data Properties window is shown in Figure 7.93. After selecting OK, the user may display the points by expanding Plot Data in the View Control window and double-clicking in the box by the name of the new object, as shown in Figure 7.94.
Chapter 7  Project Components

Figure 7.89. Creating a new Plot Data feature.

Figure 7.90. Plot Data Properties window.
IF coordinates are longitude and latitude, select appropriate fields from data file.

IF coordinates are MGRS or UTM, select appropriate field from data file.

Figure 7.91. Selecting fields for longitude and latitude.

Figure 7.92. Selecting field for coordinate string.
Figure 7.93. Plot Data Properties window completed.

Expand Plot Data folder and double-click in the box to display plotted points.

Figure 7.94. Data points plotted.
Information for each plotted point may be queried by selecting the question mark icon in the upper-right area of the interface and selecting the point of interest in the main display window. The results will appear in the Output Control window, so this window must be open, as shown in Figure 7.95.

![Select ? icon, then select point in main display window to query](image)

**Figure 7.95.** Query results for Plot Data.

Symbology for the plotted points may be changed by opening the Symbol Editor from the toolbar on the right side of the interface, as shown in Figure 7.96, and general information about the plotted data can be obtained by selecting the Information (i) icon, as shown in Figure 7.97.
Figure 7.96. Symbol Editor for Plot Data.

Figure 7.97. Plot Data information.
Recon

Details on using the Recon project function are provided in Chapter 8 of this document.

Route Database

Details on using the Route Database project function are provided in Chapter 8 of this document.

Shapefiles

Introduction

A Shapefile is a specific dataset format that is commonly used in GIS and geospatial analysis applications to store geometry and attribute information for spatial features. Point, line, and area (polygon) spatial features can all be supported in the Shapefile dataset format, and the attributes for the features represented in a Shapefile are contained in a dBASE® format file. A Shapefile typically consists of three files: the main file, an index file, and a dBASE® file or table. The main file is a direct-access, variable-record-length file in which each record describes a shape (point, line, polygon) with a list of its vertices. Each record in the index file contains the offset of the corresponding main file record from the beginning of the main file. The dBASE® table contains feature attributes with one record per feature.

File names for a Shapefile adhere to a certain naming convention. The main file, index file, and dBASE® file all have the same prefix. The suffix for the main file is .shp, the suffix for the index file is .shx, and the suffix for the dBASE® file is .dbf. For example, a Shapefile named “points” would consist of the following three files:

<table>
<thead>
<tr>
<th>File</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main file:</td>
<td>points.shp</td>
</tr>
<tr>
<td>Index file:</td>
<td>points.shx</td>
</tr>
<tr>
<td>dBASE table:</td>
<td>points.dbf</td>
</tr>
</tbody>
</table>
Shapefiles are created or obtained in a number of ways. They may be created using common GIS software, or they may have been created by others and be available for use in a project from some such source.

Importing a shapefile

To import and display a Shapefile, select the Project tab in the View Control, right-click on Shapefile, and select New as shown in Figure 7.98. The New Shapefile window appears, as shown in Figure 7.99. To select the Shapefile to import, click to the right of the Select Shapefile area as indicated in Figure 7.99, to open the Select Shapefile browser. Navigate to the directory where the Shapefile is stored, select the Shapefile, and click on Open in the Select Shapefile file browser. Figure 7.100 shows a Shapefile named “points.shp” being imported.
Figure 7.99. Opening the New Shapefile window.

Figure 7.100. Browsing with the Select Shapefile window.
After Open is selected in the Select Shapefile window, the New Shapefile window appears as in Figure 7.101. The path to the selected Shapefile is shown under Select Shapefile and, by default, the prefix of the selected Shapefile is adopted as the Overlay Name. The Overlay Name may be changed by typing a new name in the Overlay Name area.

Two other options may be chosen before moving to the next step. A subfolder may be created under the Shapefiles folder in the project by typing an Overlay Folder name in the designated location. If this is done, a folder with that specific name is created, and the new overlay will be stored in that folder. If Overlay Folder is left blank, the new overlay is created directly in the Shapefiles folder. The other option is to have the original set of Shapefile files (*.shp, *.shx, *.dbf) copied into the project folder by checking the box labeled Copy Shapefile to Project. If this option is not chosen, the overlay is created as specified, but the actual Shapefiles will continue to reside only in their original location.

To illustrate these options, Figure 7.101 shows the default overlay name “points” retained from the “points.shp” Shapefile, a new Overlay Folder named project1 is being created, and Copy Shapefile to Project box is checked so the Shapefiles will be copied in the project folder.
Figure 7.101. File path, overlay name and overlay folder for selected shapefile.

Clicking Next brings up the window shown in Figure 7.102, where the Projection and Datum for the Shapefile are defined. The Projection may be either geographic (latitude and longitude) or Universal Transverse Mercator, and several choices are available for the Datum. The user selects the appropriate choices for data from the drop-down menus for Projection and Datum. Figure 7.102 shows that the Shapefile in this example is in the Geographic projection with the WGS84 datum.
From this step forward, there are differences in creating a new overlay depending on whether it is being created with a point Shapefile, a line Shapefile, or a polygon Shapefile. The Toolkit software automatically recognizes what type of file is being imported, and examples of each of these three (point, line, polygon) are presented in the following sections.

Point shapefiles

When importing a point Shapefile, several options are available that affect the way in which objects in the Shapefile are displayed and managed. Among these options are that the points may be displayed as icons or as text, the icons or text may be scaled by size according to the values in a field chosen from the dBASE® file, and filtering tools allow the user to display (or not display) certain points in the file based on user-defined criteria. These basic options are discussed and illustrated in the examples below.

Displaying Point Shapefiles with All Objects the Same

Figure 7.103 shows the continuation of the Shapefile import from Figure 7.102. Here, the user selects whether the data in the Shapefile are
drawn with all objects the same, with simple ranges based on data values in one of the attribute fields of the Shapefile, or with more advanced options that will be detailed later in this section. The points in the Shapefile may also be drawn using Icons or using Text. In Figure 7.103, the options to draw all of the objects the same and to draw them using icons have been chosen.

After clicking Next, the window in Figure 7.104 appears, allowing the user to define how the points or icons will be displayed. The Shapefile in this example has three fields of data or attributes in the dBASE® file for each point: ID, DEPTH, and DIAMETER. The check boxes and drop-down menus under Text are used to define what text associated with these attributes will appear, if any. If the boxes are left unchecked as in Figure 7.104, no text will appear, just icons. An example of displaying text is presented later in this section.
Symbology used to display the points in the Shapefile is defined via the Symbol Editor, which is accessed by clicking the Symbology button in the New Shapefile window, as in Figure 7.105. The color, size, and display units for icons are defined from the Symbol Editor, and custom editing tools to create icons are available by clicking the Edit button. The size of the symbols is with units of either Screen Mills or World Meters. For Screen Mills, the size of the icons will remain constant at the specified size on the screen as the map or background is zoomed in or out. For World Meters, the size of the icons on the screen is scaled up or down as the user zooms in or out in the main viewing window. Note that if Screen Mills is chosen as the Unit with which to scale the icons, a value of 5 or 6 is a good starting value. The default value of 20 may result in icons that are much too large to be useful. If World Meters is selected, ensure that a large enough value is chosen to make the icons visible.
After defining the symbology, clicking OK on the Symbol Editor, and clicking Next in the New Shapefile window, the window shown in Figure 7.106 appears. In displaying the Shapefile objects, the user may choose to display attributes from the dBASE® fields associated with the Shapefile as the cursor is moved over each object on the screen. This is accomplished by selecting the desired dBASE® field(s) from drop-down menus for the Tip and Description. When the cursor is moved over an object, the Tip will appear in a bubble on the screen, and the Description will appear in the Status Bar at the bottom of the Toolkit interface. Up to three dBASE fields can be specified for the Description. In Figure 7.106, the example Shapefile has attribute fields named ID, DEPTH, and DIAMETER. The ID has been chosen as the Tip, and ID, DEPTH, and DIAMETER have been chosen as the Description using the drop-down menus in each area. Once the Map Tip and Description have been defined, clicking the Finish button completes the process of importing the Shapefile and creating the new overlay.
To display the Shapefile, expand the Shapefiles folder in the View Control window and any Folder below Shapefiles by clicking on the plus (+) signs next to the folder names. In this example, a new folder named project1 was created under Shapefiles, so both the Shapefiles and project1 folders are expanded by clicking on the plus (+) signs by the folder names. The name of the new overlay appears with an empty check box. Double-click in that box to view the display of the new overlay, and the main viewing window will be automatically redrawn with the points in the overlay displayed over the background map or image. In Figure 7.107, this is shown for the points overlay that was created in the project1 overlay folder under Shapefiles (displayed as five red dots). Figure 7.108 shows the Tip and Description for one object as the cursor is moved over it.

If the geographic area currently in the main viewing window does not coincide with the geographic location of the points in the Shapefile that was used to create the overlay, the points will not appear on the screen. The user must pan or jump the main viewing to the geographic location of the points or zoom out until the points are visible. The map display will not automatically locate the display map to the location of the data points in the overlay.
Figure 7.107. Turning on display of shapefile overlays.

Figure 7.108. Map Tip and description.
For the Shapefile used in this example, the point with ID 1 has a DEPTH value of 125 and a DIAMETER value of 12. So, when ID, DEPTH, and DIAMETER (values of 1, 125, and 12, respectively) are displayed as the Description, the numbers run together and appear as “112512,” as shown in Figure 7.108. To make this clearer, the display can be customized by defining spaces and/or delimiters between the numbers. This could be accomplished during the initial creation of the overlay by entering information into the three blank areas under Description (Figure 7.106). Once the overlay has been created, this can also be accomplished in the Shapefile Legend Editor, which is accessed by clicking as indicated in Figure 7.108. Before opening this editor, ensure that the overlay to be edited is selected or highlighted by clicking once on the name of the overlay in the View Control window. Then, open the Shapefile Legend Editor. This editor allows the user to define, or redefine, all aspects of the overlay display. Figure 7.109 shows the Shapefile Legend Editor. Note, in the Map Tip area under Description, that some additional characters and information have been entered under ID, DEPTH, and DIAMETER. Figure 7.110 shows the resultant display of the description in the lower left portion of the window after these changes have been made.

Attributes for points may be displayed as text on the screen adjacent to the points. In the Text area of the Shapefile Legend Editor in Figure 7.109, several of the boxes are checked. The user can check a specific box or boxes to define where to display text relative to the points. Text may be displayed in the center, above (top), right, below (bottom), and/or left of the points, and drop-down menus are used to select which attribute (DEPTH, ID, or DIAMETER in this example) will appear in each location. The appearance of the text is defined in the Text Color area. Choose the desired color(s) for the fill, outline, and background of the text, and check the box(es) by Fill, Outline, and/or Background. Checking only Fill produces solid-colored text, clicking Outline adds an outline to the text if a color different from the fill color is chosen, and checking Background produces a rectangular background behind the text. If the background and fill color are the same, a solid rectangular area will appear, as the text is not distinguishable from the background area. If none of the Text Color boxes are checked, no text will appear, even if the boxes above in the Text area are checked. In Figure 7.109, DIAMETER is selected to display to the right of each point, ID below each point, and DEPTH to the left of each point; the resultant display is shown in Figure 7.110.
Chapter 7  Project Components

Figure 7.109. Shapefile Legend Editor.

Figure 7.110. Revised descriptions and text display.
Displaying Point Shapefiles using Simple Ranges

To display points in a Shapefile using ranges of values from the dBASE® attributes, select Simple Ranges in the New Shapefile window during the import process, as shown in Figure 7.111. With this option, the color or appearance of each point differs depending on its attribute value. Clicking Next brings up the window in Figure 7.112, which has an area labeled Column with a drop-down menu that contains the names of each attribute field associated with the points in the Shapefile. In this example, those fields are ID, DEPTH, and DIAMETER; in Figure 7.112, DEPTH has been chosen. In the lower portion of the window, details of the DEPTH data values for all points in the Shapefile are shown in the Column Information area. For the points in this example Shapefile, the minimum DEPTH value is 125, the maximum DEPTH value is 200, and unique values include 125, 150, 175, and 200.

Figure 7.111. Using simple ranges to draw shapefile.
Chapter 7   Project Components

Figure 7.112. Column information.

Click Next for the window in Figure 7.113, which indicates a Number of Ranges for the values in the selected column and a selection of colors to be associated with the points in each range. The number of ranges, Start Color, and End Color may be changed. If the Unique Values box shown in Figure 7.112 is checked, each point with a unique value for the selected attribute (DEPTH in this example) is assigned a unique color as opposed to a series of ranges with the points having DEPTH values within each range being grouped together. For this example, the Unique Values box is unchecked such that a series of Simple Ranges is used.

Click Next to bring up the window in Figure 7.114, where icon symbology and text display are defined. In this example, DEPTH is selected to be displayed at the top of each point. Also note that the color of the points cannot be changed from this menu. The colors of the points are based on the colors associated with the ranges as shown in Figure 7.113.

Clicking Next will bring up the Map Tip and Description window, and clicking Finish completes the overlay creation. Figure 7.115 shows the overlay displayed based on the options selected in Figures 7.111–7.114.
Chapter 7  Project Components

Figure 7.113. Number of ranges and range display colors.

Figure 7.114. Symbology and text display options.
Displaying Point Shapefiles using Advanced Display Options

The third option for displaying point Shapefiles is the Advanced method. Selecting this option during the import process directly brings up the full Shapefile Legend Editor, which allows a variety of display options to be set. After a Shapefile has been imported, this same Shapefile Legend Editor can be accessed as was illustrated in Figure 7.108, but this option allows the user to take advantage of the options offered in this editor during the import process.

To illustrate this, Figure 7.116 shows the Advanced method selected to draw the Shapefile using icons. Clicking Next in the window shown in Figure 7.116 brings up the Shapefile Legend Editor shown in Figure 7.117. From within this Shapefile Legend Editor, the user can include a description of the overlay, set the Tip and Description information, define the Symbology for the points, and define what text will appear adjacent to the points, if any. Display of the points in the example Shapefile based on the options selected in Figure 7.117 is shown in Figure 7.118. Note the use of a 45-degree azimuth to display text adjacent to each point.
Figure 7.116. Selecting the advanced method to draw shapefile.

Figure 7.117. Shapefile Legend Editor.
Adding or Inserting Additional Views or Clauses into Overlay

Additional views or display options (referred to hereafter as a “clause”) of the same Shapefile can be added or inserted through the Shapefile Legend Editor. To do this, first select the overlay to be edited by clicking once on the name of the overlay in the View Control window and then click on the Edit button (indicated in Figure 7.118) to open the Shapefile Legend Editor. In the Shapefile Legend Editor, as shown in Figure 7.119, click on either Add or Insert. Add will add the new clause at the bottom of any others that already exist for this overlay, and Insert will insert the new clause above the active clause. Clicking in any text box or drop-down menu of a particular clause will activate that clause. Clicking on Add or Insert brings up the Shapefiles Add/Insert Clause window, as shown in Figure 7.120.
Figure 7.119. Add or insert new clause for overlay via Shapefile Legend Editor.

Figure 7.120. Shapefiles Add/Insert Clause menu.
In the Shapefiles Add/Insert Clause window, the user chooses whether to display all of the points in the same way or to use the data values in a specific column of attribute data to control the point display by clicking either the All or Column option. If All is chosen, the only other decision is whether to display the points as icons or as text by clicking either Icon or Text in the Draw As area. If Column is chosen, the drop-down menu to the right becomes active and contains each of the fields from the dBASE file for the Shapefile (ID, DEPTH and DIAMETER, in this example). When a column is chosen from that drop-down menu, a summary of the data in the column appears in the Column Information area. In the example in Figure 7.120, the DIAMETER column is chosen, and the Column Information shows that the data are integers, the minimum value is 12, the maximum value is 24, and the unique values are 12, 15, 18, and 24.

The other option in this window is the Unique option. If the box by Unique is checked, the user can choose one or more unique values from the data in the selected column, and only the points with those unique values are displayed. If Unique is not checked, the user will be able to define a range of values, and only the points included in the specified range are displayed. Here, an example where Unique is chosen will be presented, followed by an example where Unique is not chosen.

Clicking OK in the window shown in Figure 7.120 will add this new Clause to the Shapefile Legend Editor along with any existing clauses. The new Clause essentially appears as another Shapefile legend in the same Shapefile Legend Editor window. Figure 7.121 shows the new clause below the original clause. Note that only the bottom portion of the original clause appears because of the size of the figure. Scrolling up or expanding the size of that window in the Toolkit software would reveal the entire clause. A description of the new clause provided under Description and the same display options (for Map Tip, Description, Symbology, and Text as have been previously discussed) are available and can be defined for the display of points in this clause.
The unique data values that are to be displayed must be selected by clicking on the desired value. Multiple values are selected by holding down the Control key on the keyboard and clicking each of the desired values. A series of values can be selected by holding down the Shift key on the keyboard and clicking on the first and last values in the desired series.

An example is shown in Figure 7.122 where the unique values of 12 and 18 are selected. Only those points with DIAMETER of 12 or 18 are displayed, and points with any other DIAMETER values will not appear. If the NOT box is checked, then the opposite is true (points with 12 and 18 values are NOT displayed, while 15 and 24 are be displayed). The display resulting from the addition of this new clause is shown in Figure 7.123. Note the points are colored green and the text values for DIAMETER are displayed below each point. These reflect the options chosen in Figure 7.122.

In Figure 7.123, the points as specified in this new clause (green) appear on top of the previous display (blue). If more than one clause exists for an overlay, the display for a clause lower on the list will be drawn on top of any clauses above it. Clauses may be reordered using the Move Up and Move Down buttons in the Shapefile Legend Editor.
Figure 7.122. Unique values selected for shapefile display.

Figure 7.123. Display of points2 overlay with two clauses.
To display points without the Unique option, the Unique box is left unchecked in the Shapefiles Add/Insert Clause window, as shown in Figure 7.124, where the Column option is selected with DEPTH as the data field. The box next to Unique is not checked. The Column Information area shows a summary of the DEPTH data values for the points in this Shapefile. Clicking OK adds this clause to the overlay, as shown in Figure 7.125.

In this example, a range of values is defined for the data in the selected column rather than selecting one or more unique values. The range is defined in the lower left portion of the window by the numbers in the areas adjacent to the >= and < signs. By default, the minimum and maximum data values appear, but these values can be edited. In Figure 7.125 the upper end of the range is changed to 180, and the result is that only points with DEPTH values greater than or equal to 125 and less than 180 will be displayed. Points with DEPTH values outside of that range will not be displayed. This can be reversed by checking the NOT box, i.e., only points with values that fall outside of the specified range will be displayed.

The display based on the options shown in Figure 7.125 is shown in Figure 7.126 where the displays for all three of the example clauses are visible. The first clause has blue points with yellow ID numbers (note that the azimuth has been changed back to 0 degrees where it was previously 45 degrees), the second has green points with unique DIAMETER values of 12 or 18 displayed and green text for the DIAMETER values below each point, and the third clause has red points with DEPTH values greater than or equal to 125 and less than 180 and white text for the DEPTH values to the left of each point. The point with ID value of 3 has a DEPTH of 200, which falls outside the defined range, and thus a red point is not displayed at that location.
Figure 7.124. Adding a new clause with column option but not unique.

Figure 7.125. New clause with range of depth values defined.
Displaying point shapefiles using text

Point Shapefiles may be displayed using text instead of icons to represent the data points. For this option, select Text for the Draw As option and choose to draw All Objects the Same as shown in Figure 7.127. Click Next to bring up the window in Figure 7.128. Next, select which column of data to use for the text. Whichever column is selected, the text or value associated with each point in that column will be displayed rather than a point icon. In Figure 7.128, the ID column is selected. Tools are provided to control the size of the text, the origin of the text with respect to the point location, and alignment of the text. To control the color and size of the text, use the Symbol Editor by clicking on the large area where the word Text appears, as shown in Figure 7.128. Figure 7.129 shows the options chosen for this example with the text fill color red and no outline or background. The resultant display is shown in Figure 7.120 with the ID number for each point displayed at the point locations on the map.

Simple Ranges may also be used with Text as was previously outlined for use with Icons, but the Advanced option will simply invoke the Shapefile Legend Editor, which does not provide tools to display the points using Text and the result will be objects displayed as points.
Figure 7.127. Draw as Text for new shapefile.

Figure 7.128. Choosing the column and text positioning and size.
Figure 7.129. Symbol Editor for text display.

Figure 7.130. Text displayed with ID numbers for points.
Line shapefiles

Importing line Shapefiles starts with the same steps as point Shapefiles, i.e., right-click on Shapefiles and left-click on New in the View Control window. Browse to the desired Shapefile and Open the file in the Select Shapefile window (see Figures 7.98, 7.99, and 7.100). This brings up the New Shapefile window, as in Figure 7.131, where a line Shapefile named lines.shp is opened, the default overlay name “lines” is in place, and a new Overlay Folder project2 is being created. The check box by Copy Shapefile to Project is selected to copy the original Shapefile into the project folder.

Clicking Next brings up the window as in Figure 7.132, where the three basic options for drawing line Shapefiles are presented: All Objects the Same, Simple Ranges, or Advanced. The procedures and options for displaying line Shapefiles via any of these three methods are essentially the same as previously presented for point Shapefiles via these same three options. Two exceptions are that there is no option to display lines as text versus icons, and there are no options to display text or values associated with the dBASE® attributes for lines. Tools and options to define Map Tips and Descriptions are available, as are options to display lines based on unique values or ranges of values. Additional clauses can be added or inserted using the Shapefile Legend Editor.
Figure 7.131. Importing a line shapefile to create a new overlay.

Figure 7.132. Three methods for drawing line shapefiles.
Polygon shapefiles

Importing polygon Shapefiles also starts with the same steps as point or line Shapefiles, i.e., right-click on Shapefiles and left-click on New in the View Control window. Browse to the desired polygon Shapefile and Open that file in the Select Shapefile window (see Figures 7.88, 7.89, and 7.90). This results in the New Shapefile window, as shown in Figure 7.133, where a polygon Shapefile named polygons.shp is being opened, the default overlay name “polygons” is in place, and a new Overlay Folder named project3 is being created. The check box by Copy Shapefile to Project is also selected to copy the original Shapefile files into the project folder.

Clicking Next brings the user to the window shown in Figure 7.134, where the three basic options for drawing polygon Shapefiles are presented: All Objects the Same, Simple Ranges, or Advanced. The procedures and options for displaying polygon Shapefiles via any of these three methods are essentially the same as were previously presented for displaying point Shapefiles via these same three options. Two exceptions to this are that there is no option to display the polygons as text versus icons, and there are no options to display text or values associated with the dBASE® attributes for polygons. The option to draw the polygons as Filled or Outlined is available. Filled polygons have the option to define color fill and patterns for the interior of the polygons while Outlined polygons may only be displayed as outlines with no interior color or pattern. Tools and options to define Map Tips and Descriptions are available, as are options to display polygons based on unique values or ranges of values. Additional clauses can be added or inserted using the Shapefile Legend Editor.
Figure 7.133. Creating a new polygon shapefile overlay.

Figure 7.134. Selecting the method to draw the polygon shapefile.
8 Processing Route Reconnaissance Data

Recon

The Recon project component is used with the Automated Route Reconnaissance Kit for collecting, recording, and displaying route reconnaissance information in the TETK. The ARRK includes hardware that is installed in a vehicle to measure and record reconnaissance data, and the TETK is the software platform for that system. Details on using the ARRK for route reconnaissance are given in “Installation and Operation of the Automated Route Reconnaissance Kit (ARRK)” [ERDC technical report TR-05-11].

Two options are available after right-clicking on Recon in the View Control window: New Recon Folder and Add Existing Recon Folder (Figure 8.1). New Recon Folder is selected when the user will be physically conducting reconnaissance with the ARRK, and Add Existing Recon Folder is selected when working with previously recorded reconnaissance data.

![Figure 8.1. Recon component options.](image-url)
New Recon Folder

The New Recon Folder is to be selected only when the computer is physically connected to the ARRK system and the user is preparing to record new reconnaissance data with the ARRK using the TETK software. Details on this function are provided in ERDC TR-05-11.

Add Existing Recon Folder

When reconnaissance data have been previously collected with the ARRK system, the resulting recon may be shared and used on other computers or by other users through the Add Existing Recon Folder function. Selecting this option from the Recon component will bring up the window shown in Figure 8.2, which allows the user to browse for the existing recon folder to add to the TETK project. That folder may be stored on the user’s computer, on a CD, on a network drive, or on other data storage media. The user browses to the desired recon folder and opens that folder. In the example shown in Figure 8.2, the recon folder is named Mobile-Bankhead Tunnel. Opening that folder reveals a file with the same name as the recon folder but with the “.rdf” file extension. Figure 8.3 shows the “Mobile-Bankhead Tunnel.rdf” file for this example in the Mobile-Bankhead Tunnel recon folder. It is that “.rdf” file that the user must open to add this existing recon folder to the current TETK project.

After adding the recon folder, the Recon component in the View Control window will have a plus sign if this is the first recon folder in the project. If previous recons already exist, the plus sign will already be there. Expanding Recon (by clicking on the plus sign and then expanding the new recon folder) will reveal the new recon that has been added to the project. This action is shown in Figure 8.4 for the Mobile-Bankhead Tunnel example.

Under the expanded recon folder are one or more specific recons that were previously recorded. Each recon has a name that was given by the original ARRK user who recorded the data, with a date-time stamp and random five-digit number appended to ensure a unique name. To open the recon, the user double-clicks in the box adjacent to the recon name, and a check appears in that box along with two toolbars on the right side of the window and the recon route and other features (as shown in Figure 8.5).
Figure 8.2. Add Existing Recon Folder window.

Figure 8.3. Opening existing recon folder.

Open ".rdf" file to add existing recon folder
Figure 8.4. Expanding the new recon folder.

Figure 8.5. Opening the new recon.

- Double-click to open recon
- Recon toolbars and route display
Viewing the recon

To view the recon, select Recon View from the toolbar as indicated in Figure 8.6. This will activate the Recon:Control and Recon:Picture windows, as also shown in Figure 8.6.

Recon:Control window

After opening the recon data, viewing and navigating is primarily done with the controls in the Recon:Control window. The options and tools within the Recon:Control window are described in the following sections.

Play, Pause/Stop and Rewind

Click Play to begin the playback. If the recon data has not previously been centered in the main viewing window, it will automatically become centered in the main viewing window when Play is pressed. The video playback will appear in the Recon:Picture window, and the icon showing the current vehicle location within the recon will move along the route. Any audio that was recorded with the original recon will play, provided the sound and speakers on the computer are functioning and are not muted. The playback can be paused or stopped by pressing the Pause button, and the playback will reverse if the Rewind button is pressed. Figure 8.7 shows an example of the recon playback.

Playback Speed

The playback speed is changed by selecting the desired speed from the drop-down list, as shown in Figure 8.8. After selecting a new playback speed, the Play button or the Rewind button must be pressed for the new playback speed to take effect. Note that audio will play only when the recon is playing at the x1 playback speed.
Figure 8.6. Opening the Recon:Control and Recon:Picture windows.

Figure 8.7. Playing the recon.
Seek

The user can navigate through the recon data in a number of ways. The recon can simply be played back and viewed in forward or reverse and at various playback speeds as previously described. The user may also skip through the recon data and seek only specific items such as road changes, intersections, bridges, steep grades, or intersections. To do so, the user selects the item to seek from the drop-down list, as shown in Figure 8.9. Once an item is selected from the list, the forward seek button is used to seek and jump to the next such item forward along the recon, or the backward seek button is used to seek and jump to the previous such item backward along the recon from the current location. When an item is found and the recon has jumped to the appropriate location in this manner, the forward or backward seek buttons may be selected again to seek and jump to the next item, or the recon may be played forward or backward from that location. If no additional items of the type selected occur along the recon in the direction the user is seeking, a message of “None Found” will appear when the seek button is pressed.
Current Location

The coordinates shown under Current Location indicate the coordinates of the current vehicle location along the recon.

Segment Distance

The value under Segment Distance shows the total distance in kilometers from the beginning of the recon to the current vehicle location.

Distance

Distance measures the straight line distance between any two locations along the recon. At any point along the recon, click the upper of the two buttons above Distance, and this will lock the coordinates of that location into the first distance window. Then, move the vehicle location to another point along the recon by playing the recon or by seeking an item, and click the lower of the two buttons. This locks the coordinates of that second point into the second distance window and displays the straight line distance between the two locations, as illustrated in Figure 8.10.
The Recon:Picture window displays the video image recorded by the ARRK camera for the current location along the recon. The grid coordinates indicating the location of the image are displayed in the lower-left portion of the window, and an arrow depicting the direction of travel is also displayed. The arrow pointing directly up would indicate that the direction of travel is north.

Saving individual images from the Recon:Picture window

Although the images in the Recon:Picture window may appear to be a video or movie when played, they are actually a series of individual still photos. A snapshot or individual image from this window may be saved as a separate image file by right-clicking within the Recon:Picture window. After right-clicking, the user will be prompted to provide a location and file name to save the current image in the Recon:Picture window, as shown in Figure 8.11. The image will be saved as a .jpg-format image file.
Viewing legend for recon objects

Icons for the various objects along the recon track appear in the main viewing window. To view the legend that defines what each icon represents, select the Legend tab in the View Control window, and the legend for the icons in the active recon will be displayed as shown in Figure 8.12.

Controlling display of recon objects with the Stacker

Display of individual components of a recon may be controlled with the Stacker in the View Control window. To access the Stacker, select the Stacker tab in the View Control window as shown in Figure 8.13. With the Stacker, the user can toggle off the display of one or more individual components of the recon by clicking in the box adjacent to an object until there is no check mark in the box. For example, Figure 8.13 shows all of the recon objects displayed, while Figure 8.14 shows the display redrawn with Intersections and Obstructions toggled off using the Stacker.
Figure 8.12. Display of the legend for recon objects.

Figure 8.13. Stacker for recon objects.
Recon toolbars

Two toolbars appear on the right side of the TETK interface when a recon has been opened for viewing. These toolbars (the location of which was shown in Figure 8.5) provide a series of tools for working with the recon data, editing the recon, and extracting data from the recon. Each of the tools and its functionality is described below.

Select Location

In addition to navigating along the recon using the play and seek tools in the Recon:Control window, navigation along the recon may be accomplished by using the Select Location tool shown in Figure 8.15. Once this tool is chosen, the cursor turns into a crosshair, and the user may simply click on or near the route at a location of interest. The current location icon will jump to the nearest location along the route to the point clicked, and the user may play the recon in forward or reverse, use the seek function, or click at another location using the Select Location tool to continue to navigate through the recon.
Slope/ Curve

The Slope/Curve tool opens the Compute window, as shown in Figure 8.16, in which there are buttons for Compute Curves, Compute Slopes, and Compute Track. Each of these buttons should be pressed once for the recon. The result of Compute Curves will be that any sharp curves that were recorded by the ARRK (based on the gyroscope data during the original recon) will be computed, and icons showing the locations of the sharp curves will be displayed along the recon track in the main viewing window. The Compute Slopes will accomplish the same for any steep slopes that were detected by the ARRK during the original recon. When the Compute Track button is pressed, the TETK software will analyze the track that was recorded by the ARRK based on the GPS readings during the original recon. If any GPS points that were collected along the track did not have a good GPS signal from at least three satellites, the Compute Track function will automatically detect those errors and correct the track data for the recon. This function is automatically performed on the GPS points recorded using TETK Version 3.04.0103.2907 (29 Mar 07) or later, and the feature described here is provided as a means of correcting GPS
data collected using earlier versions of the software. Note that GPS points that are determined to be errant will be lost from the data at this point once the Compute Track button is pressed. The user is prompted as such on the screen and given the option to cancel the Compute Track action if necessary. Once these Compute buttons have been pressed once each, click OK to close the Compute window.

Pressing the Zero Data tool will bring up the Obtain Zero Data window shown in Figure 8.17. The purpose of this tool is to allow the user to define the basis from which slopes will be computed from the recon data. For example, there may be a situation in which the ARRK data collection box could not be placed on a flat surface in the vehicle while the recon data were being recorded. As such, the recorded recon data would indicate a slope even when the vehicle was on flat terrain (the slope being due to the recording device not being level). The Zero Data tool allows for that to be corrected such that the correct slope data may be analyzed for the recon track. Three options are available in the Obtain Zero Data window. These
options are Reset Zero Data, Use Default Zero Data, and Use Current Gyro Data as Zero. The appropriate use of each of these options is described below.

**Reset Zero Data** – This option will reset all zero gyroscope values to zero.

**Use Default Zero Data** – This option sets the zero gyroscope data to the values obtained from the Acquire Zero Data setup dialog during the initial ARRK setup, or it will use the previously saved zero data if the Save As Default checkbox has been checked in the past.

**Use Current Gyro Data as Zero** – The gyroscope data for the current vehicle location in the recon playback will be used as the zero data if this option is selected.

![Figure 8.17. Obtain Zero Data window.](image)
The Edit tool allows the user to edit information associated with objects along the recon track. To do so, an object must first be selected. This is accomplished by choosing the type of object to be edited from the drop-down Seek list in the Recon:Control window. For example, Bridge has been selected from that drop-down list in Figure 8.18. Next, press the forward seek button and the next bridge along the recon track will be selected, or press the backward seek button and the previous bridge along the recon track will be selected. The selected object will be highlighted by a white box in the main viewing window. Figure 8.19 shows the next bridge along the recon track selected and highlighted after the forward seek button was pressed. Once the object has been selected, the Edit button becomes active and may be pressed to bring up the edit window for the object type. The window for Bridge is shown in Figure 8.20. Information associated with the object may be entered into this window, and the information will be saved when the OK button is selected. The same steps are followed to edit Road Change, Curve, Steep Grade, Bridge, Obstruction, Intersection, and Other objects along the recon track.
Figure 8.19. Object along recon track selected.

Figure 8.20. Edit window for bridge information.
Delete

The Delete button will delete the selected object. Note that there is no undo button and no confirmation to verify that the user wishes to delete the object once this button is pressed.

Road Change

The Road Change tool generates a Road Properties window, as shown in Figure 8.21, which enables the user to specify the location of a road change such as a new road surface type or a change in the width or other characteristic of the road along the recon track. To specify the location of the road change, click the Location button and the coordinates of the current vehicle location will become the location for the road change. The surface type is selected from the Surface Type drop-down list, and the width and other characteristics of the road change are also specified in the Road Properties window. Clicking OK completes the process, and the new road change will be added to the recon track, as shown in Figure 8.22.

Figure 8.21. Road Change Tool and Road Properties window.
The Obstruction tool enables the user to add an Obstruction to the recon track at a given location. Selecting the Obstruction tool brings up the Obstruction dialog. In this dialog, the user specifies the current vehicle location as the location for the Obstruction by pressing the Start Location button. This will mark the coordinates of the current vehicle location in the Start Location area of the dialog; the user may also provide additional details and information about the obstruction in the Particulars and Remarks areas of the dialog. An example of the Obstructions window is shown in Figure 8.23. After pressing the OK button, a new icon for the obstruction will be added to the recon track at the appropriate location, as shown in Figure 8.24.
Chapter 8   Processing Route Reconnaissance Data

Figure 8.23. Obstruction window to add new obstruction to recon track.

Figure 8.24. New obstruction added to recon track.
Steep Grade

With the Steep Grade tool, the user may add a Steep Grade designation to a section of the recon track. Selecting the Steep Grade tool brings up the Grade dialog in which the user specifies the current vehicle location as the start of the grade by pressing the Start Location button, as shown in Figure 8.25. This will mark the coordinates of the current vehicle location in the Start Location area of the dialog and mark that location as the start of the grade. The current vehicle location is then moved to the end of the grade, and the user presses the End Location button to designate that location as the end of the grade and manually enters the slope of the grade in the dialog, as shown in Figure 8.26. After pressing OK, the grade is then indicated along the recon track in blue between the designated Start Location and End Location, as shown in Figure 8.27.

![Figure 8.25. Designating start location in steep grade tool.](image)
Figure 8.26. Designating end location in steep grade tool.

Figure 8.27. New grade added to recon track.
Curve

The Curve tool allows a Curve to be added to the recon track. In the Curve dialog, which appears after selecting the Curve tool, the beginning of the curve is designated by pressing the Start Location button to mark the coordinates of the current vehicle location, as shown in Figure 8.28. The vehicle location is then moved to the end of the curve, and the coordinates at that location are marked by pressing the End Location button (see Figure 8.29). The radius of curvature is entered and, after selecting OK, the icon denoting a sharp curve location is added to the recon track, as shown in Figure 8.30. Curves with a radius of curvature of 30 meters or less are designated with a red curve icon, and those with a radius of curvature greater than 30 meters are shown with a yellow curve icon. The legend tab in the View Control window can be selected to view the legend for recon icons.

Figure 8.28. Start location of curve.
Figure 8.29. End location and radius of curvature for curve.

Figure 8.30. New curve added to recon track.
The Bridge tool allows the user to add a Bridge to the recon track at a given location. Selecting the Bridge tool brings up the Bridge dialog shown in Figure 8.31. Here, the user specifies the current vehicle location as the location for the Bridge by pressing the Start Location button, which marks the coordinates of the current vehicle location in the Start Location area of the dialog. The user may then also complete as much information about the bridge as is available to complete the remainder of the Bridge dialog. After completing the Bridge dialog and pressing the OK button, a new icon for the bridge will be added to the recon track at the appropriate location, as shown in Figure 8.32.

Figure 8.31. Bridge dialog.
An Intersection is added to the recon track with the Intersection tool. Selecting this tool brings up the Intersection dialog shown in Figure 8.33. Pressing the Start Location marks the coordinates of the current vehicle location as the location for Intersection. The user may also enter remarks such as the names of the intersection streets or other pertinent information about the intersection. After completing the Intersection dialog and pressing OK, a new Intersection icon is added to the recon track at the selected location, as shown in Figure 8.34.
Figure 8.33. Adding a new intersection.

Figure 8.34. New intersection added to recon track.
Other Point of Interest

The tools listed above give the user the capability to add most of the common features along a route that may be encountered, with a specific tool provided for each type of feature or object. The Other Point of Interest tool (dialog shown in Figure 8.35) allows the user to add an icon to the recon track to designate some object or feature along the recon track that does not fit one of the tools specified above. The coordinates of the current vehicle location are used to mark the location of the Other Point of Interest by pressing the Start Location button. Remarks describing the Other Point of Interest may then be entered, and a new icon is added to the recon track after selecting OK, as shown in Figure 8.36.

![Figure 8.35. Other Point of Interest dialog.](image-url)
Export Elevation

The Export Elevation tool enables the user to create a text file that contains the GPS location and elevation data that were recorded along the recon track between any two specified locations, or along the entire route. Selecting this tool brings up the Export Elevation Track dialog shown in Figure 8.37. Here, the user specifies a file name to which the data are to be saved and marks the desired beginning and ending points for the data to be exported using the Start Location and End Location buttons. The coordinates of the current vehicle location will be marked as the beginning point when the Start Location button is pressed and, similarly, for the ending point when the End Location button is pressed. If the user wishes to export the data for the entire recon track, the Entire Route check box may be selected. When the file name, Start Location, and End Location have been specified and the OK button pressed, a file is saved that contains data as shown in the example data file (Figure 8.38). This example file is shown being viewed using Microsoft Excel, but the file is simply a text file that may be opened in various other applications. The data file contains
the latitude, longitude, elevation, and several other data fields associated with the GPS points recorded along the recon track. Note that the elevation data shown are based on the elevation recorded by the GPS unit with the ARRK, and the elevation data in this application do not come from digital terrain data (such as DTED) that may be associated with the TETK project.

![Figure 8.37. Export Elevation Track dialog.](image)
Figure 8.38. Sample data file from Export Elevation Track.

Export Pictures

A series of pictures showing the individual images that were taken with the windshield camera along a segment of the recon track by the ARRK system may be exported with the Export Pictures tool. These images are those that are displayed in the Recon:Picture window when the recon is viewed in the TETK. Selecting the Export Pictures tool brings up the Export Picture Records dialog, as shown in Figure 8.39. The user must specify the folder into which he wishes the image files to be saved, and the beginning and ending points of a section along the recon track must be provided using the Start Location and End Location buttons. Images along the entire recon track can be saved by checking the Entire Route box. When OK is pressed, all of the individual images between the specified Start Location and End Location, or along the entire recon track if that option was selected, will be saved to the specified folder. Figure 8.40 shows an example of a folder where a series of images have been saved in this manner. Note that there is an Excel spreadsheet file in that folder along with the image files. That spreadsheet contains data on the location, azimuth, and date/time for each of the image files—to provide
georeferencing information. Note that these are not fully georeferenced images that can be merged together to create a seamless georectified image. Rather, the data contained in the spreadsheet merely provide information as to the location and direction of travel of the ARRK system when each image was originally captured.

Figure 8.39. Export Picture Records dialog.
Extract Other Point of Interest

The Extract Other Point of Interest tool is used to export a file containing location, description, and status information related to a specified set of Other Points of Interest. To use this tool, a text file containing relevant information for the points of interest must be in the following folder:

C:\TETK\Configuration\Recon\Extract Others

The current version of the TETK software has one such file in that folder that is created when the software is installed. That sample file defines certain information related to potholes that are designated as either “Repaired” or “Needs Repair.” The text file is named “Potholes.txt” and the contents of that text file are as follows:

# Key “Description” “Status”
PH “Pothole” “Needs Repair”
PHR “Pothole” “Repaired”
The first line (starting with #) contains comments describing the fields of information in the lines that follow. Each of the succeeding lines contains three items: Key, Description, and Status. Here, the Key is “PH” for a pothole that needs repair or “PHR” for a pothole that has been repaired. More lines, with additional descriptions and status options, can be used.

To export a data file with information related to potholes, Other Points of Interest must be created, as previously described, and the appropriate key must be in the Remarks section in the Other Point of Interest dialog. For example, Figure 8.41 shows an Other Point of Interest created with the pothole key PH in the remarks dialog. Figure 8.42 shows another with the pothole key PHR in the remarks dialog. When the Export Other Points of Interest tool is selected, the user selects the type of object to be exported and specifies the folder into which the file is to be saved, as shown in Figure 8.43. A prompt appears (as in Figure 8.44) after OK is selected, verifying that the file has been written. The resultant exported data file is in a comma-separated text file format (.csv) that can be opened in Microsoft Excel or another appropriate application. The contents of the sample file created here are shown in Figure 8.45.

Figure 8.41. Creating an Other Point of Interest with pothole key PH.
Figure 8.42. Creating an Other Point of Interest with pothole key PHR.

Figure 8.43. Selecting type and folder for extracting other objects of interest.
Figure 8.44. Verifying successful extraction of other objects.

Figure 8.45. Contents of sample data file for extracted objects.
This method for extracting other points of interest provides great flexibility and allows the user to create customized object extractions as needed to meet their needs. A simple text file is created with the Key, Description, and Status information for the desired objects to be extracted; the appropriate Key is entered into the Remarks section when an Other Point of Interest is created; and then those points can be extracted to create a file similar to the one shown in Figure 8.45. Even though the example presented herein shows only two keys for potholes, there may be as many different keys as needed to meet the user’s needs, and the user may create as many text files as needed for different objects to be extracted.

**Save objects to Route Database (Engr DB)**

The TETK provides the capability to save data and objects from a recon, or from multiple recons, to a database. Once the recon data have been saved to the database, it can then be used to create a route. The distinction between a “recon” and a “route” in the TETK should be clarified so that the process of saving data from recons to the Route Database and using those data to create routes is understood. A recon consists of all of the data collected and recorded during a single recording session with the ARRK. Data from one or more recons may be saved to the Route Database. A route then consists of specific segments from among all of the recon data that reside in the Route Database. For example, if two separate recons are conducted on two different days with the ARRK, and the data from both recons are saved to the Route Database, the user can then create a single new route using some portion of the first recon that joins geographically with some portion of the second recon. After the route has been created in this manner, the standard Road Reconnaissance Report (DA Form 1248) and other standard recon forms can be automatically generated from within the TETK for that route. Additional details on the concept of the Route Database are provided in the next section of this manual.

To save recon objects to the Route Database, right-click on the name of the active recon in the View Control window and select Save Objects (Engr DB), as shown in Figure 8.46. This should be done only one time for each recon.
Save recon to Route Database (Engr DB)

The entire recon, including the images from the ARRK windshield camera and audio track, may be saved to the Route Database. Once this is done, that recon can later be retrieved for viewing, analysis, or editing. To save the recon to the Route Database, right-click on the name of the active recon in the View Control window and select Save Recon (Engr DB), as shown in Figure 8.47.
Figure 8.47. Saving recon to Route Database.

Downloading a recon from Route Database (Engr DB)

Once a recon has been saved to the database, that recon is within the database and can be downloaded. To download a recon from the database, right-click on the recon folder and select Download Recon (Engr DB), as shown in Figure 8.48. A menu listing the available recons in the database will then appear, as shown in Figure 8.49. This example shows only one recon in the database, but additional recons would be listed if they had been saved. The user selects the desired recon for download, presses OK, and the recon is loaded into the project for use as shown in Figure 8.50.
Figure 8.48. Download recon from database.

Figure 8.49. Selecting recon for download from database.
Viewing recon data in Output Control window

In addition to the graphical information and icons displayed along the recon track in the main viewing window, the audio recorded during the recon, and the pictures displayed in the Recon:Picture window, a series of other digital data are recorded by the ARRK during the recon process. This is primarily data recorded by the gyroscope in the ARRK system and includes data on the pitch, roll, and yaw as well as the acceleration in all three dimensions. To view these data, the recon must be active (check mark in box by name of recon and name of recon highlighted), it must be in viewing mode (select the Recon View icon), and the Output Control window must be opened by selecting the Output Control tool as shown in Figure 8.51. When the recon is played, the data in the Output Control window will scroll and are time synchronized with all of the other recon information being shown in the main display window.
Right-clicking in the Output Control window will bring up the Graph Control menu shown in Figure 8.52, which allows the user to control what channel of information is displayed, to select colors for the graph, and to control the scale at which data are displayed. The user may change the items or channels of data being displayed by selecting from the drop-down list of options, as shown in Figure 8.53. The color for each channel of data on the graph may be selected by left-clicking on the colored line by each channel to bring up a color selection window, as shown in Figure 8.54.

The scale for display of the data on the scrolling graph may also be controlled by selecting the Scale tab on the Graph Control menu shown in Figure 8.55. Note that the scale displayed on the left side of the scrolling display in the Output Control window always shows as ranging from -1.0 to +1.0. The number selected in the Scale tab for each item displayed corresponds to a full-scale value of 1.0 on the graph. For example, a scale of 10 for Angle means that if the ARRK has recorded a 10-degree incline, the graph will display a value of +1.0. If an incline of 5 degrees is recorded, the graph will display a value of +0.5 (half of the full-scale value).
Figure 8.52. Graph control for recon data.

Right-click in Output Control window for graph control.

Figure 8.53. Selecting data channel for recon data in Output Control window.
Figure 8.54. Color selection for data display.

Figure 8.55. Scale options for graph control.

Click on line for color options
Route Database

The Route Database is used to store data associated with one or more recons from which routes may be created and standard road reconnaissance and other forms generated. The current approach for this is that the database resides locally on the computer where the TETK software is running. However, in future versions of the TETK, it is anticipated that the capability will exist to use a central database that is accessible by multiply users via a network. In that configuration, data from multiple recons conducted by multiple ARRK users may all be stored to the common Route Database for use by many users connected to the database via the network.

Expanding the Route Database folder in the View Control window reveals route objects (bridges, curves, roads, etc.) that may exist in the Route Database from recons that have been saved to the database. Figure 8.56 shows the listing of these route objects in the View Control window.

Figure 8.56. Components of the Route Database in the View Control window.
Any one of more of the types of objects listed under the Route Database may be displayed in the main viewing window by double-clicking on the name of the item to be displayed, or in the box adjacent to the name. Figure 8.57 shows the bridges (red icons), intersections (green icons), and roads (yellow lines) displayed.

![Figure 8.57. Selected Route Database objects displayed.](image)

**Working with Route Database objects**

Tools are available in the TETK to edit, delete, add, or export objects in the Route Database. To do so, an object type must be displayed by double-clicking to create a check mark in the box adjacent to the name of the object in the Route Database, and the object type must also be active. Multiple types of objects may be displayed simultaneously, but only one type of object may be active at any given time. For example in Figure 8.58, Bridges, Intersections, and Roads are all displayed, but only Bridges is active, as indicated by the blue highlighting over Bridges in the View Control window. An object type is activated by clicking one time on the name of the object to highlight it. Note also in Figure 8.58 that the Route Database toolbar along the right side of the interface is now open.
Once an object type is displayed and active in the Route Database and the Route Database toolbar is displayed, the specific objects of that type in the database may be selected and edited. The first step in this process is to select the object that is to be edited. To select a specific object, the cursor must be in “select” mode. This is done by ensuring that both the normal mode icon ( ) in the Map toolbar and the select mode icon ( ) in the Route Database toolbar are selected, as indicated in Figure 8.59. The cursor then becomes a crosshair, and the desired object is selected in the main viewing window by clicking on it. Once selected, the object will be highlighted by a small white box. In Figure 8.59, a bridge has been selected. Prior to selecting a specific object from the active type, only the Symbology ( ), Select ( ), and New ( ) tools are active in the Route Database toolbar. These tools allow the user to define the symbology (color, line size, icon) for a new object, select an existing object, or create a new object of the active type, respectively. Once a specific object of the active type has been selected, the remaining tools on the Route Database toolbar are also active.
Bridges in the Route Database

Editing Bridge Data (Bridge Reconnaissance Report – DA Form 1249)

Bridge data may be edited with the EDT tool on the Route Database toolbar. When EDT is selected, the Bridge Reconnaissance Report (DA Form 1249) appears as in Figure 8.60. The form is populated with some data (such as location) about the bridge from information in the Route Database, and the form may be edited in the yellow highlighted spaces.

The second page of the Bridge Reconnaissance Report provides areas to include drawings or attach photographs to further describe the bridge, as shown in Figure 8.61. Left-clicking with the mouse on the form inside any one of the drawing areas brings up a drawing palette with tools to draw bridge details, as shown in Figure 8.62. Photographs may be inserted into the form in these areas following the steps shown in Figure 8.63. Additional pages may be added to the form if needed to include additional photographs, as shown in Figure 8.64. The form may be saved or printed once it is complete. Note that the user must click OK on the form for information added to the form to be saved to the database.
Figure 8.60. Bridge Reconnaissance Report (DA Form 1249) – page 1.

Figure 8.61. Bridge Reconnaissance Report (DA Form 1249) – page 2.

Click EDT for Bridge Report

Click in any drawing area for drawing palette
Figure 8.62. Drawing and image palette for bridge report.

Figure 8.63. Inserting a photograph or image file into Bridge Report.
Adding a New Bridge

A new bridge may be added by selecting the NEW tool from the Route Database toolbar. When the NEW tool is selected, the cursor becomes a crosshair, and the user clicks on the map or image in the main viewing window at the location where the new bridge is to be created. Once the location is selected on the map or image, the Bridge Reconnaissance Form will appear and the user may use that form as described above. Click OK when finished with the form for the new bridge to be added to the Route Database.

Deleting a Bridge

A bridge may be deleted from the Route Database by selecting the bridge and clicking the Delete tool (\( \times \)). Note that there is no undo button, and the user is not prompted to verify the deletion. Once the Delete tool is pressed, the selected bridge will be deleted.
Relocating a Bridge

The location for a bridge may be changed by selecting the bridge to be moved, selecting the GEO tool from the Route Database toolbar (the cursor will become a crosshair), and then left-clicking on the map or image in the main viewing window at the desired new location for the bridge. Once the new location for the bridge is clicked on the map or image, the selected bridge will immediately be moved to that new location.

Curves in the Route Database

Editing Curve Data

After selecting a Curve and pressing the EDT tool on the Route Database toolbar, a dialog will appear showing the Curve Radius (meters) for the selected curve. The radius of curvature has been determined from data collected by the ARRK during the recon. Figure 8.65 shows an example of this Curve Radius dialog, and the user may edit the radius of curvature as needed.

Figure 8.65. Editing curve data in the Route Database.
Adding a New Curve

A new curve may be added to the Route Database using the NEW tool from the Route Database toolbar. The cursor will become a crosshair when the NEW tool is selected, and the user must define the location of the curve by clicking on the map or image in the main viewing window. A curve is a linear feature, so the user must define at least two points (start and end of curve) but may include additional points along the curve to properly define its extent. As the points along the curve are being created, the drawing toolbar becomes active to enable the user to undo, edit, extend, or cancel the drawing process for the curve. When the curve has been completed, the Done button on the drawing toolbar must be clicked, and the dialog will then appear for the user to enter the radius of curvature for the new curve. The process of adding a new curve to the Route Database is shown in Figures 7.66–7.68.
Chapter 8   Processing Route Reconnaissance Data

Figure 8.67. Entering radius of curvature for new curve.

Click “Done” to finish drawing

Enter radius of curvature and click OK

Figure 8.68. New curve completed and added to Route Database.

New curve added
Deleting a Curve

A curve may be deleted from the Route Database by selecting the curve and clicking the Delete tool (×) from the Route Database toolbar. Note that there is no undo button, and the user is not prompted to verify the deletion. Once the Delete tool is pressed, the selected curve will be deleted.

Relocating a Curve

A curve may be relocated by selecting a curve and then clicking the GEO tool from the Route Database toolbar. When the GEO tool is selected, the points along selected curve become active or highlighted in the main viewing window and the drawing toolbar becomes active. The user may move or relocate points along the curve by selecting a point and dragging it with the mouse to redefine its location, and the user may use the extend tool to increase the length of the curve. When the changes are complete, click the Done button on the drawing toolbar to finish. Figure 8.69 shows a selected curve being relocated.
Ferries in the Route Database

Editing Ferry Data (Ferry Reconnaissance Report – DA Form 1252)

Ferry data may be edited with the EDT tool on the Route Database toolbar after a ferry has been selected. EDT brings up the Ferry Reconnaissance Report (DA Form 1252), as in Figure 8.70. The form is populated with the ferry location (initial and terminal points) from information in the Route Database, and the form may be edited in the yellow highlighted spaces.

Page 2 of the Ferry Reconnaissance Report provides areas to include drawings or attach photographs to further describe the ferry. Drawing palette capabilities are also included, and photographs or images may be inserted, as previously described for the Bridge Reconnaissance Report. The “Add Photograph Form” button at the bottom of the second page of the Ferry Reconnaissance Form may be used to add more pages to the form, if needed, to include additional photographs. The form may be saved or printed once it is complete. Note that the user must click OK on the form for information added to the form to be saved to the database.

Figure 8.70. Ferry Reconnaissance Report (DA Form 1252) – page 1.
Adding a New Ferry

A new ferry may be added to the Route Database using the NEW tool from the Route Database toolbar. The cursor will become a crosshair when the NEW tool is selected, and the user defines the initial point and terminal point of the ferry location by clicking on the map or image in the main viewing window. After those two points have been selected on the map, the Ferry Reconnaissance Report form will appear for the user to provide data regarding the new ferry. When the Ferry Reconnaissance Report is completed, clicking OK will save the data and add the new ferry to the Route Database.

Deleting a Ferry

A ferry may be deleted from the Route Database by selecting the ferry and clicking the Delete tool (🗑️) from the Route Database toolbar. Note that there is no undo button, and the user is not prompted to verify the deletion. Once the Delete tool is pressed, the selected ferry will be deleted.

Relocating a Ferry

To relocate a ferry, first select the ferry that is to be moved and then click the GEO tool on the Route Database toolbar. The cursor will become a crosshair, and the user must select the new initial point and terminal point for the ferry by clicking on the map or image in the main viewing window. After those two points have been selected, a white line indicating the new ferry location will appear on the screen. Click the Select tool (☐) on the Route Database toolbar to complete the process.

Fords in the Route Database

Editing Ford Data (Ford Reconnaissance Report – DA Form 1251)

The EDT tool on the Route Database toolbar may be used to edit ford data after a ford has been selected. The Ford Reconnaissance Report (DA Form 1251) appears when the EDT tool is selected, as in Figure 8.71. The form is populated with the ford location (initial and terminal points) from information in the Route Database, and the form may be edited in the yellow highlighted spaces.
The Ford Reconnaissance Report provides areas on Page 2 of the form to include drawings or attach photographs related to the ford. Left-clicking in any area on Page 2 will bring up the drawing palette, and photographs or images may be inserted as previously described for the Bridge Reconnaissance Report. The “Add Photograph Form” button at the bottom of the second page of the Ford Reconnaissance Form may be used to add more pages to the form, if needed, to include additional photographs. The form may be saved or printed once it is complete. Note that the user must click OK on the form for information added to the form to be saved to the database.

Figure 8.71. Ford Reconnaissance Report (DA Form 1251) – page 1.

Adding a New Ford

A new ford may be added to the Route Database using the NEW tool from the Route Database toolbar. The cursor will become a crosshair when the NEW tool is selected, and the user defines the initial point and terminal point of the ford location by clicking on the map or image in the main viewing window. After those two points have been selected on the map, the Ford Reconnaissance Report form will appear for the user to provide data.
regarding the new ford. When the Ford Reconnaissance Report is completed, clicking OK will save the data and add the new ford to the Route Database.

Deleting a Ford

A ford may be deleted from the Route Database by selecting the ford and clicking the Delete tool (\(\text{\textasteriskcentered}\)) from the Route Database toolbar. Note that there is no undo button, and the user is not prompted to verify the deletion. Once the Delete tool is pressed, the selected ford will be deleted.

Relocating a Ford

To relocate a ford, first select the ford that is to be moved and then click the GEO tool on the Route Database toolbar. The cursor will become a crosshair, and the user must select the new initial point and terminal point for the ford by clicking on the map or image in the main viewing window. After those two points have been selected, a white line indicating the new ford location will appear on the screen. Click the Select tool (\(\text{\textasteriskcentered}\)) on the Route Database toolbar to complete the process.

Intersections in the Route Database

Editing Intersection Data

After selecting an Intersection and pressing the EDT tool on the Route Database toolbar, a dialog will appear with Remarks for the selected curve. Figure 8.72 shows an example of this Intersection Remarks dialog, and the user may edit the remarks as needed.

Adding a New Intersection

A new Intersection may be added to the Route Database using the NEW tool from the Route Database toolbar. The cursor will become a crosshair when the NEW tool is selected, and the user must define the location of the intersection by clicking on the map or image in the main viewing window. When the location for the new Intersection is selected, the Intersection Remarks dialog will appear and the user may enter remarks as appropriate and click OK when finished.
Deleting an Intersection

An Intersection may be deleted from the Route Database by selecting the Intersection and clicking the Delete tool (\texttimes) from the Route Database toolbar. Note that there is no undo button, and the user is not prompted to verify the deletion. Once the Delete tool is pressed, the selected Intersection will be deleted.

Relocating an Intersection

An Intersection may be relocated by selecting the Intersection and then clicking the GEO tool from the Route Database toolbar. When the GEO tool is selected, the cursor becomes a crosshair and the user clicks the new location for the Intersection on the map or image in the main viewing window. When the new location is clicked on the map or image, the Intersection will be immediately relocated to that point.
IRI in the Route Database

The “IRI” in the Route Database refers to the International Roughness Index, which is used to define a characteristic of the longitudinal profile of a traveled wheeltrack and constitutes a standardized roughness measurement. The commonly recommended units are meters per kilometer (m/km) or millimeters per meter (mm/m). The IRI is based on the average rectified slope, which is a filtered ratio of a standard vehicle’s accumulated suspension motion (in mm or m) divided by the distance traveled by the vehicle during the measurement (in m or km).

Editing IRI Data

For a segment of road on which the IRI has been defined in the Route Database, the IRI value may be edited by selecting the segment of road and using the EDT tool from the Route Database toolbar. When EDT is selected, the IRI dialog will appear, as in Figure 8.73. The user may enter or edit the IRI value for that segment of road and click OK when complete.

Figure 8.73. Editing IRI data in the Route Database.
Adding New IRI Data

New IRI data may be defined for a segment of road using the NEW tool from the Route Database toolbar. The cursor will become a crosshair when the NEW tool is selected, and the user must define the segment of road for which the IRI data are to be entered by clicking on the map or image in the main viewing window. The IRI data are defined for a linear feature, so the user must define at least two points (start and end) but may include additional points along the road to properly define the extent over which the IRI data will apply. As the points along the road are being created, the drawing toolbar becomes active to enable the user to undo, edit, extend, or cancel the drawing process. When the segment of road for the IRI data has been defined, the Done button on the drawing toolbar must be clicked, and the dialog will then appear for the user to enter the IRI value for that segment of road. This process is identical to the process used to add a new Curve, as detailed previously in this chapter.

Deleting IRI Data

IRI data may be deleted from the Route Database by selecting the IRI road segment and clicking the Delete tool (x) from the Route Database toolbar. Note that there is no undo button, and the user is not prompted to verify the deletion. Once the Delete tool is pressed, the selected IRI road segment will be deleted.

Relocating IRI Data

IRI data may be relocated by selecting the IRI road segment and then clicking the GEO tool from the Route Database toolbar. When the GEO tool is selected, the points along the selected IRI road segment become active or highlighted in the main viewing window and the drawing toolbar becomes active. The user may move or relocate points along the IRI road segment by selecting a point and dragging it with the mouse to redefine its location, and the user may use the extend tool to increase the length of the IRI road segment. When the changes are complete, click the Done button on the drawing toolbar to finish. This process is identical to the process used to relocate a Curve, as detailed previously in this chapter.
Obstructions in the Route Database

Editing Obstruction Data

After selecting an Obstruction and pressing the EDT tool on the Route Database toolbar, a dialog will appear with Particulars and Remarks for the selected Obstruction. Figure 8.74 shows an example of this Obstructions dialog, and the user may edit the particulars and remarks as needed.

![Figure 8.74. Editing obstruction data in the Route Database.](image)

Adding a New Obstruction

A new Obstruction may be added to the Route Database using the NEW tool from the Route Database toolbar. The cursor will become a crosshair when the NEW tool is selected, and the user must define the location of the Obstruction by clicking on the map or image in the main viewing window. When the location for the new Obstruction is selected the Obstruction dialog will appear, and the user may enter particulars and remarks as appropriate and click OK when finished.
Deleting an Obstruction

An Obstruction may be deleted from the Route Database by selecting the Obstruction and clicking Delete ( \( \times \) ) from the Route Database toolbar. There is no undo button, and the user is not prompted to verify the deletion. Once Delete is pressed, the selected Obstruction will be deleted.

Relocating an Obstruction

An Obstruction may be relocated by selecting it and clicking GEO from the Route Database toolbar. When GEO is selected, the cursor becomes a crosshair and new location for the Obstruction is selected on the map or image in the main viewing window. When the new location is selected, the Obstruction will be immediately relocated to that point.

Other objects in the Route Database

Editing Other Objects (Other Point of Interest) Data

After selecting an Other Object and pressing EDT on the Route Database toolbar, a dialog appears with Remarks for the object. Figure 8.75 shows an example of this dialog, and the user may edit the remarks as needed.

Adding a New Other Object

A new Other Object may be added to the Route Database using the NEW tool from the Route Database toolbar. The cursor will become a crosshair when the NEW tool is selected, and the user must define the location of the object by clicking on the map or image in the main viewing window. When the location for the new Other Object is selected, the dialog will appear and the user may enter remarks and click OK when finished.

Deleting an Other Object

An Other Object may be deleted from the Route Database by selecting the Other Object and clicking Delete ( \( \times \) ) from the Route Database toolbar. Note that there is no undo button, and the user is not prompted to verify the deletion. Once the Delete tool is pressed, the selected Other Object will be deleted.
Relocating an Other Object

An Other Object may be relocated by selecting it and clicking GEO from the Route Database toolbar. When the GEO tool is selected, the cursor becomes a crosshair and the user clicks the new location for the Other Object on the map or image in the main viewing window. When the new location is clicked on the map or image, the Other Object will be immediately relocated to that point.

Roads in the Route Database

Editing Road Attributes

Roads in the Route Database consist of a series of road segments, each of which has certain properties assigned. Those properties include the road surface type and width. To edit the properties of a road segment, select the segment by clicking on the road in the main viewing window and then click ATT on the Route Database toolbar. The Road Properties dialog
shown in Figure 8.76 will appear, and the user may define or edit the surface type from the drop-down list provided, provide a description of the road, and enter or select other properties or characteristics of the road segment. When the road properties have been defined or edited as needed, click OK to complete the process.

![Figure 8.76. Editing road attribute data.](image)

Inserting a Break into a Road Segment

A break may be inserted into a road segment, effectively creating two segments from one original segment. To do so, select the road segment on the map or image in the main viewing window and then select the Break (_splits) tool from the Route Database. Click on the road segment at the desired location for the new break, and the single original segment will then be divided into two segments, one on each side of the break location.

Adding a New Road Segment

To add a new road segment, select the NEW tool from the Route Database toolbar and left-click with the mouse on the map or image in the main
viewing window to add the new road segment. A road segment is a linear object, so at least two points must then be created to define the new road segment, and additional points may be added as needed to define the location and extent of the road segment. Note that while the points are being added, the Drawing toolbar will be active to enable the user to undo, extend, or edit the new road segment. When the new road segment has been completed, select the Done button from the Drawing toolbar and the Road Properties dialog will appear for the user to define the attributes of the new road segment. A new road segment added in this manner is distinguished from existing road segments that were recorded during the original recon by the ARRK system. New road segments added in this manner are “digitized” roads and by default have a different legend color than ARRK-recorded road segments that were saved to the Route Database from a recon. Figure 8.77 shows a new road segment being digitized on the map, and Figure 8.78 shows the completed road segment. Note the legend in the View Control window showing the two different road types.

Figure 8.77. Adding a new road segment.
Deleting a Road Segment

A road segment may be deleted from the Route Database by selecting the road segment to be deleted and then clicking Delete (×) on the Route Database toolbar. Note that there is no undo button, and the user is not prompted to verify the deletion. Once the Delete tool is pressed, the selected road segment will be deleted.

Relocating a Road Segment

A road segment may be relocated by selecting the road segment and then clicking GEO on the Route Database toolbar. When the GEO tool is selected, the points along the selected road segment become active or highlighted in the main viewing window, and the drawing toolbar becomes active. The user may then move or relocate some or all of the points along the Road segment by selecting a point and dragging it with the mouse to redefine its location; the user may also use the extend tool on the drawing toolbar to increase the length of the Road segment. When the changes are complete, click the Done button on the drawing toolbar to finish. This
process is identical to relocating a Curve, as described previously and shown in Figure 8.69.

Steep grades in the Route Database

Editing Steep Grade Data

After selecting a Steep Grade and pressing the EDT tool on the Route Database toolbar, a dialog appears showing the slope (%) for the selected grade. The slope has been determined from data collected by the ARRK during the recon and may be edited as needed by the user. Figure 8.79 shows an example of this Grade Slope dialog.

![Figure 8.79. Editing steep grade slope data.](image)

Adding a New Steep Grade

A new Steep Grade may be added by selecting the NEW tool from the Route Database toolbar. The cursor will become a crosshair, and the user then must select at least two points on the map or image in the main viewing window to define the start and end locations of the Steep Grade. Additional points may be added as needed to define the extent of the Steep
Grade. While the points are being digitized on the screen, the Drawing toolbar is active to allow the user to undo, edit, cancel, or extend the line. When the Steep Grade has been added, select Done from the Drawing toolbar and the Route Slope dialog will appear for the user to define the slope of the grade. Click OK on this dialog to complete the addition of the new Steep Grade.

Deleting a Steep Grade

A Steep Grade may be deleted from the Route Database by selecting the Steep Grade to be deleted and then clicking Delete (×) on the Route Database toolbar. Note that there is no undo button, and the user is not prompted to verify the deletion. Once the Delete tool is pressed, the selected Steep Grade will be deleted.

Relocating a Steep Grade

A Steep Grade may be relocated by selecting the Steep Grade and then clicking GEO on the Route Database toolbar. When the GEO tool is selected, the points along selected Steep Grade become active or highlighted in the main viewing window, and the drawing toolbar becomes active. The user may then move or relocate some or all of the points along the Steep Grade by selecting a point and dragging it with the mouse to redefine its location, and the user may use the extend tool on the drawing toolbar to increase the length of the Steep Grade. When the changes are complete, click the Done button on the drawing toolbar to finish. This process is identical to relocating a Curve, as described previously and shown in Figure 8.69.

Tunnels in the Route Database

Editing Tunnel Data (Tunnel Reconnaissance Report – DA Form 1250)

Tunnel data may be edited with the EDT tool on the Route Database toolbar after a tunnel has been selected. EDT brings up the Tunnel Reconnaissance Report (DA Form 1250), as shown in Figure 8.80. The form is populated with the tunnel location (initial and terminal points) from information in the Route Database, and the form may be edited in the yellow highlighted spaces.
Page 2 of the Tunnel Reconnaissance Report provides areas to include drawings or attach photographs to further describe the ferry. Drawing palette capabilities are also included, and photographs or images may be inserted as previously described for the Bridge Reconnaissance Report. The “Add Photograph Form” button at the bottom of the second page of the Tunnel Reconnaissance Form may be used to add more pages to the form, if needed, to include additional photographs. The form may be saved or printed once it is complete. Note that the user must click OK on the form for information added to the form to be saved to the database.

Adding a New Tunnel

A new Tunnel may be added to the Route Database using the NEW tool from the Route Database toolbar. The cursor will become a crosshair when the NEW tool is selected, and the user defines the initial point and terminal point of the Tunnel location by clicking on the map or image in the main viewing window. After those two points have been selected on the map, the Tunnel Reconnaissance Report form will appear for the user to provide data regarding the new ferry. When the Tunnel Reconnaissance
Report is completed, clicking OK will save the data and add the new Tunnel to the Route Database.

Deleting a Tunnel

A Tunnel may be deleted from the Route Database by selecting the Tunnel and clicking the Delete tool (\(\times\)) from the Route Database toolbar. Note that there is no undo button, and the user is not prompted to verify the deletion. Once the Delete tool is pressed, the selected Tunnel is deleted.

Relocating a Tunnel

To relocate a Tunnel, first select the Tunnel that is to be moved and then click the GEO tool on the Route Database toolbar. The cursor will become a crosshair, and the user must select the new initial point and terminal point for the Tunnel by clicking on the map or image in the main viewing window. After those two points have been selected, a white line indicating the new Tunnel location will appear on the screen. Click the Select (\(\checkmark\)) tool on the Route Database toolbar to complete the process.

Exporting shapefiles and saving data from the Route Database

Objects in the Route Database may be saved or exported from the Route Database and saved as Shapefiles. The TETK provides an option to do this simultaneously for all objects of all types in the Route Database, and the data may also be saved for one or more of the object types individually.

Exporting Shapefiles for All Route Database Objects Simultaneously

To export Shapefiles for all object types in the Route Database simultaneously, right-click on Route Database in the View Control window and select Export Shapefiles, as shown in Figure 8.81. The Select Shapefiles Folder window will appear to allow the user to select the folder into which the Shapefiles will be saved, as shown in Figure 8.82. After the desired folder is selected, click Open on the Select Shapefiles Folder window and a separate Shapefile will be saved for each type of data in the Route Database that contains at least one object. A sample listing of Shapefiles saved is shown as Figure 8.83. Note that in the example Route Database shown here, there are no Fords and, thus, no Shapefile for Fords was saved.
Chapter 8   Processing Route Reconnaissance Data

Figure 8.81. Exporting shapefiles for all Route Database objects.

Figure 8.82. Selecting shapefiles folder.
Exporting Shapefiles for Individual Route Database Object Types

To save or export a Shapefile for any individual object type from the Route Database, right-click on the object type under Route Database in the View Control window. For Bridges, select “Export Shapefile” as shown in Figure 8.84, and for all other object types select “Save As” as shown in Figure 8.85. The Select Save As Shapefile Folder window will then appear, and the user selects the folder into which the files will be saved. Clicking Open on that window will save the Shapefile in the designated folder. Note that, if there are no objects of a particular type in the Route Database, no Shapefile for that object type will be saved or exported even when the above steps are followed.
Figure 8.84. Select “Export Shapefile” for bridges.

Figure 8.85. Select “Save As” to export shapefile for all other object types.
Creating a route in the Route Database

One of the finished products that can be generated in the TETK from route reconnaissance data collected with the ARRK is to create a Route for which a Road Reconnaissance Report (DA Form 1248) form will be automatically generated. To create a route, right-click on Route Database in the View Control window and select New Route as shown in Figure 8.86. The New Route dialog will appear as shown in Figure 8.87, and the user must provide a name for the Route. After providing a name and clicking OK in the New Route dialog, a plus (+) sign will appear by Route Database in the View Control window. Clicking on that plus (+) sign will expand the Route Database folder and reveal the new route, as shown in Figure 8.88. Double-clicking on the name of the new route to create a check mark in the box by the new route will open the Routes toolbar, as indicated in Figure 8.88. The tools on this toolbar are used to add road segments from the Route Database to actually create the new route.

![Figure 8.86. Creating a new route.](image)
Figure 8.87. New route dialog.

Figure 8.88. New route added to Route Database.
Adding Road Segments to the Route

When a route is first created, it contains no data. Road segments must be added to create the route. To add road segments, select Add from the Routes toolbar and select the first road segment for the desired route, as shown in Figure 8.89. Add more road segments by clicking on the road segments until the extent of the Route is defined. Figure 8.90 shows additional road segments added to the route. As more segments are added, the extent of the Route is shown in green. Each new road segment selected for the Route must connect to the previously selected segment, i.e., there may be no gaps in the route. If the user selects a road segment that is not adjacent to the previous road segment, a warning will appear as shown in Figure 8.91. If this occurs, the user should try again and click on the road closer to the previous segment. Some road segments that are very short may be difficult to select; so, it may be necessary to zoom in closely on the road in order to select the proper segment to form a continuous route. As the route is being created, the extent may be modified by deleting the first segment using the Delete First ( ) tool or by deleting the last segment using the Delete Last ( ) tool from the Routes toolbar.

Figure 8.89. Initial road segment added to route.
Figure 8.90. Additional road segment added to route.

Figure 8.91. Warning if non-adjacent segments are selected.
Generating the Road Reconnaissance Report (DA Form 1248)

After all of the desired road segments have been selected to form the Route, a Road Reconnaissance Report (DA Form 1248) may be automatically generated for the Route. To create this report, select the Show Road Form ( ) tool from the Routes toolbar, and the Road Reconnaissance Report for the route will appear as shown in Figure 8.92. This form is automatically populated with much of the information for the route, and the user may further edit or add information on the form in the yellow highlighted areas. When complete, the form may be saved or printed. Click OK on the form to close it when done.

Figure 8.92. Road Reconnaissance Report (DA Form 1248) for route.

Updating or Recomputing the Road Reconnaissance Report

If changes are subsequently made to the Route after the Road Reconnaissance Report has been saved, the Road Reconnaissance Report may be recomputed or updated to reflect the most current data along the route in the Route Database.
Changes to the Extent of the Route

If the extent of the Route has been changed either by adding more segments to extend the Route or by deleting segments, the user will be warned that the Route Report is out of date and will be prompted to update the form as shown in Figure 8.93. If Yes is selected, the report will be updated and the updated Road Reconnaissance Report will appear to be edited, saved, or printed. If No is selected, the previously saved Road Reconnaissance Report will appear without any of the updated changes from the Route Database.

![Warning to update report due to changes in extent of route.](image)

Changes to Objects Along the Route

If the extent of the Route is not changed, but objects along the route have been added, deleted, or edited since the Road Reconnaissance Report for the Route was generated, the user may select Recompute Route Report at the top of the Road Reconnaissance Report when the form is next opened. This will update the route data and repopulate the form with the most current information along the route from the Route Database.
Notes on processing route recon data

A common approach to processing route recon data is to run a recon in playback mode and edit the data along the route as needed, based on information contained in the recon. Ideally, the ARRK recon should contain audio information with details of the road or objects along the road. That may include such things as road surface type, lane width, details on obstructions, bridge military load classifications that were observed during the recon, etc. When the recon is being played back, the user may pause the recon playback and edit the information as needed. The information may be edited in the recon itself, in which case the edited data will automatically be transferred to the Route Database when the recon objects are saved to the Route Database but the original recon will also be altered. The other option is to save the recon data to the Route Database and edit the objects in the Route Database as the recon is being played back. In this manner, the original recon will remain intact in its original form and the updated information will exist only in the Route Database.
9 Custom Installation and Custom Project Components

Chapter 3 of this document provided an overview of the Typical installation process for the TETK, which is by far the most common option and provides all of the software features and components that are typically used. However, the installation wizard for the TETK provides options for Custom Installation and Complete Installation, which offer the user flexibility to install some or all of the program features. This chapter provides an overview of these installation options and a summary of the additional project components that are not included in the Typical installation.

Custom software installation options

To perform a Custom installation of the TETK software, begin at the initial installation screen, as shown in Figure 9.1. This screen should automatically appear if “autorun” is functioning when the TETK software CD is inserted into the disk drive, or the user may run the Startup file on the TETK software CD.

![Initial Install screen.](image-url)
On the initial install screen, select Install/Reinstall. If the TETK is already installed on the computer, the screen shown in Figure 9.2 will appear. From this screen, the user may select Remove to uninstall the TETK; select Repair to reinstall missing or corrupt files, registry keys, or shortcuts; or select Modify to enter the Select Features screen for Custom Installation, which will be described in more detail later in this section.

If the TETK is not already installed on the computer when Install/Reinstall is selected on the initial install screen, the following sequence of screens (shown in Figures 9.3–9.6) will appear to step the user through the installation process. On the Select Installation Type Screen shown in Figure 9.6, the user may select Typical (as detailed in Chapter 3), Complete (to install all features and components), or Custom (to specify only certain features and components for installation). Selecting Custom as the installation type and clicking Next will bring up the Select Features screen shown in Figure 9.7. Note that the Select Features screen will also appear if Modify is selected from the Application Maintenance screen shown in Figure 9.2.
Figure 9.3. Welcome screen for Installation Wizard.

Figure 9.4. User Information screen for Installation Wizard.
Chapter 9  Custom Installation and Custom Project Components

Figure 9.5. Configuration Data Destination Folder screen for Installation Wizard.

Figure 9.6. Select Installation Type screen for Installation Wizard.
Select Features allows the user to choose which applications and software components to install. Only two TETK applications are not included in the typical installation: HPAC Shapefile Viewer and Humanitarian Assistance. These applications are marked with a red X (as shown in Figure 9.7), indicating they will not be installed. Left-clicking on an item allows the user to select the install options for that item, as shown in Figure 9.8 for the HPAC Shapefile Viewer.

For those items that have subfeatures, such as Applications Reconnaissance, the option “Entire feature will be installed on local hard drive” automatically selects all subfeatures of that item to be installed. Alternatively, the user may selectively choose options to install each item and subfeature individually. Figure 9.9 shows that all of the applications have been selected for installation.

After the Custom Install options have been selected in the Select Features screen, the user clicks Next and then steps through the remaining installation screens, as outlined in Chapter 3.
Figure 9.8. Install options for HPAC shapefile viewer.

Figure 9.9. All applications selected for installation.
Custom project components

During a Typical installation of the TETK software, the only two project components that are not installed are the HPAC Shapefile Viewer and the Humanitarian Assistance project components. The following sections provide a brief overview of these project features.

HPAC shapefiles

The HPAC Shapefile Viewer provides the capability to view Shapefile data associated with the Hazard Prediction and Assessment Capability (HPAC) software, which models various hazardous disbursements into the atmosphere from a user-selected location. The HPAC models also use wind speed and direction as input to generate plume and casualty predictions. To view these data, right-click on HPAC Shapefiles in the View Control window and select New, as shown in Figure 9.10. The Import HPAC Shapefile window will then appear and allow the user to specify the location and name of the HPAC Shapefile CXL file to import, as shown in Figure 9.11.

![Figure 9.10. Importing a new HPAC shapefile.](image-url)
Humanitarian assistance

The Humanitarian Assistance project component provides a tool for defining and marking locations on a map and detailing capabilities related to humanitarian assistance functions such as food, fuel, power, security, and water in a database format. To use this feature, right-click on Humanitarian Assistance in the View Control window and select New, as shown in Figure 9.12. This will bring up the Create/Select Humanitarian Database window shown in Figure 9.13. The user may select to import an existing database or create a new database. If the option to create a new database is selected, the user must provide the location and name of the new database file and then click OK. If the option to select an existing database is chosen, the user must provide the path to the existing Microsoft Access® database file and click OK. This capability only functions to import an existing database file that was previously created with the TETK. Figure 9.13 shows an example of a new database being created.
Figure 9.12. Creating a new Humanitarian Assistance Database.

Figure 9.13. Create/select Humanitarian Database.
When a new database is being created and OK is clicked on the Create/Select Humanitarian Database, the user is prompted that the TETK project must be saved, the project must be closed or unloaded, and then the project must be reopened for the new database to take effect and be functional in the project. This prompt is shown in Figure 9.14.

![Figure 9.14. Prompt to save, exit and reopen project for new database.](image)

After the project has been saved, closed, and reopened, expanding the plus (+) sign by Humanitarian Assistance in the View Control window reveals several related categories (Food, Fuel Power, Security, Water) under Humanitarian Assistance, as shown in Figure 9.15. Double-clicking on any of the listed categories will activate that category, and the Humanitarian Assistance toolbar becomes active, as shown in Figure 9.15. Selecting NEW on the Humanitarian Assistance toolbar brings up the Humanitarian Assistance menu shown in Figure 9.16, in which the user may define humanitarian assistance-related information and data.
Chapter 9 Custom Installation and Custom Project Components

Figure 9.15. Humanitarian Assistance Database categories.

Figure 9.16. Humanitarian Assistance menu.
In the Humanitarian Assistance menu, the user provides a Name and selects a Type from the drop-down list (City, Town, Village, or Settlement). Coordinates for the location may be typed, or the Coordinate button may be pressed and the desired location clicked on the map to enter the coordinates into the menu. Drop-down lists are then provided below each category to select the Status (Red, Amber, Green, or Unknown), the Trend (No Change, Improving, Worsening, or Unknown), and the Validity (Yes or No) of information provided. Comments or notes may also be provided. Figure 9.17 shows an example of the completed menu. After the menu is completed, click Add to include the information in the database. An icon will also appear at the specified location, as shown in Figure 9.18.

Figure 9.17. Completing the Humanitarian Assistance menu.
When humanitarian assistance data are added to the database as described above, the Humanitarian Assistance menu for an item may be reopened for review or editing by selecting the Question Mark tool (_question mark_) from the Humanitarian Assistance toolbar and then selecting the icon on the map. The menu for that selected item will open. Additional new data may be added by selecting the NEW tool and repeating the process detailed above. Data may be deleted from the database by selecting an item on the map and pressing the Delete (_delete) tool on the Humanitarian Assistance toolbar. Note that there is no undo, and the user will not be prompted before the deletion takes effect. Once Delete is pressed, the data are gone.

Note that the color of the icon on the map provides an indication of the status for the highlighted category. In the example (Figure 9.18), the status for Food was selected as Green from the drop-down list, and the icon displayed on the map is shown as green when the Food category is selected under Humanitarian Assistance. The color will change to reflect the status of the other categories as those categories are activated. If All is selected,
the icon will appear as in Figure 9.19, indicating the status of all items (Green, Amber, Red, or White for Unknown).

![Figure 9.19. Icon color indicates status of all categories.](image)
10 Overlay Creation

Custom overlays of supported data types (tailored to meet specific needs) may be created in the Toolkit. To explain the process for doing this, an example is presented in this chapter where a VMAP1 transportation overlay (containing roads, cart tracks, and trails) is created by using the Toolkit Overlay Builder. To initiate the process, right-click on Overlays in the View Control window and select New as shown in Figure 10.1. Note that data from which to create the custom overlay must be loaded into the assigned Data Depot for the project. In this example, VMAP data must be in the Data Depot before the custom overlay process can be executed.

The overlay Query Builder (shown in Figure 10.2) appears, and the Data Feature drop-down list in this window allows the user to select among the supported data types for building overlays. For each supported data type, a list of subfeatures appears in the center pane of the Query Builder window. Figure 10.2 shows the Data Feature drop-down menu and the associated
list of subfeatures below. For the example presented here, “VMAP1 Transportation” is selected as the data feature, and this is shown along with the list of subfeatures.

Clicking on the plus (+) sign adjacent to any subfeature expands the subfeature, and a listing of detailed attributes associated with the subfeature is displayed. Figure 10.3 shows the subfeature AP030-Road expanded to reveal the associated attribute list.

To add any subfeature to the overlay being created, click in the box by the subfeature name so that there is a “check mark” in the box. That subfeature will then be shown in the Current Query area of the Query Builder window. In this example, the “AP030-Road” subfeature is checked and is listed in the Current Query area, as shown in Figure 10.3. If only the box by the subfeature name is checked, then all items or categories listed below that subfeature are added to the query. To display only specific items or categories, the boxes adjacent to the desired items can be checked.
Chapter 10   Overlay Creation

Figure 10.3. AP030-Road attribute list displayed.

After the subfeature and any desired items or categories are selected, press the Add button and the selected subfeature will be shown in the left pane of the Query Builder window, as shown in Figure 10.4. The name of the subfeature can be edited; in Figure 10.5, the “AP030-Road” subfeature has been renamed “VMAP1 Roads.” This is the name that will appear in the legend once the overlay is complete.

Subfeature symbology is edited by clicking the symbology button, as shown in Figure 10.4. This example subfeature represents vector features, so the line Symbol Editor appears as in Figure 10.5 to specify the color, pattern, and line width. Click OK when the symbology options have been selected.
Figure 10.4. Selected subfeature added to Query Builder.

Figure 10.5. Symbol Editor.

Click to edit symbology.
Additional subfeatures may be added to the overlay. The previously selected subfeature must first be deselected or “unchecked” before the next subfeature is selected or “checked.” Figure 10.6 shows the “AP030-Road” subfeature deselected.

![Figure 10.6. Deselecting AP030-Road subfeature.](image)

Once the next subfeature has been selected or “checked,” it is added to the overlay by selecting the Add button again. In the example overlay presented here, two additional subfeatures are added to the overlay: “Trail” and “Cart Track.” Unique symbology is defined for each subfeature so that the linear features in one subfeature can be differentiated from those in other subfeatures when the overlay is displayed. The result after adding those two additional subfeatures is shown in Figure 10.7.

After all desired subfeatures have been added to the overlay and all display names and symbology have been selected, press “OK” in the Query Builder window. The Save Query window shown in Figure 10.8 will then appear and prompt the user to name the new overlay and to provide a folder name where the overlay will appear in the Overlay list.
Figure 10.7. Adding subfeatures to the overlay.

Figure 10.8. Save Query window.
The Save Query window, as shown in Figure 10.8, lists existing Overlay folders. The new overlay may be created in one of these existing folders, or a new folder may be created by clicking the New Folder button if none of the existing folders is appropriate for the type of information in the new overlay. In Figure 10.9, the example overlay is named “Transport 1” and is being created in the existing “Vehicle Throughput” folder.

Clicking OK will add the new overlay to the selected folder.

The new overlay can be displayed by expanding the appropriate overlay folder under Overlays in the View Control window and double-clicking on the new overlay so that there is a check mark in the box by the overlay name. This is shown in Figure 10.10 for the example Transport 1 overlay in the Vehicle Throughput folder.

The legend for the new overlay can be viewed by clicking on the Legend tab in the View Control window, as shown in Figure 10.11.
Figure 10.10. New Overlay displayed.

Figure 10.11. Overlay legend.
Additional overlays can also be created and added as needed. Overlays for other data types supported by the Toolkit can be created with the same process. Refer to Appendix A for a list of the data types supported.

Overlays created via the Query Builder are stored in individual files under the “Configuration” folder for the Toolkit. This is generally located under the “C:\TETK\Configuration\Overlays” folder structure if the default installation options were chosen when installing the Toolkit, and the specific overlay file will be in the folder where it was saved in the Toolkit project. For example, the “Transport 1” overlay created in the example presented in this chapter was saved under the Vehicle Throughput overlay folder, so the path to this file would be:

C:\TETK\Configuration\Overlays\VehicleThroughput\Transport 1.gvl

The example file is highlighted in Figure 10.12. This file can be shared with other Toolkit users by copying the file to the same directory on another computer that has the Toolkit software. It is necessary to close any opened Toolkit project and to reopen the project to view the new overlay.
11 Sending RFI

The Toolkit was developed to facilitate communications between requesters and subject matter experts. The project annotation component allows the requester to specifically mark and label maps to create specific georeferenced graphics that specify the requirements of a Request for Information. For example, the requester may request an analysis of an airfield, bridge, fording site, etc. All such requests may be clarified by creating georeferenced annotations, graphically marking key geographic locations. In return, SMEs may conduct a specific technical analysis and provide the results to the requester in the form of an annotation that the requester can easily import into his Toolkit project for viewing.

The Toolkit stores these graphics (annotations) in a relatively small file (typically 2 to 10 kb in size) that is easy to e-mail to the TEOC. Annotation files are stored in the Annotate folder under the project folder. As an example, Figure 11.1 shows a Toolkit project named “NTC” that contains a folder named “Annotate.” All Toolkit projects contain an “Annotate” folder when the project is created. The example in Figure 11.1 shows three annotation files in the listing of the Annotate folder, named “Bicycle Lake Airfield,” “route 13nov01,” and “Route,” all with the “.ano” file extension.

![Figure 11.1. Location of example annotation file.](image)

The files shown in Figure 11.1 range in size from 1 kb to 9 kb in size, and any of these files can simply be attached to a standard e-mail,
supplemented by a written RFI describing the issue and problem, and submitted to an SME via the TEOC for technical support. Any annotation file returned by the TEOC as a response to the RFI must be copied into this same directory within the project folder structure, i.e., the Annotate folder under the appropriate project folder.

After copying an annotation file into the Annotate directory, the Toolkit project must be closed and the Toolkit software restarted before the Toolkit will recognize the new file and before the Annotation will appear under the Annotation folder in the View Control window.

E-mail annotation files, with a narrative RFI description, may be e-mailed to the TEOC non-secure e-mail (teoc@usace.army.mil) or to the secure SIPRNET e-mail (teoc@teleengineering.army.smil.mil).
12 Technical Support

To obtain assistance in using the Toolkit, contact one of the numbers below:

1-877-223-8322

(601) 634-2735 (Commercial)

(601) 634-4231 (Commercial)

312-446-2735 (DSN)

312-446-4231 (DSN)

TEOC personnel are paged 24 hours a day, 7 days a week by your voice mail. Every reasonable effort will be made to assist you.

E-mail the TEOC at teoc@usace.army.mil for non-secure e-mail or at teoc@teleengineering.army.smil.mil for SIPRNET secure e-mail.
## Appendix A - Data Types Supported

<table>
<thead>
<tr>
<th>Data Source Type</th>
<th>Data Types</th>
<th>Definition/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ARC Digitized Raster Graphics (ADRG)</td>
<td>(ARC4) GNC 1:5,000,000</td>
<td>ARC (equal Arc second Raster Chart/ map) Digitized Raster Graphics (ADRG) are digital raster representations of paper graphic products.</td>
</tr>
<tr>
<td></td>
<td>(ARC1) JNC 1:2,000,000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(ARC1) ONC 1:1,000,000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(ARC2) TPC 1:500,000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(ARC2) LFC 1:500,000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(ARC2) VNC 1:500,000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(ARC5) JOG 1:250,000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ATC 1:200,000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(ARC6) TLM 1:100,000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(ARC7) TLM 1:50,000</td>
<td></td>
</tr>
<tr>
<td>Compressed ADRG/ Controlled Image Base (CADRG/CIB)</td>
<td>1:5M GNC Global Navigation Chart</td>
<td>General purpose product, comprising computer-readable digital map and chart images.</td>
</tr>
<tr>
<td></td>
<td>1:2M JNC Jet Navigation Chart</td>
<td>CIB is a seamless dataset of orthophotos, made from rectified grayscale aerial images.</td>
</tr>
<tr>
<td></td>
<td>1:1M ONC Operation Navigation Chart</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1:500K TPC Tactical Pilotage Chart</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1:500K LFC Low Flying Chart (UK)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1:250K JOG Joint Operations Graphic</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1:250K TFC Transit Flying Chart (UK)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1:200K ATC Series 200 Air Target Chart</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1:100K TLM-100 Topographic Line Map</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1:50K TLM-50 Topographic Line Map</td>
<td></td>
</tr>
<tr>
<td></td>
<td>10m CIB10 Controlled Image Base</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5m CIB5 Controlled Image Base</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1m CIB1 Controlled Image Base</td>
<td></td>
</tr>
<tr>
<td>Data Source Type</td>
<td>Data Types</td>
<td>Definition/Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Digital Nautical Chart (DNC)</td>
<td>Cultural Landmarks</td>
<td>A vector-based digital database containing maritime significant features essential for safe marine navigation. Initial data collection of the database is from a portfolio of approximately 5,000 nautical charts that will ultimately provide global marine navigation between 84 degrees north latitude and 81 degrees south latitude and support a variety of Geographic Information System applications.</td>
</tr>
<tr>
<td></td>
<td>Earth Cover</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Environment</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hydrography</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Inland Waterways</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Land Cover</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Limits</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Aids to Navigation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Obstructions</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Port Facilities</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Relief</td>
<td></td>
</tr>
<tr>
<td>Digital Topographic Elevation Data (DTED)</td>
<td>Level 0</td>
<td>Digital terrain elevation data produced at three levels of detail: - Level 0 post spacing is approx. 1000 meters</td>
</tr>
<tr>
<td></td>
<td>Level I</td>
<td>- Level I post spacing is 3 arc seconds (approx. 100 meters).</td>
</tr>
<tr>
<td></td>
<td>Level II</td>
<td>- Level II post spacing is 1 arc second (approx. 30 meters).</td>
</tr>
<tr>
<td>Digital Topographic Data (DTOP)</td>
<td>Beach</td>
<td>A vector-based product separated into thematic layers to support GIS applications with geographic data at high resolution. Data are produced in the Vector Product Format (VPF) and geographic coordinates in decimal degrees.</td>
</tr>
<tr>
<td></td>
<td>Boundaries</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hydrography</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Industry</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Obstacles</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Population</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slope/Surface Configuration</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Surface Drainage</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Surface Materials</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Transportation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Utilities</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Vegetation</td>
<td></td>
</tr>
<tr>
<td>Data Source Type</td>
<td>Data Types</td>
<td>Definition/Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Feature Foundation Data (FFD)</td>
<td>Boundaries</td>
<td>FFD is a vector based product that portrays a selected set of geographic information features of aeronautical, topographic, and hydrographic military significance, for scales normally ranging from 1:50 000 to 1:250 000.</td>
</tr>
<tr>
<td></td>
<td>Elevation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hydrography</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Population</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Transportation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Vegetation</td>
<td></td>
</tr>
<tr>
<td>Interim Terrain Data (ITD)</td>
<td>Transportation</td>
<td>A vector-based product portraying analyzed attributes of terrain features (both natural and manmade) that are of significance to tactical military operations. The normal data collection density for ITD is 1:50,000 scale.</td>
</tr>
<tr>
<td></td>
<td>Drainage</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Surface Material/Configuration</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slope</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Vegetation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Obstacles</td>
<td></td>
</tr>
<tr>
<td>Planning Interim Terrain Data (PITD)</td>
<td>Transportation</td>
<td>A vector-based product portraying analyzed attributes of terrain features (both natural and manmade) that are of significance to military planning operations. The normal data collection density for PITD is 1:250,000 scale.</td>
</tr>
<tr>
<td></td>
<td>Drainage</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Surface Material/Configuration</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slope</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Vegetation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Obstacles</td>
<td></td>
</tr>
<tr>
<td>USGS Digital Orthophotos (DOQ)</td>
<td>USGS DOQ 1:12,000 Color</td>
<td>The DOQ is the standard product for the national ortho-imagery coverage. The DOQ has 1-meter pixel resolution and are cast on the UTM projection from black-and-white or color-infrared photographs.</td>
</tr>
<tr>
<td></td>
<td>USGS DOQ 1:12,000 Grayscale</td>
<td></td>
</tr>
<tr>
<td></td>
<td>USGS DOQ 1:24,000 Color</td>
<td></td>
</tr>
<tr>
<td></td>
<td>USGS DOQ 1:24,000 Grayscale</td>
<td></td>
</tr>
<tr>
<td>Archer Data</td>
<td>Color</td>
<td>Hyper spectral imagery from the Airborne Real-Time Cueing Hyperspectral Enhanced Reconnaissance (ARHCER) program.</td>
</tr>
<tr>
<td></td>
<td>Panchromatic</td>
<td></td>
</tr>
<tr>
<td>USGS Digital Raster Graphics (DRG)</td>
<td>USGS 1:20,000 Topographic</td>
<td>A digital raster graphic (DRG) is a scanned image of a U.S. Geological Survey (USGS) standard series topographic</td>
</tr>
<tr>
<td></td>
<td>USGS 1:24,000 Topographic</td>
<td></td>
</tr>
</tbody>
</table>
## Data Types Supported

<table>
<thead>
<tr>
<th>Data Source Type</th>
<th>Data Types</th>
<th>Definition/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>USGS</td>
<td>USGS 1:24,000 Topographic</td>
<td>map, including all map collar information. The image inside the map neatline is georeferenced to the surface of the earth and fit to the Universal Transverse Mercator projection. The horizontal positional accuracy and datum of the DRG matches the accuracy and datum of the source map.</td>
</tr>
<tr>
<td></td>
<td>USGS 1:30,000 Topographic</td>
<td></td>
</tr>
<tr>
<td></td>
<td>USGS 1:100,000 Topographic</td>
<td></td>
</tr>
<tr>
<td></td>
<td>USGS 1:250,000 Topographic</td>
<td></td>
</tr>
<tr>
<td>LandSat7</td>
<td>LandSat7 Band 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>LandSat7 Band 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>LandSat7 Band 3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>LandSat7 Band 4</td>
<td></td>
</tr>
<tr>
<td></td>
<td>LandSat7 Band 5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>LandSat7 Band 6 High Grain</td>
<td></td>
</tr>
<tr>
<td></td>
<td>LandSat7 Band 6 Low Grain</td>
<td></td>
</tr>
<tr>
<td></td>
<td>LandSat7 Band 7</td>
<td></td>
</tr>
<tr>
<td></td>
<td>LandSat7 Band 8</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CADRG 1:50K Misc Maps &amp; Charts</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CADRG 1:100K Misc Maps &amp; Charts</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CADRG 1:145826 Misc Maps &amp; Charts</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CADRG 1:200K Misc Maps &amp; Charts</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CADRG 1:250K Misc Maps &amp; Charts</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CADRG 1:500K Misc Maps &amp; Charts</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CADRG 1:1M Misc Maps &amp; Charts</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CADRG 1:3.5M Misc Maps &amp; Charts</td>
<td></td>
</tr>
<tr>
<td>CADRG City Graphics</td>
<td>CADRG 1:10K City Graphics</td>
<td>NGA Compressed ARC Digitized Raster Graphics standard map background product, city graphics maps.</td>
</tr>
<tr>
<td></td>
<td>CADRG 1:12.5K City Graphics</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CADRG 1:15K City Graphics</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CADRG 1:17K City Graphics</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CADRG 1:17.5K City Graphics</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CADRG 1:19K City Graphics</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CADRG 1:20K City Graphics</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CADRG 1:22K City Graphics</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CADRG 1:24K City Graphics</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CADRG 1:25K City Graphics</td>
<td></td>
</tr>
<tr>
<td>Data Source Type</td>
<td>Data Types</td>
<td>Definition/Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CADRG 1:30K City Graphics</td>
<td>CADRG 1:35K City Graphics</td>
<td></td>
</tr>
<tr>
<td>CADRG 1:50K City Graphics</td>
<td>CADRG 1:200K City Graphics</td>
<td></td>
</tr>
<tr>
<td>CADRG 1:250K City Graphics</td>
<td>CADRG 1:1M City Graphics</td>
<td></td>
</tr>
<tr>
<td>QuickBird</td>
<td>Color</td>
<td>High-resolution imagery with resolution at 60-cm for panchromatic and 2.4-m for multi-spectral at nadir.</td>
</tr>
<tr>
<td></td>
<td>Multi-spectral</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Panchromatic</td>
<td></td>
</tr>
<tr>
<td>IKONOS</td>
<td>IKONOS-2 Blue Band</td>
<td>Commercial high-resolution imagery at 1- and 4-meter resolution.</td>
</tr>
<tr>
<td></td>
<td>IKONOS-2 Green Band</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IKONOS-2 Near Infrared Band</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IKONOS-2 Panchromatic</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IKONOS-2 Red Band</td>
<td></td>
</tr>
<tr>
<td>SPOT</td>
<td>SPOT 10m Natural Color</td>
<td>Commercial satellite imagery acquired by SPOT Earth observation satellites.</td>
</tr>
<tr>
<td>Urban Vector Map</td>
<td>Boundaries</td>
<td>Designed to provide vector-based geospatial data with city graphic content.</td>
</tr>
<tr>
<td>(UVMAP)</td>
<td>Elevation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hydrography</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Industry</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Physiography</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Population</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Transportation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Utilities</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Vegetation</td>
<td></td>
</tr>
<tr>
<td>Vector Interim</td>
<td>Obstacles</td>
<td>Vector Product Interim Terrain Data is designed to provide terrain analysis data for systems requiring digital terrain information on CD-ROM and which are being fielded prior to NIMA full-scale production DTOP. It consists of contiguous digital data sets covering specified geographic areas.</td>
</tr>
<tr>
<td>Terrain Data (VITD)</td>
<td>Slope/ Surface Configuration</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Soil/ Surface Materials</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Surface Drainage</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Transportation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Vegetation</td>
<td></td>
</tr>
<tr>
<td>Data Source Type</td>
<td>Data Types</td>
<td>Definition/Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Vector Map Level 0</td>
<td>Boundaries</td>
<td>An updated and improved version of the National Imagery and Mapping Agency’s Digital Chart of the World (DCW). The VMap Level 0 database provides worldwide coverage of vector-based geospatial data which can be viewed at 1:1,000,000 scale. It consists of geographic, attribute, and textual data stored on compact disk read-only memory.</td>
</tr>
<tr>
<td>(VMAP0)</td>
<td>Elevation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hydrography</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Industry</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Physiography</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Population</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Transportation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Utilities</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Vegetation</td>
<td></td>
</tr>
<tr>
<td>Vector Map Level 1</td>
<td>Boundaries</td>
<td>Designed to provide vector-based geospatial data at medium resolution.</td>
</tr>
<tr>
<td>(VMAP1)</td>
<td>Elevation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hydrography</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Industry</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Physiography</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Population</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Transportation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Utilities</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Vegetation</td>
<td></td>
</tr>
</tbody>
</table>
The TeleEngineering Toolkit software was developed to provide a mechanism by which deployed engineers could view and analyze geospatial data, collect and display data required for engineering analyses conducted by subject matter experts via reachback, track previously conducted analyses, organize requests for information, maintain interoperability with other software used by deployed personnel, and provide requestors a more efficient means to display analyses provided by subject matter experts. The capabilities of the TeleEngineering Toolkit include tools to display and analyze many types of geospatial data (maps, imagery, and various other raster and vector data), manage documents in a geospatial environment, create and share annotations, plot data points, import and export vector data in several common formats, and process and view reconnaissance data. This document provides a detailed reference to the TeleEngineering Toolkit software including installation of the software, working with geospatial data and the Data Depot format, creating and working with Projects and viewing maps and imagery, using all of the menus and toolbars, using the various Project components, importing and exporting data, and working with data collected from the Automated Route Reconnaissance Kit. Complete descriptions of all of the software functions, example applications, and images of the interface to support understanding of the software are included.